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ABSTRACT

The main objective of this study is to build a QSAR model for a series of N-
ferrocenylmethylaniline derivatives, the obtained model allows the prediction of their theoretical
antioxidant activity and the selection of the antioxidant candidates . In order to achieve these
goals, the antioxidant activity of a series of 28 N-ferrocenylmethylaniline derivatives was
measured using cyclic voltammetry technique. Promising results of a half maximal inhibitory
concentration of 7.719 mM have been obtained for N-(ferrocenylmethyl)-N-(acetyl)-4-
(nitro)aniline (F23) which is a competitive result with that of the standard a-tocopherol (7.0581
mM). Other derivatives N-(ferrocenylmethyl)-4-(nitro)aniline (F12), N-(ferrocenylmethyl)-3-
(aminobenzo)nitrile (F14), N-(ferrocenylmethyl)-N-(acetyl)-2-(nitro)aniline (F21), N-(ferrocenyl-
methyl)-)-N-(acetyl)-2-(amino)benzonitrile (F24) and N-(ferrocénylmethyl)-N-(phenyl)benz-
amide (F27) also gave comparable results to the standard.

Toxicity prediction studies demonstrated that among the most potent derivatives, F24 was
predicted to be non-toxic. Molecular Docking study revealed that compound F24 is the most
inactive compound against glutathione reductase enzyme amoung the 28 derivatives having a high
inhibitory concentration of 2.61 uM and a low docking score of -7.61 kcal/mol. The compound
formed only hydrophobic and =-cation interactions with amino acid residues of glutathione

reductase.

The structural, electronical and spectral properties of the 28 derivatives were determined by
energy optimization using Gaussian 09W with the method (DFT/B3LYP) and mixed basis sets
(LANL2DZ(Fe)/6-31G(d)). Multi linear regression was used to build a quantitative relation
between superoxide radical scavenging activity and structural properties. The model was validated
and found to be statistically significant with a squared fitting correlation coefficient (R?) of 0.944,
adjusted squared correlation coefficient (R%g;) value of 0.842, and the cross-validation coefficient
value of 0.892 with calculated F value of 17.88 showing this model with a good predictability.

Key words: ferrocene derivatives, antioxidant activity, QSAR, cyclic voltammetry, DFT.
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Dipole moment
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Density functional theory
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Highest occupied molecular orbital
Half-maximal inhibitory concentration
Anodic peak current in pA.cm?
Cathodic peak current in uA.cm?
Infra-Red

Binding constant

Median lethal dose

Octanol/water partition coefficient
water solubility

Lowest unoccupied molecular orbital
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Multiple linear regression
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MV Molar volume

MW Molecular weight

02" Superoxide anion

PDB Protein data bank

PE Predictive error of the coefficient correlation
PM3 Semi-empirical Hamiltonian

Pol Molar Polarizability

Q? Cross-validation coefficient

QSAR Quantitative Structure-Activity relationship

R2 Coefficient of determination
R2adj Adjusted R squared
RMN Resonance Magnetic Nuclear

RMSD Root mean squared deviation
S Standard deviation

SAG Surface area grid

TC Toxicity class

TPSA Topological polar surface area
UV-Vis  Ultra Violet-Visible

AG Free binding energy
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GENERAL INTRODUCTION

Metallocenes, in particular ferrocene derivatives, are an important class of organometallic
compounds [1]. Currently, ferrocene is considered as a widely applicable organometallic scaffold

for the synthesis of various functional derivatives, useful in medicinal and synthetic fields [2-4].

Since its discovery in 1951, ferrocene has remained a molecule of continued interest [5], in
part due to the rich chemistry of the iron(ll) center and stability in aqueous and aerobic media
coupled with aromaticity. Access to a wide variety of derivatives along with the ability to undergo
easy iron oxidation make them fascinating targets in multiple fields such as electrochemistry,
biochemistry, drug design, mediators of protein redox reactions [6, 7], internal standards in
electrochemistry [8]. and organic synthesis [9], such as in the functionalization of cyclopentadienyl
ligands [10, 11].

Compared to the wide use of ferrocene in new materials, ferrocene has been exceptionally
applied as a structural feature in drug design, although some researchers have pointed out that
ferrocene and its derivatives have potential pharmacological applications. This was due to this low
polarity being limited to the bioavailability of ferrocene in vivo [12]. Since ferrocene was inert to
oxidation in the atmosphere, it was inferred that synthetic derivatives of ferrocene may be a new
type of antioxidant [13], in which other organic groups may enhance the bioavailability of
ferrocene, or a large conjugated system formed between ferrocenyl and other organic compounds.
groups can increase antioxidant efficacy [14] .

This study has two main objectives; the first is to build a quantitative structure-activity
relationship (QSAR) model using multiple linear regression (MLR) method for N-
ferrocenylmethylaniline derivatives, this model will be able to predict the half maximal inhibitory
concentration of the antioxidant activity of these derivatives. In this regard we will perform
structure optimisation of a series of 28 N-ferrocenylmethylaniline derivatives, their geometric,
spectral and electronic properties will be calculated in order to use them as molecular descriptors
in the QSAR study. Cyclic voltammetry assay will be applied to measure the antioxidant activity
of the 28 derivatives and to obtain their IC50 which will be used as a response for the descriptors.
The second objective of the study is to select the most potent derivatives as antioxidants drug
candidates . Absorption, Distribution, Metabolism, and Excretion (ADME) and pharmacokinetics
properties of the target derivatives will be predicted using SwissADME website tool. The toxicity
of the derivatives will be also performed in silico using the ProTox-11 web server in order to predict

their toxicity properties such as hepatotoxicity, carcinogenicity, immunotoxicity, mutagenicity,
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cytotoxicity, median lethal dose (LDso), and toxicity class , the best candidates will be docked
using AtouDockTool software to study their inhibition activity against glutathione reductase
enzyme which is involved in elimination of reactive oxygen species and act as a scavenger for
various oxygen radicals. The obtained in vitro and in silico results will correspond with one another
and will give room for the design of novel antioxidant N-ferrocenylmethylaniline derivatives with
less activity against glutathione reductase.

This thesis is structured in two main parts as follow:

= The first part contains a bibliographical and theoretical approaches and is divided into
three chapters:
o Chapter 1: Overview of ferrocene and its derivatives
o Chaptre 2: Antioxidant activity
o Chaptre 3: Theoretical background of the used expermintal and computetional
methods
= The second part concerns the experimental part and the results of the thesis and it is also
divided into three chapters:
o Chapter 1: Structural, electronical properties and in silico toxicity of N-
ferrocenylmethylaniline derivatives
o Chapter 2: Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic
voltammetry and molecular docking studies
o Chapter 3: QSAR modeling.
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I.1. Introduction

Since Ferrocene (Figure 1-1) was independently discovered in 1951 by Kealy, Pauson, and Miller
[15], the impact of this revolutionary work has been enormous. It opened up new areas of
chemistry, deepened our understanding of structure, binding, and reactivity, and thus paved the
way for the burgeoning field of organometallic chemistry itself. Ferrocene and Ferrocene
molecules are not simple trophy molecules for the plateau; rather the synthesis of this sandwich
system in all its flavors, its polyvalent reactional chemistry, its structural characteristics, the
mechanistic and theoretical studies which accompany it, its use in homogeneous catalysis, in
particular in stereoselective and asymmetric transformations [16-18], in electrochemistry, in
particularly in electron transfer processes [19], as new materials, including polymer chemistry [20-
27], as fuel additives [28-30], as anticancer reagents [31], in bioorganometallic chemistry [32, 33],
etc. has contributed to the rapid growth and therefore rapid shifting of the boundaries of this family

of compounds over the past 60 years [34].

Fe

Figure I-1 Ferrocene
1.2. Discovery of ferrocene

The chemistry of transition metals was mastered by German chemists before World War 11.
This discipline was transferred to the English and Americans after World War Il. In 1951, Kealy
and Pauson [15] published for the first time in a famous article in the journal Nature, the synthesis
of bis(cyclopentadienyl)iron or ferrocene. T.J. Kealy and P.L. Pauson attempted to prepare
dihydrofulvalene by oxidation of a Grignard reagent of cyclopentadienyl according to Equation

I-1. The compound obtained from this reaction was an orange product and thermally very stable.
2CsHsMgBr + FeCl; — > (CsHs),Fe Equation I-1

The structure proposed by Pauson for this compound has a resonance form in which iron is

bonded to cyclopentadienyl through a sigma bond with a canonical ionic formula (Figure 1-2).
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H H
H H

Figure 1-2 The resonance structure proposed by Kealy and Pauson

English chemist Geoffrey Wilkinson and the German physicist Ernst Fischer, who were
instrumental in the correction of the structure proposed by Pauson, and the discovery of the exact

nature of the iron-carbon bond in bis(cyclopentadienyl)iron, called ferrocene [35, 36].

In 1952 E. O. Fischer independently began studying the structure of ferrocene in his
laboratory at the Technische Hochschule in Munich. His conclusions were based on data from x-
ray crystallography, from which he concluded that the molecule must consist of an iron (I1) atom

located between the two cyclopentadienls as ligands.

L. E. Orgel began the description of the molecular orbitals of this new structure which has
already been determined by Dunitz [37]. The title of his publication contained the description
sandwiched [38].

H H
H—r=—H H—cr—H
H\ 1/ H H™ { 'H
e Fe
Ho/ i3 H H. | _H
I Il

Figure 1-3 The corrected structure of ferrocene
1.3. Properties of ferrocene
1.3.1. Physical properties

Ferrocene is an orange crystalline solid, with a molar mass of 186.04 g.mole™* [39], stable in
air, boiling point 249 °C and melting point 173-174 °C. Ferrocene is soluble in most organic
solvents, its solubility in water is approximately 0.1 mg/ml at 21 °C, 100 mg/ml in DMSO at 19.5
°C. It is stable at high temperature, up to 400 °C [40].

At room temperature, Ferrocene is the most stable of the metallocenes, smelling like
camphor [41]. Studies have shown that it is sensitive to prolonged exposure to air and light.
7
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Ferrocene forms with dilute nitric acid and concentrated sulfuric acid dark red solutions with
blue fluorescence [42, 43].

1.3.2.  Electrochemical properties

Many studies and analyzes by electrochemical methods have been carried out on the redox
properties of ferrocene. In general, the usual cathodic behavior of ferrocene in organic media such
as dichloromethane, acetonitrile and DMF can be described by a one electron reversible reduction,

leading to the ferrocerium ion [44, 45], Figure 1-4.

=

B 1+

—

+e”

Figure 1-4 Reversible monoelectronic oxidation of ferrocene

The reversibility of the redox reaction was demonstrated by cyclic voltammetry, the
electrochemical parameters taken from ferrocene voltammogram show that the redox process does

this in a rapid, reversible and monoelectronic way.

0.3+
0.2

0.1+

i (MA)

0.0 +

-0.1+

-0.2 L e e B
-0.6 -0.3 0.0 0.3 0.6 0.9 12 15

E (V) / AgCl

Figure 1-5 Ferrocene voltammogram recorded on a platinum electrode in acetonitrile 10> M in the

presence of Tetrabutylammoniumpairchlorate 10 M at v = 100 mv/s, my own work .
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The values of the electrochemical parameters taken from the voltammogram of Figure 1-5
are grouped together in Table I-1. These values provide information on the speed and reversibility

criteria.

Table I-1 Characteristic values of the electrochemical parameters of ferrocene

Epa (V) Epc (V) |pa (mA) |pc (mA) =77 (V) AEp (V)

0.609 0.339 0.267 -0.151 0.480 0.27

1.3.3.  Spectral properties
1.3.3.1. InfraRed

Ferrocene infrared spectroscopy (Figure 1-6) is relatively simple because of its symmetrical
structure. It exhibits an absorption band at 3075 cm equivalents to the elongation of the aromatic
C-H bond. There are only four apparent bands: two at 811 and 1002 cm™ are equivalent to the
bending vibration of C-H, and one at 1108 cm™ is equivalent to the antisymmetric vibration of the
pentadienyl ring. The absorption band at 1411 cm™ is equivalent to the antisymmetric C-C removal

vibration of unsubstituted cyclopentadienyl.

100 ~

90 —
o0 I
70

60 —

Transmitance

50

40

30 T T T T T T T T T T T T T T
4000 3500 3000 2500 2000 1500 1000 500
Wavenumbers (cm™)

Figure 1-6 IR spectrum of Ferrocene [46]
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1.3.3.2.  Uv-Visible

W. Albert Noyes et al. found that the ultraviolet and visible absorption spectra of ferrocene
in ethanol are characterized mainly by two bands. One is at 325 nm and the other (which is

somewhat broader) is centered at 440 nm [47].

250
200
150

100

Molar Extinction (cm =7 /)

300 400 500 600 700
Wavelength (nm)

Figure 1-7 UV-Vis spectrum of Ferrocene [47]
1.3.3.3.  Nuclear Magnetic Resonance (NMR)

1.3.3.3.1. NMRH

The NMR !H spectral of the Ferrocene molecule is very simple, it shows a single peak
corresponds to the ten protons of two cyclopentadienyl cycles at 4.15 ppm (Figure 1-8) [48].

'H RMN 300 MHz

Solvant Chloroforme

8 (ppm)

Figure 1-8 NMR *H spectrum of Ferrocene [48]
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1.3.3.3.2. NMR13C

Likewise, the NMR 3C spectral of ferrocene shows a single peak at 68 ppm corresponds to

the ten carbon atoms of two cyclopentadienyl rings (Figure 1-9) [48].

BC RMN 75 MHz

Solvant Chloroforme

Il

84 81 78 75 72 69 66 63 60
8 (ppm)

Figure 1-9 NMR “3C spectrum of Ferrocene [48]
1.3.3.4. Crystalline structure

The crystal structure of ferrocene (Figure 1-10) has been studied by Wilkinson et al. [49] by
X-ray diffraction. These analysis led to the determination of the exact lengths of the C-C, C-Fe,
and C-H bonds.

Jd

Figure 1-10 Ferrocene crystal structure
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The average length of the C-C bond in the two pentadienyl rings of ferrocene is 1.389A, a
value which is very close to that of benzene (1.395A). The length Fe-C is equal to 2.03A. C-H
bonds have an average length of 1.389A. Ferrocene is the most stable of the metallocenes series.
Each ligand C5Hz being a donor of six electrons, with the six electrons of Fe(l1) led to the stable

configuration of 18 electrons [49].
1.4. Synthesis of ferrocene
1.4.1. Chemical process

The acidity of cyclopentadiene (pKa = 20) is relatively high in comparison with alkanes (the

pKa of methane is of the order of 60) (Equation 1-2).

H

H H
@ @ Equation -2
———— + H+

This acidity is sufficient to react with the sodium hydroxide in DMSO and produce the
cyclopentadienyl anion. DMSO is an aprotic dipolar solvent which enhances the basicity of the

OH- ion by very efficiently solvating the Na* counterion (Equation 1-3).

NaOH, DMSO .
- Equation I-3
-H"

A sufficiently basic amine such as diethylamine can be used to form the cyclopentadienyl

ion from cyclopentadiene.

The direct reaction of cyclopentadiene with ferrous chloride in the presence of diethylamine,
can be adopted to synthesize cyclopentadienyl ion from cyclopentadiene, and even a diamine can
play the role of an HCI acceptor (Equation 1-4) [50].

THF

FeCl, + 2CsHg + 2R3N (CsHs),Fe + 2(R;N* + CI) Equation 1-4

Cyclopentadiennylthalliume can also be used as a starting material for the preparation of

ferrocene as shown in Equation I-5 and Equation 1-6 [51].
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2TICsH; + FeCl,

(CsHs),Fe + 2TICI Equation I-5

H,0

CsHg + TIOH TICsHs + H,O Equation I-6

Grignard's reagent of cyclopentadiene, an easily obtained intermediate, was used by Kealy
and Pauson [15] for their historical preparation of ferrocene (Equation 1-7). This technique was
developed by Pauson in 1955 [52].

2CsHsMgBr + FeCl, (CsHs)Fe + MgBr + MgCl Equation I-7

The success of this method is due to the solubility of ferric chloride in organic solvents. No
reaction occurs if the ferrous halide is insoluble in the solvent, but high yields of ferrocene are
obtained if the ferrous ion is "solubilized™" by chelation. In the Grignard reaction, an excess of the

reagent is required.

Several other methods for the synthesis of ferrocene have been proposed. It can be prepared
by the direct reaction of cyclopentadiene with metallic iron [53], by the reaction of ferrous chloride
with sodium cyclopentadienyl in an ammonia solvent and the reaction of cyclopentadiene with the

ferrous complex of acetylacetone- dipyridine [54].

A method for preparing ferrocene and analogous compounds was developed following a
synthesis of the work of several research teams [55-63]. This method is essentially based on the
deprotonation of cyclopentadiene by redox with sodium in xylene (Equation 1-8), followed by a
reaction of the cyclopentadienyl salt with ferrous chloride in THF (Equation 1-9).

xylene
2 +2Na —> 2 +2Na* Equation 1-8
.H2

2(CsHg + Na*) + FeCl, —HE 5 (C5H;),Fe + 2NaCl Equation 1-9
1.4.2.  Electrochemical process

The cation of the transition metal obtained by the loss of one or more electrons can be
facilitated by the use of this metal as a cathode in an electrochemical cell. Although this process
is useful for some organometallic compounds, ferrocene cannot be synthesized efficiently by this
technique [64].

The anodic process is still rarely used in the synthesis of derivatives of organometallic

compounds. In 1968 Valcher and Aluni [64] proposed the synthesis of ferrocene by electrolysis of
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a solution of cyclopentadienylthallium using dimethylformamide and an iron anode which
oxidizes to Fe*?, and which then easily replaces thallium at the cathode (Equation 1-10).

Fe + 2TICp ——— Cp,Fe + 2TI" + ¢ Equation 1-10
I.5. Reactivity

Substituted ferrocenes can be prepared directly or indirectly. In the indirect preparation, the
ferrocene molecule is used as a starting point for the synthesis of other ferrocene derivatives, while
in the direct synthesis, the substituted ferrocene is prepared by the reaction of a suitably substituted
cyclopentadiene derivative compound with the iron by methods similar to those used for the
preparation of ferrocene itself. Only strong bases such as Grignard's reagent, organothalliums,
lithium or sodium reagents can give good yields of ferrocene derivatives from substituted

cyclopentadienes [65, 66].
1.5.1.  Substitution reaction

The similar properties between ferrocene and benzene contributed to the development of the
chemistry of this new molecule, and facilitated the performance of a wide variety of substitution
reactions on ferrocene. The mechanism of substitution reactions on the pentadienyl ring is based
on the direct formation of a sigma complex without the participation of the metal. Two
mechanisms are proposed [67].

Mechanism (I): It has a two-step process. The first is a rapid step where the electrophile E
destroys the metal-carbon bond in a reaction of SE2 with conservation of configuration, followed
by limiting the rate of removal of the proton from outside the molecule, the second step is an SE2
reversal reaction (Figure 1-11).

<

H
P Slw

— =

Figure I-11 Substitution mechanism (1)

@.-
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Mechanism (I1): this mechanism has a speed limitation of the attack by the electrophile from
the outside in an SE2 displacement with a reversal of the configuration, followed by the rapid

departure of a proton from the inside, with configuration conservation (Figure 1-12).

Figure 1-12 Substitution mechanism (I1)
1.5.2.  Oxidation reaction

Ferrocene can be oxidized to the ferrocenium ion by a wide variety of oxidizing agents.
During this oxidation, the iron atom, which can formally be considered as Fe (1) in ferrocene, is
oxidized to the Fe (lll)state . This can happen even when air is passed through a solution of
ferrocene at low pH values. This oxidation occurs during attempts of nitration or halogenation of
ferrocene using nitric acid or bromine respectively. Thus, the ferrocene molecule carries a positive

charge and resists any electrophilic attack.

Numerous studies on the controlled oxidation of ferrocene and its derivatives have been
reported [68, 69]. In order to decrease the conversion of ferrocene and its derivatives into relatively
unstable and unreactive ferrocenium ion, most reactions must be carried out under an inert

atmosphere.

Electrochemical reduction of ferrocene carried by the teams of Laviron in Dijon in DMF
and by Bard in Austin in SOz was able to demonstrate the existence of extreme degrees of oxidation
Fe (1) and Fe (IV). The potentials shown on Figure 1-13 are given relative to the saturated calomel
reference electrode (SCE) [70, 71].

-0.3 -0.3 -0.3

Cp,Fe'? =——= (p,Fe" ==——== C(p,Fe ==———== Cp,Fe

19 ¢ 19e¢ 19e 19e¢

Figure 1-13 The change in the oxidation state of the metal in ferrocene
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Ferrocenium ion is a fairly stable, water-soluble ion with a blue-glass color; a number of its
salts have been isolated and they are widely used as mild oxidants in organometallic chemistry.
They are accessible by contact of ferrocene with sulfuric acid (or concentrated nitric acid). It
happens that one wishes to reduce the corresponding ferrocenium salts to ferrocene derivatives,
which is easily achievable using an aqueous solution of dithionite, stannous chloride and ascorbic
acid or TiCls as shown on Figure 1-14.

2) HPF; aq

i 3) Na,S,05 or TiCl; aq

Figure 1-14 Oxidation reaction of ferrocene
1.5.3. Reaction with electrophiles

Ferrocene behaves like most aromatic compounds, allowing the synthesis of substituted
derivatives. A typical demonstration experiment is a Friedel Crafts reaction with acetic anhydride
in the presence of phosphoric acid as a catalyst. In the presence of aluminum chloride, Me2NPClI>
and ferrocene react to give ferrocenyldichlorophosphine [72], while treatment with
phenyldichlorophosphine under the same conditions leads to P,P-diferrocenyl-P-phenyl phosphine

[73]. Figure 1-15 represents some of the main reactions of ferrocene with electrophiles.
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Figure I-15 The main reactions of ferrocene with electrophiles.
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1.5.4.  Acylation reaction

The acylation of ferrocene, according to Fridel and Crafts reaction, can be carried out under
very mild conditions with, for example, acetic anhydride containing phosphoric acid as a catalyst,
this acylation leads to the monoacetylferrocene as major product together with the disubstituted
acetylferrocene as minor product. Using aluminum chloride as a catalyst, a good yield of both
mono- and diacetylferrocene can also be obtained, their ratio depends on the proportions of the

acylating reagent [74-81]. Figure 1-16 illustrated the reaction scheme.

COMe

(CH5C0),0
Fe > Fe
i H;PO, ':

COMe COMe

I-. (CH;C0),0 I: (CH;C0),0 I;

F|e > Fe > Fe

': H;PO, ': H;PO, E

COMe

Figure 1-16 Mono- and biacylation of ferrocene
1.6. Synthesis of some ferrocene derivatives

The aromatic character and the very high reactivity of ferrocene have allowed the synthesis
of a very large number of its derivatives which are used as main intermediates in organic synthesis
[77, 81]. These derivatives can be easily prepared and are sufficiently reactive to produce
intermediates useful for the synthesis of new organic compounds difficult to synthesize by

ordinary routes using organic compounds.

These intermediates are more useful for the synthesis of monosubstituted ferrocene
derivatives than for disubstituted ferrocenes. Thus, although monoacetylated ferrocenes have been

employed for the preparation of a large family of substituted ferrocene derivatives [82].

The N,N-dialkylaminomethylferrocene derivatives, such as N,N-dimethylaminomethyl-

ferrocene [83] are among the most widely used intermediates for the synthesis of substituted
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ferrocenes. Ferrocenylmethyltrimethylamonium iodide [84], Figure 1-17 is used as a starting

material for the preparation of a large number of monosubstituted ferrocene derivatives.

Me
+/
- N
I ~
X
' Me

Fe

Figure I1-17 Ferrocenylméthyltriméthylamonium iodide

The trimethylamine group in the ferrocenylmethyltrimethylamonium salt can be easily
substituted by nucleophiles, such as alkoxide and cyanide anions, Grignard reagents, carbanionic

reagents and amines.

Many methods have appeared in the literature for the preparation of ferrocenylmethyl-
trimethylamonium iodide [83-85]. Thus, the modification of phosphoric acid has also been
successfully employed for the aminomethylation of phenyl and methylferrocene [86], Figure I-18
illustrated the reactivity of ferrocenylmethyltrimethylamonium iodide and its use for the

preparation of many other reactive ferrocene derivatives.
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Figure 1-18 Synthesis of some ferrocene derivatives from ferrocenylméthyltriméthylamonium iodide
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1.6.1. N-ferrocenylmethylanilines synthesis

Using a wide range of substituted anilines as nueoclophiles, many N-
ferrocenylmethylanilines can be obtained from ferrocenylmethyltrimethylamonium iodide in
moderate yields. In the first step, the synthesis of N-ferrocenylmethylanilines is carried out by
treating the quaternary salt ferrocenylmethyltrimethylamonium iodide with an excess of anilines
in distilled water, at a temperature between 100 to 110 °C [87]. Figure I-19 shows an example of

this reaction.

uN*(CH3)3 H2i\i N
‘>N >R
H

i H,0 i

Fe + HI + N(CH;);

Y
"rj
o

': 100-110 °C E
S —Y

Figure 1-19 N-ferrocenylmethylaniline synthesis
1.7. Ferrocene applications

The applications of ferrocene in chemistry are indeed vast. The unique structure and
aromatic character of ferrocene [88] led to its ancient use in reducing carbon deposition and smoke
formation upon addition to fuel oils [52]. Ferrocene and its derivatives have been used in many
applications, including their use as radiation absorbers, combustion regulators, highly effective
non-toxic medicinal substances, components of various redox systems, etc... [89-91] In addition,
many journals have focused on the biological chemistry of ferrocene [92], its bioorganometallic
chemistry [93], its applications in glucose biosensors [94] and bioelectronics [95], the synthesis
and electrochemical properties of nucleic acid containing ferrocene acids [96]. Below are some of

its most important applications:
1.7.1.  Applications of ferrocene polymers

The introduction of metal atoms into polymers is a good method for the preparation of
promising materials for use in different applications and therefore, much literature to date relates
to polymers containing metals [20]. The metal atom can be arranged in a variety of different ways
relative to the polymer backbone [21], as shown in Figure 1-20. In type I, the metal atom can be
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attached to the polymer backbone using a linker such as an alkyl group. While in type Il the metal
atom is electronically bonded to the backbone of the polymer. On the other hand, in type Ill, the
metal atom is found in the backbone of the polymer itself. In addition, Fc-containing polymers are
considered to be an important class of metal-containing polymers which have different

applications due to the combination of polymer properties and metal properties [20].

@ = metal atom I:l = polymer backbone

" y (298 o

Typel Type 11 Type 111

Figure 1-20 Possible arrangements of the metal atoms relative to the polymer backbone [21]

Fc-based polymers have a variety of applications, including amperometric biosensors [22],
protein, DNA [23, 24], and hepatitis B surface antigen (HBsAg) immunosensors [25], and
monoxide sensors [26]. They can also be employed in the manufacture of optical logic devices
[27].

1.7.2.  Catalytic applications of unsymmetrical ferrocene ligands

Catalysis with 1,1A-asymmetric ligands is an area of research that is still in its infancy and
only preliminary results have been reported to date (apart from 1,1A-ferrocenyl oxazolines which
reported 1,2-homologs). This is in part due to the fact that selective monolithiation of
dibromoferrocene, which represents a high yielding systemic route for the synthesis of these types
of ligands, has only recently been developed [97-101].

1.7.2.1. Ferrocenylphosphate—carbene ligands

Asymmetric catalysis using transition metal complexes is a good strategy to obtain chiral
compounds according to Soradova et al. [102] Ferrocenylphosphate-carbene ligands formulated
to catalyze "domino" reactions comprising the conjugated addition of Grignard reagents to an a,
B-unsaturated lactone followed by entrapment of the enolate with an alkene. Promising results

obtained with high enantiomeric purity.
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1.7.2.2. Ferrocene-based palladium catalyst

Hanhan et al. [103] describes an efficient method for the synthesis of ortho-substituted
sterically hindered biaryls by the Suzuki-Miyaura coupling reaction of aryl chlorides and
heterocyclic chlorides not activated with boronic acid, using a Pd(I1)-diimine containing ferrocene
as a catalyst (Figure 1-21). A small amount of catalyst (0.1%) has been found to be very effective.
The stability of the catalyst in water, its bulk due to the presence of two ferrocene units and its
electronic properties play an essential role in the success of the catalyst. Hydrolysis of ionic
diimines and their complexes in water results in the deactivation of the catalyst and the reaction is

completed in 15 min.

OH
QCI n QB< H,0, K,CO;, catalyst :
OH M.W. irradiation

R 15 min
800W

BU403NS
=N. N=
Pd
clI” ¢
Fe Fe

@ Catalyst @

Figure 1-21 Suzuki—Miyaura coupling reaction [103]
1.7.2.3. Ferrocene-based compartmental ligands

Chandrasekhar et al. [104] used the ferrocene group to prepare compartmental ligands which
selectively bring together Zn(11)/4f heterobimetallic complexes (Figure 1-22). Two phenolate
oxygen atoms and an acetate ligand form a bridge between the metal ions Zn(Il) and Dy(lll). It
was expected that with the use of this ligand magnetically interesting 3d/4f heterobimetallic

compounds could be produced.
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Figure 1-22 Molecular structure of LZn(u-OAc)Dy(NO3)2 complex [104]
1.7.2.4.  Chiral ferrocenyldiphosphine ligands

Brunner and Janura [105] studied the phosphorus-chiral ferrocényldiphosphines, in which
the chirality arises from the optically active substituents (1R,3R,4S)-menthyl, prepared by a
selective lithium-halogen exchange and a P-1-ferrocenophane ring opening. Its rhodium complex
has been used as an asymmetric hydrogenation catalyst giving high yields but with moderate
enantiomeric excess with a variety of different substrates. The use of in the nickel catalyzed
Grignard cross coupling of 1-phenylethylmagnesium chloride with vinyl bromide was also

demonstrated, but the results revealed only a low enantiomeric excess.
1.7.3.  Conducting applications

Several ferrocene-tetrathiafulvalenes have been synthesized as donors to drive charge
transfer complexes because to the excellent structural and electrochemical features of the
ferrocene-containing tetrathiafulvalene ring. The first compound in this class of donor conductive
materials was discovered by Ueno et al. [106], and Bryce et al. [107] recently reported a very

similar sort of donor molecule.
1.7.4. Industrial applications

The increased interest in ferrocene derivative research can be ascribed to their good water
and air stability, attractive electrochemical characteristics, and non-toxic behavior [108, 109]. Fuel
oil additives to reduce the creation of soot, which contains iron, are one of their industrial
applications. Rocket and satellite fertilizers, UV absorbers, burn rate modifiers, and protective
coatings.
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1.7.5.  Agricultural applications

In agriculture, crop protection is a critical concern. Ferrocene derivatives have a wide range
of uses in agriculture, including as agrochemicals and catalysts for selective agrochemical
production. They can also be employed as soil remediation surfactants and as selective
colorimetric and electrochemical chemosensors. Triazole heterocycles are found in the majority

of ferrocene agrochemicals (fungicides, herbicides) [110, 111].
1.7.6. Medical and biological applications

Beside the fact that ferrocene attracted attention in medicinal studies by being a non-toxic
compound [112] ferrocene derivatives also have attracted attention as potential anticancer,

antibacterial, antifungal, and antiparasitic medicines.
1.7.6.1. Antiviral and Anticancer agents

The two most prominent derivatives, ferroquine (Figure 1-23) and ferrocifene (Figure 1-24),
were discovered in the 1990s and have since been extensively explored for the treatment of malaria
and cancer, respectively [113, 114]. The ferrocenyl group of these two compounds participates in
important metal-specific modes of action which contribute to the overall therapeutic efficacy of
the molecules. Despite the fact that ferroquine is in Phase Il clinical trials and ferrocifene is in
preclinical studies, no other ferrocene derivative - indeed, no other non-radioactive organometallic

compound of any kind has progressed in clinical trials [115].

)
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Figure 1-23 Ferroquine (FQ) Figure 1-24 Ferrocifen (Fc-TAM)

This perspective provides techniques for systematically incorporating ferrocenyl groups into

established medications or drug candidates in order to discover new pharmacological avenues.

Zegheb et al. [31] studied the anti-proliferative effect of 29 N-ferrocenylmethylaniline
derivatives against MCF-7 cell lines and the results indicated that among the studied derivatives,
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five were very active; the binding affinity of these five active derivatives to estrogen and
progesterone receptors was further investigated by molecular docking. The results of the anti-
proliferative tests and the molecular docking were in good agreement. Moreover, the application
of drug-likeness rules shows that most of these compounds, theoretically, can be bioavailable

orally.
1.7.6.2. Antimicrobial agents

Champdore et al. [116] were inspired by the medical applications of ferrocene to create
adducts by incorporating the ferrocenemethyl group in a heterocyclic base, which have been tested
against HIV-1, HBV, YFV, BVDV, and a variety of bacteria. Only compounds containing thymine
[117-119] were found to be cytotoxic to MT-4 cells. The only compounds that were effective
against HIV-1 were the ferrocenyl derivatives of 3-deoxy-3-azidothymidine [119, 120]. However,
they were found to be 10 to 300 times less potent than the reference medicine, 3-azidothymidine
(AZT).

1.7.6.3. DNAJ/BSA binding studies

One of the recent areas of research in organometallic chemistry is the synthesis and
development of detection systems for DNA detection [121, 122]. These systems (chips) allow
rapid, simple, sensitive and inexpensive genetic diagnosis by the method electrochemical
detection. To construct such a system, it is important to develop a reproducible method for
immobilizing a capture DNA probe on the surface of gold, and many types of immobilization
methods have been reported [123, 124]. Electrochemical systems for the DNA detection are
potentially cheaper and more reliable than conventional systems. fluorescence spectroscopy.
Ferrocene and its derivatives are often used in such devices due to their favorable electrochemical
properties [125, 126]. Several reviews have recently been published on this subject [127, 128].

Khannoufa et al. [129] studied the binding interaction of 3 N-ferrocenylmethylaniline
derivatives which are N-ferrocenylmethyl-2-nitroaniline (2FMNA), N-ferrocenylmethyl-3-
nitroaniline (3FMNA) and N-ferrocenylmethyl-4-nitroaniline (4FMNA) with albumin bovine
serum (BSA) by absorption spectroscopy, cyclic voltammetry and molecular docking techniques.
The results indicated that these derivatives could bind to BSA. Molecular docking study indicated
the preferred binding site, binding mode and further suggested that the binding mode of the three
compounds to BSA is hydrogen bonding and hydrophobic forces.
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1.7.6.4. Antioxidant agents

The antioxidant capabilities of ferrocene derivatives were studied by Khelef and Lanez
[130]. They used three different ferrocene derivatives bearing amine, amide, and hydrazine groups
(Figure 1-25), and evaluaed their antioxidant activities using four different methods, including
2,2-Diphenyl-1-picrylhydrazyl (DPPH) free radical scavenging activity, superoxide (O2™) anion
radical scavenging activity, phosphomolybdenum, and decrease in peak oxidation current of
oxygen methods. The ferrocene derivative (B) showed the highest DPPH and (O:™) radical

scavenging activity and was determined to be closest to that of standard antioxidant ascorbic acid.

Fe Fe Fe
— — —
(A) (B) ©)

Figure 1-25 three different derivatives of ferrocene containing amine, amide and hydrazin

Lanez et al. [131] have been also evaluated the superoxide anion radical binding parameters
with 2-(ferrocenylmethylamino)benzonitrile and 3-(ferrocenylmethylamino)benzonitrile using
cyclic voltammetry techniques. The antioxidant activity of the two compounds was also measured.
The results indicated an electrostatic interaction of the superoxide anion radical with the two

compounds as the dominant mode.
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11.1. Introduction

The measurement of the antioxidant potential and the monitoring of the oxidation processes
are approached globally by determining products resulting from the oxidation or by evaluating the
ability to scavenge radicals of reaction models. The first, older mode requires prior knowledge of
the compounds resulting from oxidation. Indeed, these methods look for certain functional groups
(aldehydes, ketones, dicarbonyls, etc.) in the derivatives of the original constituents. The second

relates the amount of radicals trapped to that of the antioxidant used [132].

Due to their high reactivity, reactive oxygen species (ROS) are responsible for a great deal
of damage to cellular constituents. This production of deleterious species is generally balanced by
their consumption at equal speed by the endogenous antioxidant system. The disruption of the

balance between pro- and anti-oxidant species is referred to as oxidative stress. [133].
11.2. Oxidative stress

Oxidative stress is an imbalance between the generation of ROS and the body's ability to
neutralize them and separate oxidative damage [134]. It corresponds to a disturbance of the
intracellular oxidative status [135].

Free radicals are produced by various physiological mechanisms because they are useful for
the body in reasonable doses. This physiological production is perfectly mastered by defense
systems. Under normal circumstances, the antioxidant / prooxidant balance is said to be in
equilibrium. If this is not the case, whether through antioxidant deficiency or as a result of
overproduction of radicals, the excess of these radicals is called Oxidative Stress. It is now
accepted that the phenomenon of oxidative stress is involved in the etiology of many
neurodegenerative diseases (Alzheimer's, Parkinson's, Huntington's), pathological disorders
(ischemia reperfusion syndrome), but also in the phenomena of aging [136].

11.3. Free radicals

A free radical is a molecule or an atom having one or more unpaired electrons, which makes
it extremely reactive [137]. The collection of free radicals and their precursors is often referred to
as reactive oxygen species [136]. The term "reactive oxygen derivatives” is not restrictive. It
includes the free radicals of oxygen itself, but also certain non-radical reactive oxygenated

derivatives of significant toxicity such as hydrogen peroxide H20Ox.
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Due to the involvement of free radicals in various pathologies, research into new molecules
that can compensate for a deficit in the natural anti-free radical protection system has been greatly
intensified [138].

Recently, chemists have been developing analogs of natural antioxidants by chemically
modifying them to increase their free radical scavenging properties. They are interested in the
development of more specific traps based on the particular reactivity of certain chemical groups

towards radical species [138].
11.3.1. Free radical formation

At the cellular level, ROS and reactive nitrogen species (RNS) can be produced in response
to a variety of stimuli, such as metabolic overload caused by an excess of macronutrients. The
main determinants of the generation of ROS or RNS are the family of nicotinamides adenine
dinucleotide phosphate oxidases (NOX), mitochondrial respiration, endoplasmic reticulum
function (ER) and nitric oxide synthase (NOS) [139].

ROS
SOD Fe* — Fe¥

i Il

Superoxide Hydrogen peroxide Hydroxyl

Peroxynitrite

Figure 11-1 Generation of the major reactive species of oxygen (ROS) and nitrogen (RNS)[140].
11.3.1.1. Redox reaction

The most common free radicals have a single celibate electron. They can be formed from a
radical species which undergoes a redox reaction. There is then loss or gain of electron (Equation
I1-1, Equation 11-2) [141].

Oxydation: R—-X->R-X't4+e >R +X"+e” Equation 11-1
Reduction: R—X+e” > R—-X""->R*"+X~ Equation I1-2
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One of the best-known examples is the Fenton reaction, which reacts ferrous iron and
hydrogen peroxide is presented in the following Equation 11-3:

H,0, + Fe?* - HO® + OH™ + Fe3* Equation 11-3
11.3.1.2. Homolytic rupture

The production of free radicals can also be done by homolytic breaking of a covalent bond,
which results in the formation of two entities each having a single electron (Equation 11-4).

R—X->R"+X* Equation 11-4

Homolytic rupture is the symmetrical partitioning of the common valence doublet, as
opposed to heterolytic rupture which gives rise to ions of opposite charge. This most commonly

occurs in the gas phase or in the liquid phase for molecules having weakly polarized bonds.

The oxygen molecule is representative of this type of rupture, the bond energy that connects
the two oxygen atoms (150 kJmol™?) is relatively low compared to the carbon-carbon bond (346

kJmol?) [142]. This bond being fragile, it is more apt to undergo homolytic rupture.
11.3.2. Radical reactive oxygen species
11.3.2.1. Superoxide radical (O2™)

In the human body, part of the molecular oxygen can univalent and sequentially capture an
electron, leading to the formation of the leader of reactive oxygen species: one of these reactive
species is known as superoxide anion [143], it generates as indicated in the following equation
(Equation 11-5).

0, +e” - 03 Equation I1-5
11.3.2.2. Hydroxyl radical

It mainly produces from superoxide anion and hydrogen peroxide in the presence of ferric

ions, during the Haber-Weiss reaction (Equation 11-6):
05~ +H,0, » ‘OH+ OH™ + 0, Equation 11-6

The hydroxyl radical has a very high reactivity in biological media, being able to combine
with many molecules with a rate constant of the order of 101° M2, s%. It is able to react with almost
all cellular components by electron exchange, addition on double bonds or tearing of a hydrogen
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atom, it is a very powerful oxidant, certainly constituting the most toxic free radical in biology.
The hydroxyl radical is therefore a very powerful oxidant and is believed to be at the origin of the
production of secondaryfree radicals, following its reaction with various cellular compounds
[144].

11.3.2.3. Perhydroxyl radical HO2*

This is obtained after protonation of the superoxide radical in a pH<4.8 medium. The
perhydroxyl radical is more reactive than superoxide because the standard redox potential is higher
as well as its rate constants, especially with respect to polyunsaturated fatty acids (linoleic,

linolenic, arachidonic acids) [145].
11.3.3. Non-Radical reactive oxygen species
11.3.3.1. Hydrogen peroxide H202

Hydrogen peroxide H>O> which is not a free radical can be formed secondarily to the
dismutation of (O2") by superoxide dismutase or produced by bivalent reduction of oxygen thanks
to a large number of dehydrogenases, in particular acyl CoA dehydrogenase, NADH
dehydrogenase, xanthine oxidase, uricase, mono-amine oxidase... etc (Equation I1-7, Equation
11-8) [146].

05 + 2H* - H,0, + 0, Equation I1-7
0, +2e” + 2H* - H,0, Equation 11-8

Hydrogen peroxide is also a very reactive oxidizing agent; this is why it is often used as a
disinfectant and as a bleaching agent. If not quickly destroyed, it can decompose and produce
hydroxyl radicals that attack macromolecules in the cell [147].

I11.4. Diseases linked to oxidative stress

By revealing abnormal biological molecules and by overexpressing certain genes, oxidative
stress will be the main initial cause of several diseases: cancer, cataracts, amyotrophic lateral
sclerosis, acute respiratory distress syndrome, pulmonary edema, accelerated aging, Alzheimer's,

Parkinson's, intestinal infections, rheumatism, atherosclerosis, diabetes [148, 149].
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11.5. Diet and oxidative stress

The production of ROS can occur at the cellular level in response to various stimuli, such as
the metabolic overload itself caused by an overabundance of macronutrients. Indeed, when the
calorie intake exceeds the energy expenditure, the increase induced by the excess substrate

activates the Krebs cycle which causes the formation of ROS.

Thus, excessive ingestion of macronutrients induces the production of ROS [140]. In this
sense, a study has shown that the ingestion of 75¢g of glucose induces an increase in the production
of superoxide in leukocytes, which are then released into the extracellular environment. A similar
response has also been observed following the ingestion of saturated fat [150]. Thus, a meal rich
in fat and carbohydrates induces a more intense and prolonged oxidative and inflammatory
response with increased production of ROS. in obese patients compared to normo-weighted
subjects [151].

For this, it is possible to choose antioxidant and non-inflammatory foods to minimize
inflammation and postprandial oxidative stress. The advent of molecular biology shows the role
of certain small molecules in antioxidant defense; indeed, this defense can be reinforced by

exogenous inputs.

Diagram (Figure 11-2) shows that a good diet directly provides most of the elements that can

ensure good antioxidant defense. This power supply guarantees:

= A supply of vitamins A and C, carotenoids and flavonoids which have the role of
neutralizing radical entities by trapping them (Scavangers).
= Trace elements such as iron, Selenium, copper, zinc and manganese essential for the

activity of antioxidant enzymes (Cu, Zn-SOD, Se-GPXx).

Based on these data, scientists are attaching more and more importance to a diet rich in fruits
and vegetables, this finding therefore leads to an important reflection on the effect of long-term
antioxidant therapy in the context of prevention of pathologies where oxidative stress is involved
(eg cardiovascular disease). With this in mind, the SUVIMAX study proposed to evaluate the
impact of a daily intake for 8 years of a mixture of antioxidants at physiological doses (30 mg of
Vit E, 120 mg of Vit C, 6 mg of b-Carotene, 100ug of selenium and 20 mg of zinc on the incidence

of the onset of cardiovascular diseases [152].
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Figure 11-2 Role of diet in oxidative metabolism [140].
11.6. Antioxidants

Antioxidants are molecules with the ability to neutralize free radicals which are responsible
for many diseases. Antioxidants are compounds that inhibit or delay the oxidation process by

blocking the initiation or propagation of chains of oxidative reactions [153].

Natural or synthetic antioxidants are used to prevent many diseases (cardiovascular and
neurodegenerative, inflammation, diabetes, etc.) and aging, due to the excessive formation of free
radicals. Antioxidants are also used in foods to delay spoilage, rancidity or discoloration which is

often due to oxidation caused by light, heat and certain metals [154].
11.6.1. Enzymatic antioxidants

One of the enzymatic antioxidant defense systems is made up of three enzymes: superoxide
dismutase SOD, glutathione peroxidase GSH-Px and catalase. These enzymes have a
complementary action on the radical cascade at the level of superoxide and hydrogen peroxide,

ultimately leading to the formation of water and molecular oxygen [155].
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SOD
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Catalase
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Glutathion peroxydase
H202 + 2GSH » H202 + 2GSH

Figure 11-3 Enzymatic reactions trapping reactive oxygenated species ROS

There are many other antioxidant enzymes such as peroxyredoxins, heme oxygenase,
glutathione transferase, thioredoxin reductases or thioredoxin peroxidases. Most of these enzymes,
as well as the oxidative damage repair enzymes, will use a reducing equivalent donor, NADPH,

which, along with glutathione, forms the hubs of antioxidant defense [156].
11.6.2. Non-enzymatic antioxidants

This group of antioxidants is made up of several compounds capable of reacting directly or
indirectly with ROS. The indirect mechanism involves the chelation of transition metals which

prevents the production of the highly toxic hydroxyl radical [157].

Certain antioxidant compounds such as vitamins E (tocopherol), C (ascorbic acid), Q
(ubiquinone), or carotenoids provided by food, act by scavenging radicals and capturing the single
electron, transforming them into stable molecules or ions. The trapping vitamin will become a
radical, then will either be destroyed or regenerated by another system. Thus, vitamin E is
regenerated by vitamin C which is itself regenerated by enzymes, ascorbate reductases. This type
of antioxidant is called a scavenger for the Anglo-Saxons. Many food compounds can also have
this behavior: polyphenols, alkaloids.... There are also endogenous compounds synthesized by
cells and playing the same role; the most important is reduced glutathione which protects not only

against oxygen radicals, but also against peroxides or NO* [156, 158].
11.6.3. Antioxidants of plant origin

Carotenoids and polyphenols constitute large families of compounds (several hundred)
including B-carotene, caffeic acid and quercetin. Carotenoids and polyphenols are generally good
scavengers of hydroxyl HO® and peroxyl RO" radicals. They are therefore capable of inhibiting
the lipid peroxidation chains, but in a less efficient manner than that of a-tocopherol. In addition,
carotenoids have a specific role of capturing oxygen in gulet 102, which allows them to exercise
protection against damage induced by the ultraviolet rays of sunlight [141].
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11.6.4. Synthetic antioxidants

These are butylhydroxytoluene (BHT), butylhydroxyanisole (BHA) and gallic acid esters:
propyl gallate, doctyl gallate, and dodecyl. BHT is a highly effective and inexpensive chain
breaking antioxidant. BHA is a mixture of two positional isomers whose efficiency is somewhat
lower than that of BHT.

There are other little used synthetic antioxidants such as tertiobutylhydroquinone (TBHQ)
used for the preservation of crude oils, nordihydrogualaretic acid (NDGA), the latter is used in
products for topical use and 4-hydroxymethyl 2,6-ditertiobutylphenol or lonox 100, whose
antioxidant properties are similar to those of BHT (Figure 11-4) [159].

OH OH
C(CH3)3 (H;C);C C(CHj3);
OCH; CHj,
3-BHA BHT
OH OH
C(CH,); (H3C)C C(CH;);
OH CH,OH
TBHQ Tonox 100

Figure 11-4 Chemical structure of some synthetic antioxidants.
11.7. In vitro evaluation of antioxidant activity

Currently, a wide variety of analytical methods for determining antioxidant capacity are
available. These analyzes differ from each other in terms of reaction mechanisms, oxidants and
target species (probes), reaction states and the form in which the results are expressed. In addition,
even when only one of these analyzes is considered, it generates other parameters to be taken into
consideration such as: the solvent, the reaction time and the pH [160].

A battery of assays measuring different aspects of antioxidant behavior is recommended to

produce a complete antioxidant profile. Comparing data from different studies is difficult. It is also
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of great importance to choose accepted, validated and standardized methods, with data both
comparable and available in the literature.

The design of such methods is based on the use of oxidizing species and probes (proteins,
triacylglycerols, and cell models) with the appropriate biological significance that the reaction

conditions (concentration, reaction time, pH...), closely related to which can be in vivo [160].
11.7.1. Stable radical scavenging methods and evaluation of their reduction capacity
11.7.1.1. Trapping of the 2.2-diphenyl-1-picrylhydrazyl (DPPH") radical

In this analysis, the purple-colored DPPH" is reduced by the so-called antioxidant molecules
to pale yellow hydrazine, Figure 11-5. The trapping capacity is generally assessed in organic media
by monitoring the decrease in absorbance at 515-528 nm until the absorbance remains constant
[161].

The determination of the antioxidant capacity is based on the amperometric reduction of
DPPH" to glassy carbon. The current which results from it on a glassy carbon electrode polarized
at the fixed potential, is proportional to the residual concentration of DPPH" after the reaction with
the antioxidants [162].

SUO NS

D |
N +RH —— NH +R
O,N NO, O,N NO,
NOZ N02
DPPH (free radical) DPPH (non-radical)

Figure I1-5 Reaction of DPPH with an antioxidant

In opposition to what has always been believed, the reaction mechanism is based on an
electron transfer reaction, while hydrogen atom abstraction is a marginal reaction process, because

it occurs slowly in strong solvents, such as methanol and ethanol [163].

The steric accessibility of DPPH" is a determining cause of the reaction, since the small
molecules which have better access to the site of the radical probably have a relatively higher
antioxidant capacity [164]. Many high molecular size antioxidant compounds that react quickly
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with radicals may react slowly or may even be inert in this assay. The lack of DPPH" or similar
radicals in biological systems is also a weak point.

11.7.1.2. Antioxidant iron reduction power (FRAP analysis)

FRAP analysis measures the ability of antioxidants to bring back the ferric complex of
tripyridyl-s-triazine 2.4.6 [Fe(ll)-(TPTZ).]** intensely to the blue-stained ferrous complex
[Fe(1)-(TPTZ)2]** in an acidic medium [165]. The values are calculated by measuring the increase
in absorbance at 593 nm and relating it to a standard solution of ferrous ions or a standard solution
of antioxidants [166].

One point to be aware of is the concomitant production of Fe(ll), which is a well-known
prooxidant, and can result in the generation of additional radicals in the reaction medium. In
addition, compounds which absorb at the same wavelength can mix with it, leading to

overestimation of the results [167].
11.7.1.3. Analysis by the Folin-Ciocalteu (FC) reagent

The chemistry behind FC analysis is based on the transfer of electrons into an alkaline
medium from phenolic compounds and all other molybdenum reducing species, forming blue

complexes that can be detected spectrophotometrically at 750-765 nm [168].

Therefore, it is only recently that FC analysis has been proposed to measure the total
reducing capacity of samples [164]. Excellent linear correlations between FC analysis with other
analyzes (TEAC and DPPH?’, for example) have been established [169].

11.7.2.  Oxygen free radical scavenging methods
11.7.2.1. Peroxyl radical trapping (ROO?®)

The ORAC (Oxygen-Radical Absorbance Capacity) measurement developed by Cao et al.
[170] is a simple and reproducible method for assessing the antioxidant capacity of different
molecules [171]. B-PE (Porphyridium cruentum f Phycoerythrin) is a fluorescent protein
extremely sensitive to oxidative stress. In the presence of AAPH [(2,2'-azobis(2-amidinopropane)
dichloride], a donor of the peroxyl radical, the tetrameric structure of B-PE is modified, it
dimerizes. This dimerization depends on the concentration of radicals peroxyls of the reaction
medium can be followed by measuring the decrease in fluorescence of B-PE as a function of time.

This kinetics of decrease in fluorescence is directly related to the concentration of free radicals
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present in the reaction volume under these defined conditions of time and concentrations of -PE
is from AAPH.

11.7.2.2. Superoxide radical trapping (O2*)

This test evaluates the ability of a product to capture a free radical, the superoxide anion O2"
This radical is generated in vitro by the hypoxanthine / xanthine oxidase system. In this method,
the radical reduces the yellow-colored NBT2+ (Nitro-Blue Tetrazolium) to purple-colored

formazan blue which absorbs at 560 nm.

Thus an antioxidant compound capable of capturing the superoxide anion will prevent the
formation of formazan blue and the solution will remain yellow. The absorbances obtained make
it possible to calculate a percentage inhibition of the reduction of NBT2+ compared to a control
consisting of the reaction medium devoid of antioxidant compound. it can be then drawn a curve
representing the logarithm of the percentage inhibition as a function of the concentration of test
compound, and determine the IC50 (concentration inhibiting 50% of the activity) of the compound
[172].

11.7.2.3. Trapping of hydrogen peroxide (H202 scavenging activity)

One of the most common methods to assess the scavenging capacity of hydrogen peroxide
is based on the absorption of this molecule in the UV domain. As the concentration of H20:
decreases by the scavenging compounds, the absorbance value of the latter at 230 nm also
decreases. However, it is quite normal for samples to absorb at this wavelength as well, thus

requiring a blank measurement to be performed [160].
11.7.2.4. Analysis of the scavenging capacity of the hydroxyl radical (HO")

Due to the high reactivity of hydroxyl radicals, almost all molecules in biological systems
can be considered as HO" radical scavengers. Thus, evaluation of direct HO" entrapment may be
irrelevant for evaluating the antioxidant action of a compound, simply because very high

concentrations of the scavenger are required to compete with adjacent molecules in vivo.

Several in vitro methodologies for the determination of the trapping capacity of HO" are
available in the literature, mostly based on the set Fe** + EDTA + H,0> + ascorbic acid system, to
produce a constant flux of HO". These radicals attack deoxyribose at position 2 (used as a target),

degrading it into a series of fragments, some react on heating with thiobarbituric acid at low pH to
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give a pink chromogen [173]. If an antioxidant is added to the reaction mixture, it will compete
with deoxyribose for the HO" radical, thus preventing degradation of target species [174].
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lll. Theoretical background of expermintal and computetional methods

I11.1. Introduction

The electrochemistry method is one of the most popular technics for the characterization of
new compounds. The basic thermodynamic quantity that is assigned to an electrode process is the
standard or formal reduction potential (Eo or Ef) [175]. Electrochemistry is also an important
method for demonstrating reactions involving transfers of electrons [176]. it relates electrons
transfer to chemical changes. The redox potentials of an antioxidant could be determined by cyclic

voltammetry which considered to be good measures of their antioxidant capacities.

The use of mathematical and theoretical methods to the solution of chemical concerns is
described as computational chemistry. Molecular modeling, a subset of computational chemistry,
focuses on predicting the behavior of individual molecules within a chemical system. The most
precise molecular models use ab initio or “first principles” electronic structure methods, based on
the principles of quantum mechanics, and are generally very computer intensive. Molecular
modeling, on the other hand, has been a quickly changing and developing area due to increases in
computer storage capacity and processor capability, to the point that it is now possible to solve
relevant problems within a short period of time [177].

These methods are needed in this study. thus, in this chapter, some basic and important

concepts will be discussed in order to make all these methods a bit familiar and clear to the reader.
111.2. Cyclic Voltammetry (CV)

Cyclic voltammetry is one of the analytical methods that make it possible to specify the
conditions under which an oxidation and reduction reaction can be carried out electrochemically

and possibly to establish the mechanism.

The general principle of voltammetry is therefore to obtain a response (the current) of the
system under study to the excitation (the potential) responsible for the desired electrochemical
reaction. This operation is carried out by carrying out an exploration by imposition and progressive
variation of the electrode potential (potential sweep). Analysis of the resulting figure (response |

as a function of E) provides information on the properties that determine its shape.

Knowledge of the fundamental characteristics of electrochemical reactions is obtained
experimentally, by determining figures which express the relationship between current and
electrode potential. These figures are called voltammograms, their determination is the object of

voltammetry.
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Its most frequent use consists in carrying out two linear scans, the first called “outward” and
the second called “backward” in the opposite direction so as to return to the starting potential, after
having therefore carried out a cycle. In this case, the method is called "cyclic voltammetry™, which
is its standard name. VVoltammetry only reaches its true power when it is practiced back and forth.
It is cyclic voltammetry, the principle of which is to perform a linear potential sweep from an
initial potential E;, given by Equation I11-1:

E=E; vt Equation I11-1

where v: the sweep speed, the sign + corresponds to a sweep towards positive potentials, the

sign — to a sweep towards negative potentials.

The evolution of the current I(t) which crosses the electrochemical system during
voltammetry, represented on a graph as a function of the value of E(t), bears the name of
voltammogram or also polarization curve. In the case of cyclic voltammetry, the direction of the

scan is indicated by arrows. Figure I11-1 represents the general shape of a voltammogram | = f(E).
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Figure I11-1 General appearance of a cyclic voltammogram.
The characteristic quantities of a voltammogram are:

Ipc, Ipa: cathode and anode peak current, Epc, Epa: cathode and anode peak potential,
Epcr2, Epar: potential at mid-height of the cathode and anode peaks, AEp; potential difference
between Epc and Epa.
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111.2.1. Mathematical expressions of peak currents and potentials in a charge transfer

The mathematical expressions for peak current and potential were originally developed for
a forward sweep (linear voltammetry) by Randals et al. [178] for fast systems, and by Delahay
[179] for slow systems. This theory is extended by Matsuda et al. [180] to semi-rapid systems. The
work of Nickolson et al. [181] have allowed the development of the relations describing the

experimental curves of cyclic scans.

In the case of a rapid charge transfer, electrochemical parametres are linked to each other as

shown in equations Equation I11-2 to Equation I11-6:

Ox + ne” © Red Equation I11-2
I, = 0.2694n3/2DY?CxV/%  (mA) Equation 111-3
0.029 Equation I11-4
E,=Ep,,+ — (mV)
0.059 Equation I11-5
Epy = Epe=—— ()

Ip, 1 Equation I11-6

Ipc -

In the case of a semi-rapid charge transfer, the pic current denity is given by the following

Equation I11-7:
I, = 0.269An3/2DY?Co K 1/ | Equation 111-7
In the case of a slow (irreversible) charge transfer, the current is described by Equation 111-8:

I, = 0.269An(an)/2Dy/? Cx 112 | Equation 111-8
Ks: Speed constant, a: Transfer coefficient, Dr: Diffusion coefficient (cm?/s), Cr: Concentration,

V: Scanning speed (V/s), A: Electrode surface (cm?2), and n: Number of electrons.
I11.2.2. Criteria for analysis and discrimination of the deferent systems

The study of the variations of the current and the potential according to the scanning speed
(Ip = f(v}'?) and Ep = f(logv)) can inform us about the nature of the limiting stage of the current

measured on the electrode mechanism.

= |If Ip = f(v*?) is a straight line; the reaction is governed by pure diffusion.
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= If Ip = f(v"?) is a concavity curve turned towards the axis of the currents; the process at the
electrode involves charge transfer accompanied by adsorption; and in the case where the
concavity is turned green, the axis of the scanning speeds; the process at the electrode is
associated with a chemical reaction.
= If Ep=f(logv) is a line:
o zero slope; the reaction to the electrode is rapid.
o with a slope other than zero and equal to -30 on (mV); this is a slow charge transfer.

= IfEp=f(logv) isacurve and Ip = (v*?) is a line; we are dealing with semi - rapid processes.

In that case; note that for a process governed by diffusion; the peak current is proportional

to the analytical concentration of the electroactive species.
111.3. Molecular modeling

Molecular modeling is a collection of computerized algorithms based on theoretical
chemistry methodologies and experimental data that may be used to evaluate molecules and
molecular systems, as well as forecast molecular, chemical, and biological properties [182, 183].

It acts as a link between theory and practice in the following ways:

= Extract results for a particular model.

= Compare experimental results of the system.

= Compare theoretical predictions for the model.

= Help understanding and interpreting experimental observations.

= Correlate between microscopic details at atomic and molecular level and macroscopic
properties.

» Provide information not available from real experiments.
111.3.1. Quantum calculation methods
111.3.1.1. Schrodinger equation

The geometric structure, the modes of vibration, the enthalpies of reaction as well as other
observables derive from the electronic structure of the studied system. This electronic structure is
deduced from the time-independent multi-electronic Schrddinger equation, given by Equation
111-9 [184]:

HY = EY Equation 111-9
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Where H is the Hamiltonian operator, ¥ is the wave function of the system and E is its
energy. The total energy E is calculated by applying the time-independent molecular Hamiltonian
to the orthogonal wave function ¥. The Hamiltonian is written in terms of operators of kinetic and

potential energies of electrons and nuclei as follows (Equation 111-10):
H=T,+ Ty + Ve + Voo + Vyn Equation 111-10
Where:

T, is the operator of the kinetic energy of electrons, given by Equation 111-11:
n
. 1 ) :
T, = _Ez Vi Equation 111-11
i=1
Ty is the operator of the kinetic energy of nuclei (Equation 111-12):
N

1N Vi

- ) — Equation 111-12
2 M

Vye is the operator of the coulombic potential energy of attraction between electrons and

nuclei, given by the following Equation 111-13:

n N 7
Vye = — z Z Zk Equation 111-13
e ik

1., donate the coulomb repulsion energy between electrons (Equation 111-14):

Z Z Equation 111-14
Ty

i j>i
Vyn represents the Coulomb repulsion energy between nuclei (Equation 111-15):
ZyZy .
Z Z Equation 111-15
=110>1 Rkl

Where the Hamiltonian terms are in atomic units (m, = 1,h = 1,4me, = 1). V? is the
Laplacian operator. m, and M, are the masses of the electron and the nucleus respectively.

d; represents the distance between the electron i of coordinate r; and the nucleus k of charge Zj,
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and coordinate Ry. 1;; represents the distance between electrons i and j. Ry, is the distance between

the nuclei k and [ of respective charges Z, and Z;. Under the apparent simplicity of its formulation
hides in fact several insoluble problems which have led to approximations and original resolution
methods. We will detail some of them in the following paragraphs, in particular those we have
used, from the density functional theory.

111.3.1.2. Born-Oppenheimer approximations

The Born-Oppenheimer approximation [185] is based on the separation of the movements

of electrons and nuclei because electrons move much faster than nuclei due to the large mass

difference between them (% = Fl%). We can thus imagine an image such that the electrons
N

revolve around the fixed nuclei. This leads us to solve the problem of the movements of electrons
in the field of supposedly fixed nuclei. This approximation simplifies the Schrodinger equation by
decoupling the motions of nuclei from those of electrons. Here electronic and nuclear movements

will be studied separately. The wave function ¥ describes the system and takes as variables the

positions of electrons # and nuclei R. It can be decomposed as a linear combination of products of

electronic and nuclear orthonormal wave functions:
N
W(r R) = Z W, (r, R)Wy; (R) Equation 111-16
i=1

i being the index of the considered electron.

In the framework of the Born-Oppenheimer approximation, the Hamiltonian A will be

decomposed into two terms: a purely electronic Hamiltonian A, and a nuclear Hamiltonian Hy.
The electronic Hamiltonian is written acoroding to Equation I11-17:
H =T.(r) + Vye R, 1) + V0 (1) | Equation 111-17
And the purely electronic Schrdodinger equation then becomes as given by Equation 111-18:
A,%,(r,R) = E,(R)¥,(r,R) | Equation 111-18

In the electron wave function W, (r, R) the nuclear coordinates R act as parameters for the

electron wave function.
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The nuclear Schrodinger equation is given by Equation 111-19
HyWy(R) = Exy(R)Wy(R) Equation I11-19

Where Wy (R) is the nuclear wave function that does not depend on the electronic

coordinates r.
H), is the nuclear Hamiltonian which is written as indicated in Equation 111-20:
Hy =Ty(@) + Vyn(R,7) + E.(R) Equation 111-20

Nuclear energy Ey (Equation I11-19), corresponds to the total energy E; within the
framework of the Born-Oppenheimer approximation and represents the electronic and nuclear
energy of a given system. The Born-Oppenheimer approximation applies when electronic and
nuclear Hamiltonians are separable. In other words, when nuclear motion does not cause electronic

states to change.
111.3.1.3. Hartree-Fock method (HF)

One of the main electronic structure methods is the Hartree Fock (HF) method, which was
developed in the 1920s after the discovery of the Schrddinger equation. The Hartree-Fock (HF)
method [186, 187] is a variational method. It makes it possible to determine the orbitals and the
associated energies of an atom or a molecule, taking into account in an average way the

electrostatic interactions between the electrons [188, 189].

Hartree-Fock approach is based on the independent electron model approximation. We can
separate the variables by assuming that each electron moves in the mean field of the other
electrons. The polyelectronic wave function W, is described as a product of all the so-called spin-
orbital monoelectronic functions ¢;. The spin-orbitals ¢; are written as a product of a space

function ¢; relating to electron i and a spin function a;.
o; = @0, Equation 111-21
The function o, can be an a or § function depending on the nature of the electron's spin
(— Zou + 1).
2 2
The associated electronic wave function is then written as follows:

Y, =¢;(1)p,(2) ... ... ... ¢ (n) Equation 111-22
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The Pauli principle [190] is not respected by the wave function W, (Equation 111-22) in this
form, because it is not antisymmetric with respect to a permutation of 2 electrons. In order to
satisfy the Pauli principle, the zero-order electronic wave function for an n-electron system is
written as a Slater determinant defined as follows, Equation 111-23:

| [HD @

y, = P
val [¢1(n> qsn(n)]

Thus, the exchange of two electrons corresponding to the permutation of two rows (or two

Equation 111-23

columns) has the effect of changing the sign of the determinant on the one hand and on the other

hand, the spin-orbitals must be different from each other. to have a non-zero determinant.
Electronic Hartree-Fock (HF) energy is written in the following form (Equation 111-24):

IRCALAL

E, = Equation 111-24
(W)

The operator H, can be written as a sum of mono-electronic and bi-electronic operators:
— Equation I11-25

He:Zhi+ Ti-

n n n
i=1 i=1j>1 Y

Where h; is the mono-electronic operator who uses the single electron i. It is defined as

follows:

N
Zx

h —lv2

k

Equation 111-26

The bi-electronic term ri cannot be solved exactly, because it causes the coupling of all the
ij

movements of the electrons. This term constitutes a difficulty. All methods of quantum chemistry

differ in the way they take into account the term bi-electronics ri
ij

The Hartree-Fock method solves the problem of the bi-electronic term ri by introducing the

ij
Fock monoelectronic operator F;. It consists in writing the bielectronic contribution as a sum of
monoelectronic operators. Each of the n monoelectronic operators represents the average influence

of the electrostatic field of the n-1 electrons.
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The monoelectronic operator of Fock F; is defined according to the coulomb J; and exchange

K; operators as follows:
Fi=h; + Z(]j .9 Equation 111-27
J

We can express the total HF energy as a function of the mono and bi-electronic integrals:
n n n
EHF Zz&'i +ZZ(]U _KL]) +VNN Equation 111-28
i=1 j=1j>1
The term ¢; represents the energy of the spin-orbital ¢;.

The term J;; represents the coulomb integral. It corresponds to the repulsion between the

charge distributions of two electrons. It can be interpreted as a classic electrostatic repulsion. It is

expressed in the following form:

Jy = (08, 75010, 0) Equation I11-2

K;j is the exchange integral. It has no physical meaning in the classical sense. It arises from

the need to antisymmetrize the wave function. It is expressed in the following form:

Ky = (9:09,0)| 5|40 0) Equation 111-30

K;j is the Coulomb repulsion energy of nuclei. It is introduced as a parameter.

The sign (-) comes from the antisymmetrization of the wave function ¥, by exchanging two
electrons (to satisfy the Pauli exclusion principle). Its minimization with the constraint of
orthonormalization of the set of spin-orbitals at (¢>i|¢j) = §;; leads to the so-called Hartree-Fock

system of equations.
Filgi) = &ilp)  i=123.... n Equation 111-31

The Fock Operator F; as well as the Coulomb Operator J;; and the Exchange Operator K;;
issent operate on only one orbital. They are called monoelectronic operators. We see here that the
operators J and K are expressed as a function of the solutions of Equation 111-26. We are therefore

in the presence of a set of n nonlinear monoelectronic equations that would have to be solved by
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an iterative process. From a set of test orbitals ¢;, we compute the Fock operator to then deduce a

new set of functions ¢;.

This procedure is called the “Self-Consistent Field Method” (SCF) because the iterations are
continued until the electrostatic field felt by an electron (field caused by the other electrons in the
other orbitals) remains. stationary. An exact solution of the HF equations, obtaining atomic
orbitals, is possible for atoms comprising a nucleus and an electron. Further developments are
nevertheless necessary to solve the Schrédinger equation for systems with several electrons. This
requires the consideration of the LCAO [191] (Linear Combination of Atomic Orbitals)
approximation which consists of developing molecular orbitals ¢; on a basis consisting of a set of

atomic orbitals y,,:

m
Q; = z CiuXu i=123.... n Equation 111-32
u=1

With m being the number of base functions, C;,, designates the coefficients of the molecular
orbitals assumed to be real and developed on the base functions. y,, constitute the basic functions

used in our calculations. If this base is complete, it means that the molecular orbitals ¢; are exact.

There are two types of HF methods the first one known as RHF (Restricted Hartree-Fock
method) and the second is UHF (Unrestricted Hartree-Fock method).

111.3.1.4. Density Functional Theory (DFT)

Taking into account the electronic correlation requires the implementation of elaborate post-
HF calculations. When the studied systems are very large, this becomes almost impossible. An
alternative to all of these methods is the density functional theory. In addition, the precision of the
results obtained as well as the computational performance of the DFT method currently make it
an essential tool for the computation of molecular properties. It is based on two theorems
established by Hohenberg and Kohn (1964) [192].

111.3.1.4.1. Hohenberg and Kohn theorems

The goal of DFT methods is to find a functional (that is to say a function dependent on a
function) allowing to connect density with energy. The density functional theory is based on the
postulate proposed by Thomas and Fermi [193, 194] that any electronic property of a system can

be calculated from its electron density. Hohenberg and Kohn, in 1964, took up this theory and
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demonstrated that there is a one-to-one correspondence between the energy of a system E and its

electron density p(7) [192]. The energy can therefore be calculated as a functional density:
E = Flp(#)] | Equation 111-33

In a second theorem, Hohenberg and Kohn established the variational principle for energy,

by showing that the electron density of the system in the ground state p, is that which minimizes

the energy calculated thanks to this same functional, it is that is, (g—/F)) = 0. This theorem was
P=Po

subsequently generalized to the lowest energy state of a given symmetry, provided it was non-
degenerate.

For a system made up of N nuclei and n electrons, the energy can therefore be written:

E = T[p]f Vne @ p(F)dT + J[p] + Exclp] Equation 111-34
exp

Where:
T[p] is the Kinetic energy of the system;
vy (7) is the interaction energy of an electron with the N nuclei;

J1p] is the bielectronic integral describing the Coulomb interaction between electrons, which

is expressed simply as a function of the density p(7);

Exc[p] is a non-classical integral, called “"exchange and correlation energy", which has no
known analytical expression. It ensures the exclusion of two electrons of the same spin (exchange
part) and opposite spin (correlation part). The expression of this integral must therefore be

approximated by physical models, which will be detailed later.
111.3.1.4.2. Theorem of Kohn and Sham

The methodology of Kohn and Sham [195] reduces to a system of monoelectronic equations,
which can then be solved using the same algorithms as the Hartree-Fock method. It consists in
imagining a system of electrons without interactions, which would have the same electron density
p(7) as the real system. In the case of a closed-layer system, the wave function of the system can
then be constructed as the Slater determinant of n monoelectronic orbitals ¢;. The electron density

of the system is then written:
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p() =) 0o Equation I11-35
i
The kinetic energy of the fictitious system is:
vZ
Tslpl = Z <<Pi - <Pi> Equation 111-36

And the energy of the real system can be expressed as follows (Equation 111-37).

E=T[p] = f Ve PP d7 + JIp] + Byelo] Equation I11-37

exp

where:

Exclp] = Exclp] + T,[p] — Ts[p] Equation 111-38

Most often, the difference T,[p] — Ts[p] is negligible and Exclp] can be equated with the

energy of exchange and correlation Ex.[p].

Using the variational principle, we then show that Equation 111-37 can be transformed into a

system of coupled equations whose unknowns are the monoelectronic orbitals ¢;:

&S Iplei(7) = g0:(F) Equation 111-39

Since the Kohn-Sham operator f%5 is expressed as a function of the electron density p,
which is itself calculated from the orbitals ¢;, these equations must be solved iteratively, like the
Hartree equation- Fock. We therefore proceed in the same way by introducing atomic orbital bases.
The resolution provides a set of monoelectronic orbitals called "Kohn Sham orbitals”, from which
we calculate the electron density of the system (#), then the energy of the real system using
Equation 111-39. In the case of a system with open layers, the UDFT (unrestricted density
functional theory) formalism makes it possible to apply the Kohn Sham method by defining the
spin densities p®(#) = p# (). It is essential to remember that the Kohn-Sham monoelectronic
orbitals are only mathematical intermediaries describing a fictitious system. However, they often
have many similarities with orbitals obtained by Hartree-Fock or post-Hartree-Fock methods and

as such are sometimes used for qualitative interpretations.
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111.3.1.4.3. Successes and limitations of DFT

Several works have been carried out in recent years, using DFT calculations and giving good
results on large chemical systems, taking into account the effects of electronic correlation. Many
properties (molecular structures, vibration frequencies, ...) are well reproduced. However, the DFT
method still suffers from several shortcomings, one of which is the lack of real criteria that allow

functional and molecular properties to be improved [196, 197].
111.3.1.5. Time Dependent Density Functional Theory (TD-DFT)

Time Dependent Density Functional Theory (TD-DFT) is an approach that describes
electronic excitations. Similar to Hohenberg and Kohn's first theorem of DFT, the Runge-Gross
theorem [198] establishes a direct relationship between the time-dependent electron density and
the time-dependent potential v[p(r,t)]; therefore the potential and the wave function will be
density dependent. Recently van Leeuwen generalized the Runge-Gross theorem to molecular
systems [199]. Likewise, the time dependent Kohn-Sham equations should be derived. Assuming
that there is a time-dependent reference system without interaction with an external potential
vs(r, t) whose electron density pg(r,t) is equal to the exact density of the real system with

interaction p(r, t).

N
p(r,t) = ps(r,t) = Zlqbi(r, t)|? Equation 111-40
i

If the external potential exists, we can deduce the time dependent equations of Kohn and
Sham:

E[p(r),t] = T,[p(r)] + fveff[p(r, t)]p(r, t)dr Equation 111-41

p(r',t) . 0Exc[p] Equation 111-42
Very [0, 0] = o) + | ER ar 4+ SEEE

Then just solve the time-dependent schrdodiger equation:

O0Y(r,t)

[Ts + vess|Wi(r,0) = i o Equation 111-43

The computation of excited states with TD-DFT is faster than ab initio methods. The theory
of linear response is applied to the charge density of a molecule subjected to an electric field

oscillating over time. The dynamic polarizability is obtained from the response of the dipole
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moment, and the energies of excitations are then calculated as the poles and the forces of oscillators
as the residues of this response, developed in the basis of the eigenstates of the operator
Hamiltonian DFT. Wave functions are determined a posteriori for the excited states, in the form
of linear combinations of simple excitations from the determinant Kohn Sham. This method is
only true within the limit of an exact density functional. In practice, it is very sensitive to the
misbehavior of the long-range exchange-correlation potential, where the density is most
polarizable. As a result, the energies calculated for the excited charge transfer states can be
severely affected. This method, suitable for large systems due to its low cost, is therefore not yet

reliable in all cases, and should be used with caution.
111.3.1.6. Functional generations
111.3.1.6.1. Local density approximation (LDA and LSD)

In only one model case, that of the uniform gas of electrons (corresponding quite well to the
electrons of the conduction band of a metal), we know the exact expressions or with an excellent
approximation of the terms of exchange and correlation respectively. In this Local Density
Approximation (LDA) [200], the electron density is assumed to be locally uniform and the
exchange-correlation functional is of the form:

Ex¢“lp] = f p(Mexc(p(r))dr Equation 111-44

Its extension to unrestricted systems takes the name LSD which means (Local Spin Density).

the exchange-correlation functional distinguishes the density o and B in the form:

Exe” [par pg] = f p(exc (pa(r), pp(r)) dr Equation 111-45

The corresponding keywords in Gaussian are SVWN (exchange, Slater, correlation, Vosko,
Wilk, Nusair) and SVWNS5, these methods often provide quite good molecular properties

(geometry. Frequencies) but generally lead to very bad energy data such as binding energies etc.
111.3.1.6.2. Hybrid Generalized Gradient Approximation (GGA) and Functional

To overcome the shortcomings of the LDA and LSD methods, the generalized gradient
approximation considers exchange-correlation functions depending not only on the density at each
point, but also on its gradient, of the general form:
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ESE4 pas pp] = f £ (e P, VPa, Vpp)dv Equation 111-46

The exchange part is in general the Becke functional (B), the correlation part that of Lee,
Yong and Parr (LYP) or that of Perdew-Wang (PW) with the variants 86 and 91, hence finally the
keywords BLYP, BPW86 and BPW91.

Finally, it turned out that in the LDA methods, there was some good to take, that on the other

hand, as we have seen, the HF method correctly handled the exchange energy.

Hence hybrid methods based on an empirical combination of these energies with energies
with GGA. The most widely used is the “three-parameter Becke” method (B3); thus, the B3LYP
functional [201-204] used the LYP functional for the GGA part. The parameters were adjusted to
reproduce the values of the atomization energies. The GGA part can also be the functional PW91
and PW86.

111.3.1.7. Bases of atomic functions

The choice of the basis of orbitals is essential for quantum chemistry calculations. There are
two basic types of functions mainly used in the calculations of electronic structures: Slater Type
Orbitals (STO) and Gaussian Type Orbitals (GTO) [205].

111.3.1.7.1. Slater Type Orbitals (STO)

At the very beginning of quantum chemistry, Slater proposed the use of functions of the

form:
X, Lm(r,0,9) = NY, (6, p)r"1eér Equation 111-47

Where N is a normalization constant, and the functions. Y, ,,, are of spherical harmonic type.
The exponential dependence of the distance between the nucleus and the electrons is that of the
orbitals of the hydrogen atom. Thus, a linear combination of several STOs makes it possible to
correctly reproduce the true orbitals. Even if the dependence on r allows us to correctly write the
behavior of orbitals when r — 0, the computation of integrals with three or four centers (like bi-
electronic integrals) is not analytically possible. Thus, these orbitals are generally only used for

atomic and diatomic systems where high computational precision is required.
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111.3.1.7.2. Gaussian Type Orbitals (GTO)

An alternative to Slater's orbitals is the use of Gaussians, which are written in the Cartesian

coordinate system in the form:
X3 L, (x,y,2) = Nxlxylyzlze=ar® Equation 111-48

With [, 1,1, determining the type of orbitals (for example, [,[,[, = 0 represents an s-type
orbital, [,.[,,l, = 1 the p-type orbitals and [, 1, [, = 2 allows to obtain d and s type orbitals). The

index «a is called exponent. The center of the function usually coincides with the center of the

nucleus.

The multiplication of two Gaussians results in a Gaussian. Thus, bi-electronic integrals are
much easier to evaluate with Gaussians than with Slater functions. On the other hand, they have
the drawback of not correctly describing the exact orbital in the vicinity of the nucleus (r — 0),
but also of decreasing too quickly as a function of r. Thus, the representation of molecular orbitals
requires many more Gaussians than Slater functions (we roughly consider that three GTOs make
it possible to model an STO). Despite this drawback, the ease of calculating bi-electronic integrals
makes Gaussian functions the most widely used orbitals in quantum chemistry.

Gaussian bases have a fairly poor representation of atomic orbitals because they do not have
the exact behavior at the origin (non-zero derivative) or at great distances (too fast decay with r)
on the other hand their interest is that all the integrals involved in the calculations can be calculated
explicitly without recourse to a numerical integration. To compensate for this incomplete
representation of atomic orbitals by Gaussian functions, we use linear combinations of Gaussians
as base functions. These functions are called contracted Gaussian functions. There are a multitude

of possible Gaussian bases for performing an SCF calculation.

= The simpler base is STO-3G, also called minimal base. this means that Slater type orbitals
are represented by three Gaussian functions.

= The next level includes split-valence bases such as 3-21G, 4-31G and 6-31G where the
first number represents the number of Gaussians used to represent 1s orbitals. Valence
orbitals are represented by two functions which are composed of the numbers of Gaussians

given in the second part of the two numbers of the base denomination.

The base 6-31G will have six Gaussians for the 1s orbital. Three Gaussians for one function

representing the 2s orbital and 1s Gaussian for the other function, and the 2p orbital will also have
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three Gaussians for one of the functions and one Gaussian for the other. for greater flexibility, the

polarization functions can be added.
111.3.1.7.3. Polarization functions

They correspond to unoccupied orbitals in the ground state atom. They will therefore be of
type p, d for the hydrogen atom, and of type; d, f and g for the atoms of the second period. They
must increase the flexibility of the base used and take into account the deformations of the atomic

valence orbitals during the formation of the molecule. Their role in the base is decisive.

Thus, the introduction of polarization functions in the base is necessary for the determination
of the geometry of particular molecules, such as for example the non-planar structure [206] of
H3O™ or structures containing hypervalent atoms such as, for example, phosphates. Likewise,
many properties could not be described correctly without the presence of polarization functions in
the base: energy quantities such as inversion barriers, rotation barriers, electrical quantities,
spectroscopic quantities. It exists in the literature [207, 208] many proposals for the values of the
exponents of these polarization functions The presence of this type of functions in a base is
generally indicated by the letter "P" except in the nomenclature of Pople where the FP are
represented by an asterisk (*) if only the base of atoms other than hydrogen has FPs or two asterisks
(**) if all the atoms are affected by this extension of the base. For example, using a 6-31G ** base
for a molecular calculation means that the core electrons of atoms are described using a linear
combination function of six Gaussians, the valence electrons by two functions, one linear
combination of three Gaussians and the other consisting of a Gaussian, and that, moreover, there
is a set of polarization functions on all the atoms of the molecule (p-type functions on hydrogen

and functions of type d, or f or g on the other atoms depending on their nature).
111.3.1.7.4. Diffuse functions

Another type of function must necessarily expand the atomic base used whenever the
physical phenomenon corresponding to the property studied requires a good description of the
space located beyond the valence orbitals: these are the diffuse functions. These functions are
generally uncontracted and have a low exponent which allows them to cover the diffuse space
located a great distance from the nucleus. They have the same quantum number | as the valence
orbitals of the atoms considered. Their role is decisive in the study of the properties of anionic
species or of any phenomenon involving them, such as the determination of electron affinity, for

example. They are also necessary for the treatment of molecules comprising strongly ionic bonds,
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for the determination of spectroscopic quantities, for the study of excited valence states, atomic or
molecular Rydberg states and also for the study of molecular interactions.

Several methods for determining the exponents of diffuse functions have been proposed,
including minimizing the energy of anions, or by extrapolation using the property of exponents of
functions of a given symmetry, which constitute a geometric progression [209]. It is commonly
accepted that the exponent of a diffuse is generally four times smaller than the smallest exponent

of a valence function.

In the nomenclature of Pople, a diffuse function is represented by the sign +. So, using a
base 6-31+G** means that the core electrons are described using a linear combination of 6
Gaussians, the valence electrons using two functions, one linear combination of three Gaussians
and the other made up of a single Gaussian; moreover, each atom carries a polarization function,

the heavy atoms also carrying a diffuse function.
111.3.2. Molecular Mechanics (MM)

The expression "Molecular Mechanics" currently designates a method of calculation which
allows, a priori, to obtain results of molecular geometries and energies based on classical
mechanics. MM appeared in 1930 [210], but developed from the 1960s, when computers were

more accessible and more efficient.

MM is based on the Born-Oppenheimer approximation that electrons are much faster than
nuclei and nuclei are therefore implicitly processed. MM is an empirical method where atoms
(nuclei) are represented by masses or spheres, and bonds by springs of different strengths. The
values of these forces come from experimental data from vibrational spectroscopy, from X-ray
diffraction data or from values obtained by ab-initio methods. By calculating all of these forces,
according to the rules established for harmonic oscillators, we obtain molecular energy and

determine the three-dimensional structure.

Today, MM is used to interpret NMR data. The main advantage of MM over other methods
is the speed of calculations. This is due to a simplification of the force field equations; it is therefore
possible to process very large molecular systems. On the other hand, this method does not take
into account the molecular electronic structure. It is therefore impossible to study systems in which
electronic effects are predominant. Thus, the validity of the results (results of the energies) depends

only on the original parameterization of the constants internal to the force field.
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In addition, the value of steric energy obtained in MM does not have any physical meaning
in absolute terms; it is only the comparison between two values obtained for two different

conformations that can be interpreted.
111.3.2.1. Interaction energy of bonded atoms

The bond stretching, bending and torsion interactions are called bonded interactions because
the atoms involved must be directly bonded or bonded to a common atom. The Van der Waals and

electrostatic (qq) interactions are between non-bonded atoms.

The total steric energy of a molecule can be written as a sum of the energies of the

interactions:
Esteric energy = Estr T Epena + Etor + Evaw + qu Equation 111-49
111.3.2.1.1. Stretching energy

Defines the energy brought into play by the variations in the length r of the links after

extension and compression from their equilibrium values.

@lll'e

Ky

Figure I11-2 Stretching between two atoms

Eser = Z K, (r— req)

bonds

Equation 111-50

req: bond length at equilibrium;

kr: force constant.
111.3.2.1.2. Bending energy

Defines the energy involved in the variations of angle 0 between two contiguous bonds,

around an equilibrium value 6o.

Figure 111-3 Bending of valence angles
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Epena = Z Kg(6 — 6eq) Equation 111-51

bonds
eq: angle at equilibrium;

ke: force constant.
111.3.2.1.3. Torsional energy

Defines the energy involved in rotating part of a molecule around a bond.

Figure I11-4 dihedral angle formed by atoms 1-2-3-4

Eor = z Ky(1+ cosn @) Equation 111-52

bonds

ko: force constant;
n: periodicity (n =1, 2, 3, 4, 6).

111.3.2.1.4. Van der Waals Energy

The Van der Waals energy function, reflects the attraction and repulsion between two atoms

that make up a dipole.

o 0
—>

Figure 111-5 Van der Waals interaction between two atoms

Evaw = RiZ R_i6j Equation 111-53

Aijj, Bij: parameters depending on the nature of atoms i and j, distant from r;;.
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111.3.2.1.5. Energy of electrostatic interactions

The energy of electrostatic interactions, is written in the form of a Coulomb potential

between atoms considered to carry a net charge.

o — 0
+—r
Figure 111-6 electrostatic interactions

_ 4iq;
Eqq = P Equation 111-54
> 4y

qi, qj: partial charges of atoms i and j, distant from rj;
gij. dielectric constant accounting for the attenuation of the electrostatic interaction by the

environment (solvent or molecule itself).
111.3.2.2. Force field in molecular mechanics

A force field consists of a set of potential energy functions (“analytical energy function™)
associated with a series of numerical parameters, obtained experimentally (IR, microwave ...) or
evaluated theoretically. It is therefore a multidimensional potential energy. that is, a sum of binding

and non-binding contributions to N-bodies [211].

= Forasingle molecule, we can count several thousand of these individual contributions.

= The development of a new force or parameter field (parameterization), remains a major
challenge for complex chemical functions, i.e., conjugated ketone, phosphonate, sulfate
...etc.

» In addition, compatibility from one force field system to another is often not possible.

The performance of a force field can be related to certain parameters.
111.3.2.2.1. The different fields of force and their fields of application

It is difficult to define a universal force field that would be suitable for the study of small
organic molecules as well as for the study of large proteins via organometallic compounds. Several
force fields have therefore been developed in order to study these different classes of molecules.

Here is a non-exhaustive list [212]:

=  AMBER: (Assisted Model Building with Energy Refinement) Force field for proteins and

nucleic acids
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= CHARMM: (Chemistry at HARvard Molecular Mechanics) Force field for proteins,
nucleic acids and lipids.

= MM2, MM3: Generalist force field (small molecules) by N. L. Allinger [213, 214]. This
force field makes it possible to treat certain effects due to the system pi.

= MM3PRO: Version of MM3 whose parameters are suitable for the study of proteins.

= OPLS: (Optimised Potentials for Liquid Simulations) Force field for proteins as well as for
certain classes of organic molecules. This force field is of the “united-atom” type. that
hydrogen atoms are included in the atom that carries them, for example one type of atom

would represent a —CHa.
111.3.2.2.1.1. Parametrization
111.3.2.2.1.1.1. Reference parameters

The energy functions described below contain many parameters (Ko, Ko, dipole moments,
rotational barriers, etc.) which are generally adjusted from experimental data deduced from the
analysis of model compounds (spectroscopy vibrational, crystallography, thermodynamics, etc ...)
or in some cases deduced from quantum mechanical calculations. These parameters are optimized
so that the calculated properties (geometries, energies, heats of formation, etc.) come as close as

possible to the experimental properties of the model compounds in the database.
111.3.2.2.1.1.2. Substitution parameters

The databases of the different force fields are generally very limited. The absence of
reference parameters in particular for heterocyclic systems requires a choice of substitution

parameters or ad hoc parameters.
111.3.3. Semi-Empirical methods

A semi-empirical method is a method in which part of the calculations necessary for Hartree-
Fock calculations are replaced by parameters adjusted to experimental values (the Hamiltonian is
always a parameter by comparison with reference compounds). In general, all these methods are
very precise for the families of given products close to those used for parameterization (MNDO,
ZDO, CNDO, NNDO...etc) [215].

= MNDO method [216] (Modified Neglect of Diatomic Overlap) which takes in account the
repellencies between the electron’s pairs and the electron-electron repellence directions;

= ZDO method (zero differential overlap) is based on the Huckel method for the 7 electrons;
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CNDO method (Complete Neglect of Differential Overlap) which takes in account only
the atomic orbital of spherical symmetry and assesses the repellence integrals as the orbital
would be sphere. In this case are two methods CNDO/1 and CNDO/2 which are used for
the spectrum parameters;

INDO method [217] (Intermediate Neglect of Differential Overlap) which includes the
monoelectronic repellence integrals between atomic orbital of the same atom;

NDDO method (Neglect of Differential diatomic overlap) which takes in account the
orientation direction of the orbital;

MINDO/3 [218] method is an particular case of the NNDO method which assesses the
monoelectronic repellence integrals;

SAM1 (Semi-Ab-Initio Model 1) [219] In SAM1, two-electron integrals are calculated
using a standard STO-3G basis set (and hence the appearance of ab initio in the title). The
resulting integrals were then scaled, and the Gaussian terms in the core—core repulsions
were retained in order to fine-tune the calculations;

AML1 (Austin Model 1) Next came Austin model 1 (AM1), due to M. J. S. Dewaret and his
collaborators [220]. AM1 was designed to eliminate the problems from MNDO caused by
a tendency to overestimate repulsions between atoms separated by the sum of their Van
der Waals radii. The strategy adopted was to modify the core—core terms by multiplication
of the Coulomb term with sums of Gaussian functions. In the original AM1 paper there are
four terms in the Gaussian expansion. Each Gaussian is characterized by its position along
the A-B vector and by its width. This significantly increased the number of parameters for
each atom. The performances of the semiempirical method consist in the smaller cost of
them and it their speed, but also in the fact they can determine some properties that cannot
be established experimentally;

PM3 (parameterized method 3) is the third parameterization of MNDO which contains
essentially all the same terms as AM1. The parameters for PM3 were derived by J. J. P.
Stewart [221] in a more systematic way than for AM1, many of which were derived by
‘chemical intuition’. As a consequence, some of the parameters are quite different from
those of MNDO but the two models seem to predict physical properties to the same degree

of accuracy.

111.3.4. Types of calculations

Computational chemistry (also called molecular modelling; the two terms are the same) is a

set of techniques for investigating chemical problems on a computer. Questions commonly

investigated computationally are:
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111.3.4.1. Molecular geometry

The three-dimensional arrangement of the atoms that form a molecule is known as molecular
geometry. It covers the molecule's overall form, as well as bond lengths, bond angles, torsional

angles, and any other geometrical characteristics that govern each atom's position.
111.3.4.2. Geometry Optimization

Geometry Optimization is a standard computational chemistry calculation to find the lowest
energy or most relaxed conformation for a molecule. The approach is the same for all levels of

calculation, involving an iterative “jiggling” process like that described for molecular mechanics.

At each step, the molecular geometry is slightly changed and the energy of the molecule is
compared to the last cycle. The computer shifts the molecule a bit, calculates the energy, shifts it
a bit more, and continues until it finds the lowest energy. This is the minimum energy of the
molecule and is obtained with the optimized geometry. Recall that the energies from molecular
mechanics can only be used in a relative sense, while those from quantum electronic structure

methods can be compared in an absolute sense, such as the heats of formation [222].
111.3.4.3. Single point calculations

Single point calculations are often used in combination with a geometry optimization to
investigate steric hindrance. In this case the method only performs one computational cycle to
calculate the energy of a particular fixed geometry. In a thermodynamically controlled reaction,
the energetic difference between two conformations is often due to steric hindrance. If the product
molecule optimizes in one conformation, you can use single point calculations to determine how

much more energy is needed to form the non-preferred conformation.

The structure drawing and manipulation part of the software will allow you to move only
that part of the molecule that changes in the higher energy form, leaving the rest of the molecule

optimized.

The single point calculation performed on this modified molecule will give an energy that
you can directly compare with the optimized energy to find the energy difference between the
lower and higher energy conformers. For example, the energetic difference between having a

constituent in the axial or equitorial position on a cyclohexane ring can be determined [222].
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111.3.4.4. Transition state calculations

Transition state calculations can be thought of as the reverse of geometry optimizations. In
this case, the method searches for a structure of maximum energy, a transient intermediate which
cannot be isolated experimentally. For example, this type of calculation allows one to examine

transition state energies and geometries of intermediates involved in carbocation rearrangements.

The literature contains standard models that should use as the starting point for these
calculations. It takes an amount of effort and experience to properly analyze transition state

structures and energies [222].
111.3.4.5. Electronic density and spin calculations

Electronic density and spin calculations allow visualization of electronic properties such as
electron densities, electrostatic potentials, spin densities and the shapes and signs of molecular
orbitals. The values for a particular property at each point in the 3-dimensional space around a
molecule are displayed on the 2-dimensional computer screen as a surface of constant numerical
value, often called an isosurface which can be rotated in any direction to study it. Alternately,
numerical variations of a given property (such as electron density) at a defined distance from the
molecule can be displayed as property maps using color as a key yielding what is called a property
map. Carrying out surface calculations and viewing their graphical representations are major
activities in computational chemistry and can provide useful insight into the mechanisms of

organic reactions [222].
111.3.4.6. Chemical Reactivity

For example, knowing where the electrons are concentrated (nucleophilic sites) and where
they want to go (electrophilic sites) enables us to predict where various kinds of reagents will
attack a molecule [222].

111.3.4.7. IR, UV-Vis and NMR spectra:

IR, UV-Vis and NMR spectra can be calculated, and if the molecule is unknown, someone
trying to make it knows what to look for. allow the calculation of infrared stretching and bending
absorption frequencies and it is a lot of fun to view animations of these types of motions in
molecules. The vibrational frequency of a two-atom system is proportional to the square root of
the force constant (the second derivative of the energy with respect to the interatomic distance)

divided by the reduced mass of the system (which depends on the masses of the two atoms) [222].
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111.3.4.8. Energies of the Frontier Molecular Orbitals HOMO and LUMO

The energies of the frontier orbitals HOMO (highest occupied molecular orbital) and LUMO
(lowest unoccupied molecular orbital) are descriptors commonly used in QSAR analysis. They
reflect the reactivity of a molecule. Higher HOMO energy suggests a higher affinity of a molecule
to react as a nucleophile, lower LUMO energy suggests a stronger electrophilic nature of a

molecule.

In addition, electrophilic and nucleophilic attacks will most likely occur at atoms where the
coefficients of the corresponding atomic orbitals in HOMO and LUMO, respectively, are large
[223].

Energy
High A
Unoccupied
 molecular
orbitals
LUMO —m8m8 . e;g:(ltlfgg)tn _e_
|:> ‘f excited energy
HOMO —e—e— _e_
-©O—6O6~  Occupied -o0—-
 molecular
-O—6O | orbitals -o0—6-
Low -o0—6- -o0—6O-
in ground state in excited state

Figure I111-7 Diagram of the HOMO and LUMO of a molecule (each circle represents an electron).
111.4. Quantitative Structure-Activity Relationship (QSAR) Modeling

Quantitative Structure-Activity Relationship (QSAR) analysis is based on the general
principle of medicinal chemistry that the biological activity of a ligand or compound is related to
its molecular structure or properties, and structurally similar molecules may have similar
biological activities [224]. This molecular structural information is encoded in molecular
descriptors and a QSAR model defines the mathematical relationships between the descriptors and
the biological activities of known ligands to predict the activities of unknown ligands. QSAR
methods have been applied in several scientific studies including chemistry, biology, toxicology
and drug discovery to predict and classify the biological activities of virtual or newly synthesized
compounds [225-228].
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111.4.1. Main Steps in QSAR Analysis

To develop QSARs, a series of compounds, called a training set, is used. The compounds in
the training set ideally, the same or similar mechanism of biological action to ensure that the same
factors influence the activity of all compounds under investigation. For all compounds in the series,
biological activities are evaluated and compound structural descriptors are calculated. Statistical

tools are then used to derive QSARs.

Biological data J% Training set Chemical structure
representation

W
[ Statistical analyses ]

[ Preliminar\{ models(s) ]

Evaluation ufgle quality of
the model(s)

[ Modification of the training set ]

and further statistical analyses

[ Refined model(s) ]

Figure 111-8 The main steps in QSAR analysis
111.4.2. Tools and Techniques of QSAR
111.4.2.1. Molecular Descriptors

The crucial point in the QSPR approach is an appropriate description of the molecular
structures. The chemical descriptors take account of the different aspects of the chemical
information. The molecular descriptor expresses chemical information transformed and encoded
from a molecule and effectively solves chemical, pharmaceutical, and toxicological problems. The
advantage of theoretical molecular descriptors is in developing compounds that have never been
synthesized or explored experimentally. Molecular descriptors are well known for their ability to

establish linear regression relationships with physicochemical and biological properties [229].
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111.4.2.1.1. Constitutional Descriptors

Constitutional descriptors can simply obtain the information from the chemical composition
of the compounds. Typical constitutional descriptors include molecular weight, total numbers of
atoms, bonds, and rings in the molecule. These are one-dimensional (1D) descriptors that can
easily be obtained with knowledge of the molecular formula. Unfortunately, the linear relationship
between constitutional descriptors and physicochemical properties cannot sufficiently prove that

a physical mechanism reflects molecular interactions [229].
111.4.2.1.2. Topological Descriptors

Topological descriptors are two-dimensional (2D) descriptors obtained from information on
the molecular topology; they express the atomic connectivity in the molecule and can be calculated

from 2D graph representation of molecules [230].
111.4.2.1.3. Geometrical Descriptors

Geometrical descriptors are derived from three-dimensional (3D) structures of molecules
defined by the coordinates of atomic nuclei and the size of the molecules represented [229].
Weighted holistic invariant molecular (WHIM) descriptors contain another prospective class of
molecular geometric parameters, WHIM descriptors are obtained from the molecular (x, y, 2)
coordinates of the molecules with 3D structure, in which the descriptors capture detailed
information on molecular size, shape, symmetry and atomic distribution. The derivation of WHIM
descriptors can be obtained from centered molecular coordinates using the PCA approach from

the weighted covariance matrix of atomic coordinates [231, 232].
111.4.2.1.4. Electronic Descriptors

Electronic descriptors reflect the electronic structure of the molecule, based on 3D structure
and the charge distribution in the molecule. The descriptors can be obtained from the calculation

with ab initio or semi-empirical approaches.
111.4.2.2. Biological Parameters

In QSAR analysis, it is imperative that the biological data be both accurate and precise to
develop a meaningful model. It must be realized that any resulting QSAR model that is developed
is only as valid statistically as the data that led to its development. The equilibrium constants and

rate constants that are used extensively in physical organic chemistry and medicinal chemistry are

69



lll. Theoretical background of expermintal and computetional methods

related to free energy values AG. Thus, for use in QSAR, standard biological equilibrium constants
such as Ki or Km should be used in QSAR studies.

Likewise, only standard rate constants should be deemed appropriate for a QSAR analysis.
Percentage activities (e.g., % inhibition of growth at certain concentrations) are not appropriate
biological endpoints because of the nonlinear characteristic of dose-response relationships. These

types of endpoints may be transformed to equi-effective molar doses.

Only equilibrium and rate constants pass muster in terms of the free-energy relationships or
influence on QSAR studies. Biological data are usually expressed on a logarithmic scale because
of the linear relationship between response and log dose in the mid-region of the log dose-response
curve. Inverse logarithms for activity (log 1/C) are used so that higher values are obtained for more
effective analogs. Various types of biological data have been used in QSAR analysis. A few

common endpoints are outlined in Table I11-1.

Table 111-1 Types of biological data utilized in QSAR analysis

Source of Activity Biological Parameters

Isolated receptors

Rate constants Log k
Michaelis-Menten Constants Log 1/Km
Inhibition constants Log 1/Ki
Cellular systems
Inhibition constants Log 1/IC50
Cross resistance Log CR
in vitro biological data Log 1/C
Mutagenicity states Log TA98
In vivo systems
Biocencentration factor Log BCF
In vivo reaction rates Log I (Induction)
Pharmacodynamic rates Log T ((total clearance)

111.4.3. Statistical Methods Used in QSAR Analysis

Statistical methods are an essential component of QSAR work. They help to build models,
estimate a model's predictive abilities, and find relationships and correlations among variables and

activities. A suitable statistical method coupled with a variable selection method allows analysis
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of this data in order to establish a QSAR model with the subset of descriptors that are most
statistically significant in determining the biological activity. The statistical method can be broadly

divided into two: linear and non-linear method.

In statistics a correlation is established between dependent variables (biological activity) and
independent variables (physiochemical properties or molecular descriptor). The liner method fits
a line between the selected descriptor and activity as compared to non-linear method which fit a

curved between the selected descriptor and activity. Commonly used statistical methods are listed

as follows:

1. Principal component analysis (PCA) 10. Genetic partial least squares (GPLS)

2. Cluster analysis 11. Logistic regression

3. Simple liner regression 12.  K-Nearest Neighbor classification
4. Multiple liner regression (KNN)

5. Stepwise multiple liner regression 13. Neural Network

6. Principal component regression (PCR) 14. Discriminant analysis

7. Continuum Regression 15. Decision Trees

8. Partial least squares (PLS) 16. SIMCA

9. Genetic function approximation (GFA) 17. Canonical Correlation

I111.4.4. Multiple Linear Regressions

The Multiple Linear Regression (MLR) [233] is an extension of the classical regression
method to more than one dimension. MLR calculates QSAR equations by performing standard
Multivariable regression calculations using multiple variables in a single equation. MLR expresses

a single dependent variable (y) as a linear combination of multiple independent variables (x):
y=axs+bx, +--+k Equation I11-55

Where a, b are the coefficients of the regression, and Kk is a constant, the regression model

can be built in a stepwise manner.
I111.4.5. Statistical Parameters
111.4.5.1. Coefficient of Determination (R?)

The coefficient of determination is found by squaring the correlation coefficient and is used
as a more precise way to interpret the correlation coefficient. It is useful because it gives the

proportion of the variance in one variable that is “explained” by the other variable. It represents
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the percent of the data that is the closest to the line of best fit [234]. The coefficient of
determination can be determined by the mathematical formula:

Z?:l(yi,cal - yi,obs)z _ ESS

R? = —
2?:1(yi,cal - 3_’)2 TSS

Equation 111-56

The coefficient of determination is such that 0 < R2 < 1, The stronger correlation R when it

is closer to 1.
111.4.5.2. Correlation Coefficient (R)

Correlation coefficient is a simple statistical measure of relationship between one dependent
and one or more than one independent variables and it is use as a measure of the statistical fit of a
regression based model in QSAR [235].

The value of r is such that -1 < R < +1. The + and — signs are used for positive linear
correlations and negative linear correlations, respectively. If the predicted and observed values
have a strong linear correlation r is close to 1, however if there is no linear correlation or a weak
linear correlation r is close to 0. The value of the correlation coefficient can be strongly influenced

by one outlying point.
111.4.5.3. Fischer Statistic (F)

The F-statistic is used to test the statistical significance of the regression [236]. Hence, the
larger the F value is above the critical value, the better the regression. As can be seen from the
equation below the F-statistic increases as the number of data points increase and the coefficient

of determination increases.

F_(n—v—l)RZ_ESSn—p—l
~ (1-R>»v P RSS

Equation 111-57

In the above equation RZ is the coefficient of determination, n is the number of data points,
and v represents the degrees of freedom. The degrees of freedom can be determined by subtracting

one from the number of variables in the regression equation (Equation 111-58) [236].
Yi=fXi,B) +e Equation 111-58

Where, Y; is the dependent variable, X; is for the independent variables, £ is the unknown

parameters, e; is the error terms.
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111.4.5.4. Standard Deviation (S)

Standard deviation (S) is a statistical measure of the spread or uncertainty around the mean.

It is defined by the equation:

n . — )2
. j2l=1(yl,caz 13’) _ \/ RSS : Equation I11-59
n—p-— n—p-

Where, y; .4, is each individual data point, ¥ is the mean of the data set, n is the number of

data points, and p is the number of independent variables.

If many data points are clustered tightly around the mean, then the standard deviation is
small. However, if data points are scattered widely around the mean, then the standard deviation
is large. A useful property of standard deviation is that, unlike variance, it is expressed in the same

units as the data.
111.4.5.5. Variance (r)

The variance is the average of the squared standard deviation from the mean. Sums of

squares are directly related to variances.

n . — )2
= \/Zi=1(yl.0b5;l y) Equation I11-60
n —

111.4.5.6. Quality Factor (Q)

Quality factor is calculated by equation:

Q= Equation I11-61

Where r is variance and S is standard deviation. Over fitting and chance correlation, due to
excess number of descriptors, can be detected by Q value. Positive value for this QSAR model

suggests its high predictive power and lack of over fitting [237].
111.4.6. Validation of QSAR Model

After the model equation is obtained, moreover the stability and the goodness of fit of the
model, it is also significant to estimate the power and the validity of the model before using it to

predict the biological activity. Validity is to establish the reliability and significance of the method
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for a particular use. Therefore, validation of a QSAR model must be done. There are two validation
methods used for a QSAR model: internal and external validation techniques to establish the
confidence and strength of the model. In general, QSAR modeling involves a systematic process
with multiple steps. These include dataset preparation, molecular descriptors selection and
generation, mathematical or statistical model’s derivation, model training and validation using a

training dataset and model testing on a testing dataset.
111.4.6.1. Internal Validation
111.4.6.1.1. Least Squares Fit

The most common internal method of validating the model is least squares fitting. This
method of validation is similar to linear regression and is the R? (Equation 111-56) for the
comparison between the predicted and experimental activities. An improved method of
determining R? is the robust straight-line fit, where data points are away from the central data
points (essentially data points a specified standard deviation away from the model) are given less
weight when calculating the R2 An alternative to this method is the removal of outliers
(compounds from the training set) from the dataset in an attempt to optimize the QSAR model and
is only valid if strict statistical rules are followed. The difference between the R? and R?%; value
is less than 0.3 indicates that the number of descriptors involved in the QSAR model is acceptable.

The number of descriptors is not acceptable if the difference is more than 0.3 [238].
111.4.6.1.2. Fit of the Model

Fit of the QSAR models can be determined by the methods of chi-squared %2 and root-mean
squared error (RMSE). These methods are used to decide if the model possesses the predictive
quality reflected in the R2. The use of RMSE shows the error between the mean of the experimental
values and predicted activities. The chi squared value exhibits the difference between the

experimental and predicted bioactivities:

n . — 5.)2
x% = Z M Equation 111-62
i=1 y

n . — 1 2
RMSE = \/(Z M) Equation 111-63
i=1 n—1

Where, y and § are the experimental and predicted bioactivity for an individual compound

in the training set, ¥,, is the mean of the experimental bioactivities, and n is the number of
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molecules in the set of data being examined. Large chi-square or RMSE values reflect the model’s
poor ability to accurately predict the bioactivities even the model is having large R? value (>0.7).
For good predictive model the chi-squared and RMSE values should be low (<0.5 and <0.3,
respectively). However, excellent values of R?, «? and RMSE are not sufficient indicators of model
validity. Thus, alternative parameters must be provided to indicate the predictive ability of models.
In principle, two reasonable approaches of validation can be envisaged one based on prediction

and the other based on the fit of the predictor variables to rearranged response variables.
111.4.6.1.3. Cross-validation

Cross-validation is one of the most extensively used methods for internal validation. It
involves partitioning a sample of data into complementary subsets, performing the analysis on one
subset (the training set), and validating the analysis on the other subset (the validation set or testing
set) [239, 240]. Correlation coefficient of the regression between experimental and estimated data

obtained by cross validation is known as cross-validated correlation coefficient or Q2, parameter.

The cross-validation parameter, Q2, is mentioned in the Equation 111-64:

, _ (SSY — PRESS)
cv SSY

Equation 111-64

Where the PRESS (predictive residual sum of squares) and SSY or SD (the sum of squared

deviations of the dependent variable values from their mean) values are obtained as:

PRESS = Z(yl- - 9)? Equation 111-65

SS§Y =SD = Z(yi - ¥:)? Equation 111-66

Where y; is the experimental activity value, y; is the mean of the experimental activity

values, y; is the activity value predicted by the model and n in number of samples.

A model is considered to be significant when Q2, > 0.3. A Q2,= 0.5 is considered as good
and a Q%, > 0.9 as excellent. To be a reasonable QSAR model the PRESS/SSY ratio must be
smaller than 0.4. A PRESS/SSY value < 0.1 is considered to be indicative of an excellent model
[241].

For calculating RZ,,(Q2,), each sample in the training set needs to be eliminated once and
the activity of the eliminated sample will be predicted by using the model developed by the
remaining samples. RZ,/(Q2,) calculated according to the below formula [242]:
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_ Z?=1(yi - }’i)z
=1 —y)?

R%,(Q2) =1 > 0.5 Equation 111-67

A model is considered acceptable when the value of R%,(Q2) exceeds 0.5.
111.4.6.2. External validation

According to Tropsha et al. [243], for considering the validity of the developed models, in
addition to the internal validation, the models should be externally validated using the test set
compounds. According to their study, the following criteria could be considered as of acceptable
predictability:

2
n . — .
i1 (Vicat ~ Yiobs) > 0.6 Equation 111-68

R? 1-— - :
2?:1(yi,cal - ytrain)z

pred =

Where Rlz,red is squared correlation coefficient between the experimental and predicted

biological activities of dataset compounds (training and test sets).

Yeal @and Yobs indicate predicted and observed activity values for the test set and Vi qin
indicates mean activity value of the training set.
R% — R} R* - R' .
— <01 or  ——r— <0.1 Equation 111-69
|IRZ —R'%2] < 0.3 Equation 111-70

Where R? is the determination coefficient between the experimental and predicted activity
values of test set compounds with intercept. R3 and R'3 are determination coefficients of predicted
versus experimental and experimental versus predicted biological activity values in which their

regression line must pass through the origin, respectively.
085<K<115 or 085<K <1.15 Equation I111-71

The slope of regression line through the origin which mentioned in the above was indicated

by K and K' respectively.
I11.5. Molecular docking

Molecular docking is a key tool in structural molecular biology and computer-assisted drug
design. The goal of ligand-protein docking is to predict the predominant binding mode(s) of a

ligand with a protein of known three-dimensional structure. Successful docking methods
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efficiently search high-dimensional spaces and use a scoring function that correctly ranks
candidate dockings. Docking can be used to perform virtual screening on large compound libraries,
categorize results, and offer structural hypotheses on how ligands inhibit the target, which is

invaluable in lead optimization.

Figure 111-9 shows key steps common to all docking protocols. The 3D structures of the
target macromolecule and the small molecule must first be chosen, and then each structure must
be prepared according to the requirements of the docking method used. After docking, the results

should be analyzed, selecting the binding modes with the best scores.
_)[ Target Selection ] l Ligand Selection ](_

Target Preparation Ligand Preparation

[ Docking

[ Evaluating Docking ]
l Results J

Figure 111-9 A typical docking workflow.

All docking methods require a scoring function to rank the different candidate binding modes
and a search method to explore state variables. Scoring functions can be empirical, force field-
based, or knowledge-based, while research methods fall into two broad categories: systematic and
stochastic. Systematic search methods sample the search space at predefined intervals and are
deterministic. Stochastic search methods iteratively perform random changes to state variables
until a user-defined termination criterion is satisfied, so that the search result varies; Sousa et al.

discuss these classes of algorithms in more detail [244].

Search methods can also be classified according to their degree of exploration of the search

space, such as local or global. Local search methods tend to find the nearest or local minimum
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energy to the current conformation, while global methods search for the best or the global
minimum energy in the defined search space. Hybrid global-local search methods have been
shown to perform even better than global methods alone, being more efficient and able to find

lower energies [245].

In AutoDock 4, for example, there is the choice of two local search methods (Solis and Wets
[246] and Pattern Search [247]); two global search methods: Monte Carlo (MC) simulated
annealing (SA) [248], and the genetic algorithm (GA) [249-251]; and one hybrid global-local
search method, the Lamarckian GA (LGA) [245].

111.5.1. AutoDock

AutoDock is distributed with a GUI called AutoDockTools (ADT; see http://autodock.
scripps.edu/resources/adt). ADT helps prepare ligand and receptor input files and configure
AutoGrid and AutoDock calculations. BDT [252] is an alternative preparatory tool to ADT (see
http://www.quimica.urv.cat/~pujadas/BDT/) which helps to set up virtual analyzes with
AutoDock and set up collections of AutoGrid maps for blind docking and also by combining grid
maps to incorporate structural variability in the receiver. AutoDock's AutoGrid program
precalculate the necessary grid maps that describe the chemical potential at regular intervals

around the target.

111.5.1.1. Target Selection and Preparation

= First of all, we need to gather structures of the target, ideally with bound ligands, from
internal and external sources. Good publicly available sources include the Protein Data
Bank [253], http://www.rcsb.org/pdb; ReLiBase from The Cambridge Crystallographic
Data Centre (CCDC) [254], http://relibase.ccdc.cam.ac.uk; and Binding MOAD [255, 256]
http://www.bindingmoad.org. (See Note 1)

= Discard any structures that lack the biologically necessary cofactors is also necessary, if
any are required for biological activity. Structures that are incomplete or missing side
chains should also be disregarded.

= |f there is more than one target structure, we need to overlay them by superimposing the
key residues in the binding site or region of interest using a least-squares superimposition
method. SwissPdbViewer [257], a freely available tool from http://www.expasy.org/spdbv,
offers several superimposition options under its “Fit” menu, such as “Magic Fit” and “Fit
molecules (from selection)”. Note also that SwissPdbViewer can also automatically

reconstruct incomplete side chains.
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Identify the extent of the structural variability and select a representative structure (see
Note 2).

Add all hydrogen atoms to the target at the desired pH; under physiological conditions at
pH 7.2, the following residues have ionized side chains: arginine, lysine, aspartic acid, and
glutamic acid. This defines the formal charges (see Note 3). Each histidine side chain can
be either neutral or positively charged at physiological pH. If it is neutral, either the delta
or the epsilon nitrogen can be protonated (see Note 4).

The atomic assignments of imidazole rings in histidine and amido groups in asparagine
and glutamine side chains can be ambiguous; tools such as REDUCE and its web interface,
MOLPROBITY [258, 259] can evaluate 180° flips of these groups to optimize the
hydrogen-bond network, and add hydrogen atoms appropriately.

Remove all water molecules, except those that are integral to your binding hypothesis (see
Note 5).

If the representative target structure is complexed with a ligand, remove the ligand.
Calculate the partial charges, if required by the docking tool. Some tools may use a
dictionary of amino acid partial charges to simply assign the charges. If there are any
cofactors in the target structure, it will be necessary to compute the appropriate partial
charges if required by the docking method.

When using AutoDock, merge nonpolar hydrogens, because it uses a unitedatom
representation (see Note 6).

AutoDock uses grid maps that must be calculated using AutoGrid. Each map describes a
3D grid of interaction energies with the target, one for each atom type in the ligand (see
Note 7).

111.5.1.2. Ligand Selection and Preparation

Most docking tools require a 3D structure for each ligand, including explicit hydrogens.

Depending on the source of the ligand’s real molecules, molecules that have yet to be synthesized,

or vendor libraries the steps required to process the molecules will vary. The following steps

exemplify how to obtain these structures, and how to process them for use in AutoDock.

ZINC is one of the largest collections of commercially available compounds; it is well
curated and has 4.6 million compounds (http://blaster.docking.org/zinc) [260]. It is
particularly useful for molecular docking because it provides 3D structures in SYBYL

MOL2 formats, and is also free of charge. Subsets of compounds can be created by
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composing a query that specifies constraints on both molecular properties and two-
dimensional (2D) molecular topology.

= Ligands in the form of SMILES strings [261] can be converted into full 3D atomic
coordinates, including hydrogens, using tools such as CORINA [262, 263] or ZINC [260].

= Ligands in 2D SD format [264] can be converted into full 3D atomic coordinates using
CORINA [262, 263] or Chemical [265]. Chemical can be used to sketch the ligand in 3D
and then perform energy minimization, molecular dynamics, or conformational search to
identify low energy conformations. PRODRG [266, 267] can take PDB format, MDL MOL
files, or even ASCIl-text drawings of the molecule, instead of SD format. PRODRG is
available as a standalone executable or as a web service, where the user can sketch the
molecule in 2D and then convert the molecule into 3D; PRODRG is convenient for
AutoDock 2.4 and 3, because it outputs PDBQ format.

= |t is important that the protonation, tautomeric, and stereoisomeric forms of the ligand be
correct, otherwise subsequent calculations will be highly suspect. The enumeration of all
possible ligand tautomers can be achieved with such programs as QUACPAC (Open Eye),
TAUTOMER (Molecular Networks), and LigPrep (Schrodinger).

= When preparing ligands for AutoDock, the GUI AutoDockTools (ADT) can be used to set
up the necessary input files. The first step for AutoDock is to calculate Gasteiger partial
charges [268] and assign AutoDock atom types to each atom in the ligand (see Notes 8—
10).

* Define the “root” of the torsion tree and the rotatable bonds interactively using ADT. The
“Ligand > Torsion Tree > Detect Root...” option automatically examines all the rotatable
bonds in the ligand and chooses the atom that is nearest to the center of the torsion tree.
The “Ligand > Torsion Tree > Choose Torsions...” option displays all rotatable bonds as
green or magenta, indicating that they are active or inactive, respectively. Clicking on these
bonds toggles whether they are active or not. Make sure any conjugated bonds are not
rotatable.

= AutoDock 4 requires the ligand to be in PDBQT format, which is very similar to PDB
format, but also includes the partial atomic charge and the AutoDock atom type for each
atom. The ligand should be saved using the “Ligand > Output > Save as PDBQT...” option
in ADT.
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111.5.1.3. Docking
= Define the search space. There are two possibilities, depending on how much is known
about the binding site:
o If there is no previous information regarding the location of the binding site, then
the translational search space should encompass the entire surface of the receptor.
This is known as “blind docking,” and is possible with AutoDock [269]. If the
docking tool cannot encompass the whole target, then probable sites such as
cavities large enough to contain the ligand(s) should be investigated separately; the
third-party tool BDT [252] can be used to set up staggered grid boxes for AutoGrid.
o Ifthere is previous information, such as ligands with known binding modes, active
site residues, or mutagenesis data, then the search space can be reduced to focus on
the region of interest, thus, simplifying the search problem.
=  Set the target to be docked to, using the ADT menu item “Docking > Macromolecule > Set
Rigid Filename...”
= Select the search method (if there is more than one), and set the appropriate parameters.
AutoDock offers MCSA, a traditional GA, and a hybrid global-local search method called
LGA. The best search algorithm was shown to be LGA [245], therefore, it is recommended
for most dockings (see Note 11).
= Save the input parameter file for the docking tool, if necessary. For AutoDock, use the
“Docking > Output > Lamarckian GA...” option in ADT to save an AutoDock docking
parameter file (DPF) set up to perform LGA dockings.

111.5.1.4. Evaluating Docking Results
When evaluating the results of dockings, there are two main criteria to consider:

1) how well did the binding mode predicted by the docking match known structural data?

where available;

2) how well did the docking rank the ligands? If the method’s scoring function is designed

to predict binding affinities, how well did it match experimental binding data?

To answer the first criteria, a crystal structure of the complex of the ligand bound to the
target must be known, and then the Root Mean Square Deviation (RMSD) between the docked
and the “reference” crystallographic binding mode of the ligand can be calculated; success is
usually counted as RMSD less than 2 A. To answer the second criteria, inhibition constants, or Ki

values, must be known for the ligands and the target system.
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When the search method used is stochastic, it is important to consider how often a given

binding mode was predicted across all the dockings that were run. This is usually achieved using

conformational clustering, building families of related conformations using RMSD tolerances to

decide whether two conformations belong in the same cluster.

Read in all of the docked conformations into the docking analysis tool. For AutoDock, use
ADT with the menu option “Analyze > Dockings > Open...” for one docking log (DLG)
(see Note 12).

It is useful to view the dockings in the context of the target, therefore, if necessary, load
the structure of the target. In ADT, use “Analyze > Macromolecule > Open...” to read in
the target PDBQT structure used to compute the AutoGrid maps.

Perform conformational cluster analysis on the dockings to assess the level of agreement
in the results. In ADT, use “Analyze > Clusterings > Recluster...”, and type in a list of
RMSD tolerances in angstroms separated by spaces. This performs clustering for each
RMSD tolerance value, grouping the docked conformations accordingly.

Display the conformational clustering as a histogram, and visually inspect each cluster. In
ADT, use “Analyze > Clusterings > Show...” and then choose the RMSD tolerance value.
This displays a histogram of number of docked conformations in the cluster, versus the
energy of the most tightly binding conformation in that cluster. The histogram is
interactive, thus, clicking on a histogram bar sets up the “play” buttons in the
“Conformation Player” window to play through the conformations in that cluster. This
window has buttons to play forward and backward, and to step through the conformations
one at a time.

It is possible to examine AutoDock-docked conformations in more detail using the
“Conformation Player” in ADT, by clicking on the “&” button. This displays a panel in
which it is possible to show more information regarding the current docking, by clicking
on the “Show Info” check-button. It is also possible to monitor which hydrogen bonds are
formed between the ligand and the target using the “Build H-bonds” check-button. The
atoms in the ligand can be colored by a color scale that goes from dark blue to green to
yellow to orange to red, indicating more favorable to less favorable interaction energies,
using the “Color by” option; “vdw” colors by van der Waals or H-bond plus desolvation
free energy, “elec stat” colors by electrostatic interaction energy, and “total” colors by the
total interaction energy; and “atom” returns to the default color-by-atom coloring.

If the docking results do not cluster into at least one significantly populated cluster, with

an RMSD tolerance of between 2 and 3 A, this is an indication that the dockings did not
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11.5.1.

1)

2)

3)

4)

5)

6)

7)

search for long enough. In AutoDock and ADT, increase the number of energy evaluations
used in the LGA, and rerun the dockings. To get decent statistics, it is advisable to repeat
the docking at for at least 50 runs.

If the docked conformations are too far from the target structure, make sure that the
AutoGrid grid box is centered on or near the target; the grid box can be visualized in ADT
using the “Analyze > Grids > Open...”, then choosing one of the grid maps files. The x-,
y-, and z-axes are color-coded red, green, and blue, respectively. The energy values in the
grid map can be isocontoured by dragging the blue solid triangle on the “IsoValue” slider,
with lower energy values indicating pockets of tighter binding affinity, and higher-
resolution isocontours can be plotted using a “Sampling” value of 1 instead of the default

value, 3.

5. Notes
It is preferable to use only high-resolution structures where available, ideally better than
25A.
A representative structure or “leader” for a 90% homology family of structures is already
precalculated and available from Binding MOAD [255] http://www.bindingmoad.org.
In AutoDockTools, use the “Edit > Hydrogens > Add” then choose “All Hydrogens”; all
hydrogens are required for the initial Gasteiger partial charge calculation, but the
nonpolar hydrogens will be merged later on.
AutoDockTools offers a tool to help set the desired protonation state of each its side chain,
under the “Edit > Hydrogens > Edit Histidine Sidechains” menu. Which protonation state
a, its adopts will depend on its environment in the target.
Consolv [270], freely available from http://www.bch.msu.edu/labs/kuhn/software. html,
“predicts whether water molecules bound to the surface of a protein are likely to be
conserved or displaced in other, independently solved crystallographic structures of the
same protein.”
AutoDockTools calculates the partial charges and merges the nonpolar hydrogens
automatically when the user selects the “Grid > Macromolecule > Choose...” menu items.
AutoGrid requires the target to be saved in PDBQT format, and it requires a Grid
Parameter File (GPF). To save the receptor, use the “File > Save > Write PDBQT...”
option. Set which types of grid maps should be calculated using either “Grid > Set Map
Types > Directly...” or “Grid > Set Map Types > Choose Ligand...”. To set up the location
and grid spacing of the grid maps, use “Grid > Grid Box...”. Finally, to save the GPF, use
“Grid > Output > Save GPF...”.
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8)

9)

Note that ADT can read in a ligand with partial charges using SYBYL mol2 format. Use
“File > Read Molecule...” and change the “Files of type” button to “MOL2 files
(*.mol2)”.

If the ligand is missing hydrogen atoms, then they must be added before calculating the
Gasteiger charges. After selecting the ligand in ADT, use the menu option “Edit >
Hydrogens > Add”. It is very important to consider the tautomeric and ionization states

when adding hydrogens.

10) AutoDock atom types are assigned automatically in ADT by choosing the “Ligand >

2

Input > Choose...” option. This command will also merge the nonpolar hydrogens,

making the ligand suitable for use with the united-atom force field in AutoDock.

11) It is important to make sure that the number of energy evaluations is increased from the

default value of 250,000 if the ligand has any rotatable bonds. Use the ADT menu option
“Docking > Search Parameters > Genetic Algorithm...” and change the “Maximum
number of energy evaluations” to at least 2,500,000. It is also possible to increase the
“Number of GA runs” in the panel from the default value 10. One other important
parameter is the “Population Size”; the default is 150, although Hetenyi et al. showed that
larger values up to 300 can improve the efficiency of the search [269]. Note also that this

panel works for both the traditional and LGA search methods.

12) Alternatively, if the same ligand has been docked to the same target, but separate runs of

AutoDock have produced uniquely named DLG files, as is the case when running
dockings in parallel on computational clusters, use the “Analyze > Dockings > Open

All...” option to read in all the dockings.
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IV. Structural, electronical properties and in silico toxicity of N-ferrocenylmethylaniline derivatives

1VV.1. Introduction

To achieve molecular docking, the structure of the ligand must be optimized by molecular
modeling which is a set of theoretical methods consisting in modeling a three-dimensional
structure of a complex, and more generally its interface, from the known structures of its
constituents. The level and quality of the details obtained, depending on the type of experimental
techniques, which will weigh on the capacity of the modeling methods to obtain a good resolution
of the three-dimensional structures of the complex studied and which represent the molecular

structure of these molecules [271, 272].

Based on the fundamental laws of quantum mechanics, the Gaussian software allows us to
predict the energies, molecular structures and vibration frequencies of complex molecular systems,
and to anticipate their chemical properties. Molecules and reactions can be studied under a wide
range of conditions not only for stable species or complex compounds but also for compounds that

cannot be observed experimentally, such as ephemeral intermediates or transition states [273].

Molecular mechanics is a calculation method used in classical mechanics to calculate the
lowest energy of conformation of molecules. This makes it possible to calculate the relative
energies between different configurations or between different molecules, as well as the
geometries of equilibrium and the transition states, which correspond to the local surface minima

of potential energy corresponding to stable conformations [273, 274].
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IV.2. N-ferrocenylmethylaniline derivatives

For this study 28 derivatives were synthesized at VTRS laboratory (laboratoire de
valorisation et technologie des ressources sahariennes) at EI-Oued University. All the derivatives
have the same basic core which can be represented with the first derivative (N-ferrocenyl-
methylaniline) (Figure 1V-1). All the derivatives and their commun names are tabulated in Table
IV-1.

N/X
SO
. 2
; Y
— 3
4

Figure 1V-1 General formula of the basic core (N-ferrocenylmethylaniline) of the derivatives

Table V-1 List of N-ferrocenylmethylaniline derivatives

Code Name‘ X ‘ Y ‘ commun Name
F1 H H N-ferrocenylmethylaniline
F2 H 2-Me N-(ferrocenylmethyl)-2-(methyl)aniline
F3 H 3-Me N-(ferrocenylmethyl)-3-(methyl)aniline
F4 H 2-Et N-(ferrocenylmethyl)-2-(ethyl)aniline
F5 H 2-Cl N-(ferrocenylmethyl)-2-(chloro)aniline
F6 H 3-Cl N-(ferrocenylmethyl)-3-(chloro)aniline
F7 H 4-Cl N-(ferrocenylmethyl)-4-(chloro)aniline
F8 H 3-Br N-(ferrocenylmethyl)-3-(bromo)aniline
F9 H 4-Br N-(ferrocenylmethyl)-4-(bromo)aniline
F10 H 2-NO> N-(ferrocenylmethyl)-2-(nitro)aniline
F11 H 3-NO> N-(ferrocenylmethyl)-3-(nitro)aniline
F12 H 4-NO; N-(ferrocenylmethyl)-4-(nitro)aniline
F13 H 2-CN N-(ferrocenylmethyl)-2-(aminobenzo)nitrile
F14 H 3-CN N-(ferrocenylmethyl)-3-(aminobenzo)nitrile
F15 H 4-CN N-(ferrocenylmethyl)-4-(aminobenzo)nitrile
F16 H 3-CFs N-(ferrocenylmethyl)-4-(trifluoromethyl)aniline
F17 H 2-COMe N-(ferrocenylmethyl)-2-(acetyl)aniline
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Code Name‘ X ‘ Y ‘ commun Name
F18 H 4-COMe N-(ferrocenylmethyl)-4-(acetyl)aniline
F19 H 4-SO2-NH> 4-((ferrocenylmethyl)amino)benzenesulfonamide
F20 COMe H N-(ferrocenylmethyl)-N-(phenyl)acetamide
F21 COMe 2-NO> N-(ferrocenylmethyl)-N-(acetyl)-2-(nitro)aniline
F22 COMe 3-NO2 N-(ferrocenylmethyl)-N-(acetyl)-3-(nitro)aniline
F23 COMe 4-NO> N-(ferrocenylmethyl)-N-(acetyl)-4-(nitro)aniline
F24 COMe 2-CN  |N-(ferrocenylmethyl)-)-N-(acetyl)-2-(amino)benzonitrile
F25 COMe 3-CN  |N-(ferrocenylmethyl)-)-N-(acetyl)-3-(amino)benzonitrile
F26 COMe 4-CN  |N-(ferrocenylmethyl)-)-N-(acetyl)-4-(amino)benzonitrile
F27 COPh H N-(ferrocénylmethyl)-N-(phenyl)benzamide
F28 NHCOMe H N'-(ferrocenylmethyl)-N'-(phenyl)acetohydrazide

1VV.3. Calculation methods

All the calculation were carried out using Gaussian software (Gaussian 09W) and visualised
by GaussView to show the final optimized structure of the derivatives and their properties. The
optimization process was done using DFT/B3LYP method. The basis sets were chosen in order to
be suitable for different atoms that compose the N-ferrocenylmethylaniline derivatives.
LANL2DZ [275-279] basis set has been selected for the big atoms which are iron (Fe) in all N-
ferrocenylmethylaniline derivatives and bromine which is included in the composition of the
derivatives F9 and F10. Another basis set has been chosen (6-31+G(d)) [207, 208, 275-277, 280-
284] for the rest of the atoms (C, H, N, O, CI).

In order to confirm that the mixed basis set (LANL2DZ(Fe)/6-31G(d)) is suitable for the N-
ferrocenylmethylaniline derivatives calculations, the derivative F1 was chosen in order to compare
its calculated and experimental data [285]. F1 represents the basic core of all the derivatives. In
the study case, due the absence of experimental geometric data of F1. F10 has been chosen to
confirm only the ability of geometric optimization of the mentioned mixed bases sets.

Mulliken atomic charges were also calculated for F1 using Gaussian 09W with the same
method (DFT/B3LYP) and the same mixed basis sets (LANL2DZ(Fe)/6-31G(d)). Moreover, the
calculations of molecular electrostatic potential (MESP) map were carried out using the same
computational method with the same mixed basis sets. In order to predict the reactivity of our
derivatives, HOMO and LUMO energies, as well as the gap (HOMO-LUMO) were calculated

using single point energy.
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Furthermore, spectroscopic properties such as IR, 'TH NMR, and '*C NMR spectrums have
been predicted for F1 using the same method and mixed basis sets. in addition, the calculations of
UV-Vis spectrum was carried out using TD-DFT/B3LYP method with the same mixed basis sets,
the number of solved states was equal to 55 states and the used solvation model was CPCM and
the solvent was ethanol.

IV.4. Geometric properties

The optimized structure of F10 is shown in Figure 1VV-2 with numbering of the atoms, bond
lengths and bond angles of the compound calculated by DFT/B3LYP method with the mentioned
mixed basis sets LANL2DZ(Fe)/6-31G(d) were compared with the experimental data. Both of the
experimental and theoretical values are tabulated in Table 1\V-2. For the bond lengths it can be seen
that there is a good agreement between the calculations and the experimental data, for example the
bond Fel-C2 is calculated at 2.084 A where the experimental value was at 2.031 A and the percent
error of this calculation was 6=2.610 % which makes this calculation very accurate, the X-Ray
value of the bond lengths of Fe1-C9, Fel-C6 and Fel-C10 were equal to 2.044 A, 2.041 A and
2.036 A respectively, the calculated values were equal to 2.078 A, 2.076 A and 2.078 A
respectively with percent error equal to 1.663%, 1.715% and 2.063%, carbon-carbon bonds of the
cyclopentadiene of the ferrocenyl group had a good agreement with the experimental values. For
example, C10-C9 was observed by X-Ray to be equal to 1.430 A and the calculated value was
1.433 A with a percent error equal to 0.210 %, C4-C5 and C6-C7 were equal to 1.41 A and 1.425
A respectively, theoretically they were equal to 1.429 A and 1.428 A respectively and the percent
error was 1.348% and 0.211% for each. Also, the X-Ray value of C10-C11 was equal to 1.50 A
and was calculated at 1.51 A with percent error equal to 0.667%. For Amine group the bond C11-
N1 was at 1.466 A by X-Ray and calculated at 1.462 A with a good percent error equal to 0.273%,
in the other side C12-N1 was equal to 1.356 A and calculated at 1.359 A and its percent error was
equal to 0.221%. As for the phenyl group the bonds C12-C17 and C15-C16 were observes to be
at 1.419 A and 1.40 A respectively, theoretically they were calculated to be at 1.423 A and 1.407
A with percent error equal to 0.282% and 0.500% for each one respectively. Moreover, the bonds
of Nitro group C13-N2 and N2-O2 are experimentally equal to 1.438 A and 1.238 A were they
have been calculated at 1.446 A and 1.252 A respectively, and their percent error aqual to 0.556%
and 1.131%. It should also be noted that the maximum percent error of bond length was equal to

2.610 % and its average was 0.716 % which makes it a pretty good calculation.
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Figure 1V-2 ORTEP view of F10 Figure 1V-3 A view of F10 DFT optimized structure represented
represents atomic labelling by GaussView AND ORTEP.
obtained from X-ray data [285].

For the bond lengths it can be seen that there is a good agreement between the calculations
and the experimental data, for example the bond Fel-C2 is calculated at 2.084 A where the
experimental value was at 2.031 A and the percent error of this calculation was § = 2.610 %
which makes this calculation very accurate, the X-Ray value of the bond lengths of Fel-C9, Fel-
C6 and Fel-C10 were equal to 2.044 A, 2.041 A and 2.036 A respectively, the calculated values
were equal to 2.078 A, 2.076 A and 2.078 A respectively with percent error equal to 1.663%,
1.715% and 2.063%, carbon-carbon bonds of the cyclopentadiene of the ferrocenyl group had a
good agreement with the experimental values. For example, C10-C9 was observed by X-Ray to
be equal to 1.430 A and the calculated value was 1.433 A with a percent error equal to 0.210 %,
C4-C5 and C6-C7 were equal to 1.41 A and 1.425 A respectively, theoretically they were equal to
1.429 A and 1.428 A respectively and the percent error was 1.348% and 0.211% for each. Also,
the X-Ray value of C10-C11 was equal to 1.50 A and was calculated at 1.51 A with percent error
equal to 0.667%. For Amine group the bond C11-N1 was at 1.466 A by X-Ray and calculated at
1.462 A with a good percent error equal to 0.273%, in the other side C12-N1 was equal to 1.356
A and calculated at 1.359 A and its percent error was equal to 0.221%. As for the phenyl group
the bonds C12-C17 and C15-C16 were observes to be at 1.419 A and 1.40 A respectively,
theoretically they were calculated to be at 1.423 A and 1.407 A with percent error equal to 0.282%
and 0.500% for each one respectively. Moreover, the bonds of Nitro group C13-N2 and N2-O2
are experimentally equal to 1.438 A and 1.238 A were they have been calculated at 1.446 A and
1.252 A respectively, and their percent error aqual to 0.556% and 1.131%. It should also be noted
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that the maximum percent error of bond length was equal to 2.610 % and its average was 0.716 %

which makes it a pretty good calculation.

Moreover, for the bond angels of F10 it can be seen for the Ferrocenyl group in the
experimental values of C-C-C angles are between 107.38° and 108.44° where the calculated values
were between 107.28° and 108.38°, the angles between Iron and the carbon atoms of sandwiched
cycles had a good agreement for example C10-Fel-C6 from the X-Ray was equal to 41.14° and
the calculated value was at 40.38° and its percent error was equal to 1.847% which makes the
calculated value very accurate. C11-N1-C12 was also calculated to be found at 126.70° which is
pretty close to the X-Ray value at 125.05° with percent error equal to 1.319%. furthermore, for the
phenyl group the angles C-C-C were between 118.70° - 121.23° and their calculated values were
between 118.64° - 121.20°. For the Angles the maximum percent error was 10.660% and its

average was equal to 0.496% which means the calculation are super accurate.

Table IV-2 Bond lengths (A), bond angles (°) experimental and optimized of F10 by using
LANL2DZ(Fe)/6-31G(d) basis sets.

Percent Percent
Atoms Exp [285] Gauss Atoms Exp [285] Gauss
error (%) error (%)

Bonds distances(A)
Ci10 | Cl11 15 151 0.667 C4 C5 141 1.429 1.348
C10 | C6 1.433 1434 0.070 C5 C1l 1.408 1.429 1.491
C10 | Fel 2.036 2.078 2.063 C5 C4 141 1.429 1.348
Ci11 | C10 15 151 0.667 C5 Fel 2.047 2.085 1.856
C11 | N1 1.466 1.462 0.273 C6 C7 1.425 1.428 0.211
C12 | C17 1.419 1.423 0.282 C6 Fel 2.041 2.076 1.715
C13 | N2 1.438 1.446 0.556 C7 C6 1.425 1.428 0.211
Ci15 | Cle 14 1.407 0.500 C7 Fel 2.048 2.083 1.709
Cl6 | C15 14 1.407 0.500 C8 C7 1.424 1.429 0.351
Cil6 | C17 1.374 1.384 0.728 C8 C9 142 1.427 0.493
C1 C2 1411 1.429 1.276 C9 C10 1.43 1.433 0.210
C1 C5 1.408 1.429 1.491 C9 C8 1.42 1.427 0.493
Cl | Fel 2.039 2.084 2.207 C9 Fel 2.044 2.078 1.663
C2 C1 1411 1.429 1.276 Fel C2 2.031 2.084 2.610
C2 C3 1.42 1.43 0.704 N1 Cl1 1.466 1.462 0.273
C2 | Fel 2.031 2.084 2.610 N1 C12 1.356 1.359 0.221
C3 C2 1.42 1.43 0.704 N2 C13 1.438 1.446 0.556
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Percent Percent
Atoms Exp [285] Gauss Atoms Exp [285] Gauss
error (%) error (%)

C3 C4 1.416 1.43 0.989 N2 02 1.238 1.252 1.131

C4 C3 1.416 1.43 0.989 02 N2 1.238 1.252 1.131

Maximum percent error of bond distance = 2.610 %

Percent error average of bond distances = 0.716 %

Bonds angles (°)
C10 | C6 | Fel | 69.25 | 69.89 0.924 C4 | C3 | C2 | 1075 108 0.465
C10 | C9 | Fel | 69.19 | 69.83 0.925 C4 | C3 | Fel | 70.08 70 0.114
C10 | Fel | C1 | 112.64 | 124.08 10.156 C4 | C5 | Fel | 70.06 69.95 0.157
C10 | Fel | C3 174.4 | 159.32 8.647 C5 | C4 | C3 | 108.08 | 107.97 0.102
Cl10 | Fel | C6 | 41.14 40.38 1.847 C5 | C4 | Fel | 69.71 69.97 0.373
Cll | C10 | Fel | 125.09 | 126.9 1.447 C5 | Fel | C4 | 40.23 40.09 0.348
Cl4 | C15 | Ci6 | 118.7 118.64 0.051 C6 | C10 | Fel 69.6 69.73 0.187
C15 | C14 | C13 | 120.72 | 121.09 0.306 C6 | C7 | Fel | 69.35 69.66 0.447
Cl7 | Cle | C15 | 121.23 | 121.2 0.025 C6 | Fel | C5 | 133.1 124.53 6.439
Cl | C5 | C4 | 108.34 | 108.03 0.286 C6 | Fel | C9 | 68.77 | 67.53 1.803
Cl | C5 | Fel | 69.52 | 69.89 0.532 C7 | C6 | C10 | 108.03 | 108.42 0.361
Cl |Fel| C3 | 6831 | 67.42 1.303 C7 | C6 | Fel | 69.85 | 70.18 0.472
Cl |Fel| C4 | 679 67.41 0.722 C7 | C8 | Fel | 69.53 | 69.88 0.503
Cl |Fel| C5 | 4031 40.11 0.496 C7 | Fel | C8 | 40.66 40.09 1.402
Cl | Fel | C7 | 133.18 | 123.62 7.178 C8 | C7 | C6 | 108.14 | 107.87 0.250
Cl | Fel | C9 | 14447 | 159.87 10.660 C8 | C7 | Fel | 69.81 70.04 0.329
C2 C3 | Fel | 69.11 69.95 1.215 C8 | C9 | C10| 108.44 | 108.38 0.055
C2 |Fel| C3 40.8 40.14 1.618 C8 | C9 | Fel | 69.99 70.21 0.314
C2 |Fel | C6 | 112.74 | 123.38 9.438 C9 | Cl10 | C6 | 107.38 | 107.28 0.093
C2 | Fel| C9 | 17469 | 158.63 9.193 C9 | C8 | C7 | 108.01 | 108.05 0.037
C3 C4 | Fel | 69.48 69.88 0.576 C9 | C8 | Fel | 69.43 69.7 0.389
C3 | Fel | C7 | 11471 | 122.68 6.948 Cl11 | N1 | Cl2| 125.05 | 126.70 1.319

Maximum percent error of bond angle = 10.660 %

Percent error average of bond angles = 0.496 %

Apparently the comparation between the experimental and calculated geometric parameters
shows almost perfect agreement with coefficient of determination RZ equal to 0.9992 for the bonds
lengths and 0.9755 for the bonds angles both of them are represented in Figure 1V-4 and Figure
IV-5 respectively.
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Figure 1V-4 Correlation graphic between the experimental and calculated bond lenghts of F10
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Figure 1V-5 Correlation graphic between the experimental and calculated bond angles of F10.

IVV.5. Spectroscopic properties

IV.5.1. IR

Vibration frequencies (Table 1V-3) and IR Spectrum (Figure 1V-6) of F1 were calculated
using DFT/B3LYP method with the mixed basis sets LANL2DZ(Fe)/6-31G(d). The computational
frequencies were compared to experimental frequencies [286].
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Figure 1V-6 Calculated IR spectrum of F1

The comparison shows great agreement between computational and experimental
frequencies. Generally, Amine group has two special bonds which are N-H bond and C-N bond
the frequency of the stretching vibration of N-H bond appeared at 3405 cm™ in the experimental
spectrum where the computational frequency calculated at 3609.85 cm™, on the other hand the
bending vibration of the same bond calculated to be at 1555.01 cm™ where the stretching vibration
of C-N bond appeared at 1100 cm™ the calculation gave a good prediction of the frequency at
1301.02 cm™. Stretching vibration of C-H aliphatic and aromatic (phenyl) experimentally
appeared at 2840 and 3090 cm™ respectively where the computational values calculated at 3002.24
and 3189.32 cm™. Furthermore, the bending vibration of C-H bond from the cyclopentadiene of
ferrocene part appeared at 999 cm™ and its calculated value is at 812 cm™. C=C bond has the
strongest peak on theoretical IR spectrum at 1658.08 cm?, this peak appeared at 1602 cm™ in the
experimental data. The last calculated vibration of F1 is the one of Fe-Ccp) which is a stretching
vibration at 451.08 cm™,
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Table 1V-3 Types of vibration of F1 and their frequencies

Vibration type Experimental Caleulated Peak strenght
Frequency (cm™) Frequency (cm™)
N-H Stretching 3405 3609.85 Medium
C-Hpn) Stretching 3090 3189.32 Medium
C-Haliphaticy | Stretching 2840 3002.24 Medium
C=Cpn) Stretching 1602 1658.08 Strong
N-H Bending - 1555.01 Strong
C-N Stretching 1100 1301.02 Strong
C-Hcp) Bending 999 812 Medium
Fe-Cp Stretching - 451.08 Medium

It is clear that the comparison between the experimental and calculated values of vibration
frequency shows great agreement with coefficient of determination R2 equal to 0.9884. the graph

is represented in Figure 1V-7.

IR frequency

4000
= 3500 e

cm-1)

(

w
o
S
S
@

2500

2000 p= y = 1.0749x - 73.233
1500 0. R2=0.9884
1000 :

500

Experimental values

0 500 1000 1500 2000 2500 3000 3500 4000
Calculated Values (cm-1)

Figure IV-7 Correlation graphic between the experimental and calculated vibration frequencies

IV.5.2. NMR

NMR Spectrums of F1 were calculated using DFT/B3LYP method with the mixed basis sets
LANL2DZ(Fe)/6-31G(d). The computational shifts were compared to experimental shifts. This
comparison shows an agreement between the calculated values and the experimental shifts of

NMR analyses.

Experimental NMR 1H analysis shows that all the hydrogen atoms of the ferrocene part

resonance appeared between 4.20 and 4.24 ppm where the computational values where between
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3.07 and 4.25 ppm. The computational values shows that H atoms of the ferrocene part are not in
the same environment due the bounding of ferrocene with the substitution part in one side of its
cyclopentadiene. The aliphatic hydrogens of C11 appeared on the experimental spectrum at 4.30
ppm where the calculated shift is equal to 3.59 ppm. the hydrogen of the amine part appeared
experimentally at 4.01 ppm and theoretically at 3.52 ppm. The last type of hydrogen in F1 is the
aromatic hydrogens of the phenyl part of the substitution, these hydrogens appeared between 6.71

and 6.81 ppm and the computational values are between 5.89 and 6.96 ppm.

In the case of NMR 13C the agreement between the experimental and the computational
values was even much better than then the agreement in NMR 1H case. All the carbons of
ferrocene part had shift values between 68.04 and 86.60 ppm where the computational values
calculated to be between 57.56 and 78.75 ppm. C11 appeared at 43.52 ppm experimentally and its
calculated value is 37.89 ppm which is very close to the experimental value. The last type of
carbons is the type of the phenyl group which appeared in the interval of 117.68 - 129.44 ppm on
the experimental spectrum. On the other hand, the theoretical spectrum shows the same type of
carbons between 95.07 and 115.84 ppm. For both cases of NMR 1H and NMR 13C it can be
clearly seen that there is a little shift to the right (TMS).
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Figure 1V-8 Calculated NMR *H spectrum of F1
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Figure IV-9 Experimental NMR *H spectrum of F1
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Figure IV-10 Calculated NMR **C spectrum of F1
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Figure IV-11 Experimental NMR **C Spectrum of F1
Table V-4 Experimental and calculated NMR *H and NMR **C chemical shifts (ppm) of F1

NMR 2C
Cal. Atom EXxp. Cal.
C1l
C2
C3
C4
C5
C6
Cc7
C8
C9
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The comparison between the experimental and calculated values of NMR shifts shows a
satisfying agreement with RZ equal to 0.9278 for NMR 1H and 0.9817 for NMR 13C both of them
are represented in Figure 1VV-12 and Figure 1V-13 respectively.
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Figure 1V-12 Correlation graphic between the experimental and calculated shifts of NMR 1H
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Figure 1V-13 Correlation graphic between the experimental and calculated shifts of NMR 13C
IVV.6. Atomic Mulliken charges

For many years, chemists have had a genuine interest in describing electron density
distributions in terms of atomic charges [287]. With the increasing power of computers and the
increasing use of methods that include electronic correlations we can now consistently get fairly

accurate density matrices as part of geometric optimizations.

Atomic Mulliken charges of F1 have been calculated by DFT/B3LYP method with the mixed
basis sets LANL2DZ(Fe)/6-31G(d). the values of atomic Mulliken charges are tabulated in Table
IV-5.
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The results show that all carbon atoms have negative charges except C12 and C17 of the

benzene group. The iron and nitrogen also have negative charges.

Table 1V-5 Atomic Mulliken charges of F1

Atom Atomic charge Atom Atomic charge Atom Atomic charge
Fe -1.023
C1 -0.060 i -0.369 C13 -0.819
C2 -0.065 C8 -0.026 Cil4 -0.293
C3 -0.132 C9 -0.178 C15 -0.196
C4 -0.045 C10 0.999 C16 -0.387
C5 -0.182 C11 -0.855 C17 0.549
C6 -0.087 C12 0.232 N1 -0.364

IVV.7. Molecular electrostatic potential (MESP) map

Mapping molecular electrostatic potential (MESP) maps for chemical structure has become
a major concern. Since it can explain valuable information about the interaction, active sites as
well as determining the nature of the chemical addition, through which a molecule is most likely
to undergo; electrophilic or nucleophilic addition. Calculations at the mentioned DFT high
theoretical level and MESP maps for N-ferrocenylmethylaniline derivatives were carried out.

Generally, The MESP shows the preferred sites for nucleophilic and electrophilic attack the
maximum positive region which preferred site for nucleophilic attack is colored in blue, while the
maximum negative region which preferred site for electrophilic attack takes red color. The green
regions signify electrically neutral regions. The order of potential decreasing is: red < orange <

yellow < green < blue.

MESP Surface and contour map for F1 in Figure 1VV-14 shows one preferred site for the
nucleophilic attack which colored in blue around the amine function (Nitrogen atom N) this makes
the nitrogen atom is the most preferred site for the nucleophilic attack in any reaction or
preparation of a new derivative from F1. The map also shows three red surfaces on the benzene
group and on both cycles (cyclopentadiene) of ferrocene group, that makes them the best sites for
the electrophilic attack especially the benzene group which involves in many reactions of synthesis

new derivatives.
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Figure 1V-14 MESP Surface and contour map for F1.

MESP Surface and contour map of all the derivatives are listed below.
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F17 F18 F19
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F22

F25

F26 F27 F28
Figure 1V-15 MESP Surface and contour map of N-ferrocenylmethylaniline derivatives

IV.8. Energies of the Frontier Molecular Orbitals HOMO and LUMO

Basically, all species (atoms, ions, molecules) are considered to have frontier orbitals which
are simply the highest energy (HO) and lowest unoccupied energy (LU) occupied orbitals. When
molecular orbits are involved, the abbreviations HOMO and LUMO are used. The kinetic
characteristics of the reagents and reactions are assessed by considering only FMO interactions.
The energy difference between the highest energy occupied molecular orbit (HOMO) of a
molecule and its lowest unoccupied molecular orbit (LUMO) is known as HOMO-LUMO gap.

HOMO, LUMO and HOMO-LUMO gap of F1 were calculated at the mentioned DFT high
theoretical level. The energies and the contour diagrams of these molecular orbitals are shown in
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Figure IV-16. The diagram shows that HOMO is around the iron of ferrocene part of F1 and its
energy is equal to -5.437 eV. On the other hand, the LUMO is distributed around the benzene part
and its energy is -0.506 eV. HOMO-LUMO gap (AG) of the derivative F1 is equal to 4.931 eV.

F1 derivative then is reactive and its reactivity is considerable.

E (ev)]
oo -0.506 eV
AE=4.931 eV
4
pa
LD,

oy

Figure IV-16 HOMO, LUMO and HOMO-LUMO gap of F1

HOMO, LUMO and HOMO-LUMO gap (AE) values of all the derivatives are tabulated in
Table 1V-6.

Table 1V-6 The calculated HOMO, LUMO and HOMO-LUMO gap of N-ferrocenylmethylaniline

derivatives

Code | -Enomo (eV) -ELumo (eV) ‘ AE (eV) ‘ Code | -Eromo (€V) -ErLumo (€V) = AE (eV)
=1
F2
=
F4
=3

F6 5.528 0.880 4.648
F7 5.634 2.959 2.676
F8 5.694 3.096 2.598
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Code -Enomo (V) -ELumo (eV) ‘ AE (eV) ‘ Code | -Enomo (V) -Erumo (eV) AE (eV)

A molecule with a high frontier orbital gap (HOMO-LUMO energy gap) has low chemical
reactivity and high Kinetic stability and versa [288-290], because it is energetically unfavorable to
add an electron to the high-lying LUMO in order to remove electrons from the low-lying HOMO.
Among the 28 derivatives some of them are predicted to be more reactive than others as F10-F12
and F21-F26 where it is obvious that their HOMO-LUMO gaps are lower.

IV.9. ADME and Pharmacokinetics properties

In pharmacokinetics and pharmacology, ADME is an abbreviation for "absorption,
distribution, metabolism, and excretion” which explains the disposition of a pharmacological
substance in an organism [291]. Development of new drugs were shown to be caused by the
undesirable pharmacokinetic properties of these drugs, therefore, it has been increasingly

demanded to evolve new approaches that are able to predict drugs ADME properties [292].

SwissADME webserver was used to study the ADME and Pharmacokinetics properties,
this webserver allows computing physicochemical descriptors and estimate ADME parameters,
pharmacokinetic properties, druglike nature of N-ferrocenylmethylaniline derivatives, ensuring
that they are not only promising candidates in terms of biological efficacy but also

pharmacokinetics [293].
IV.9.1. Pharmacokinetic properties

Pharmacokinetics is one of the major branches of pharmacology. It refers to the way that the
body reacts on and affects a pharmaceutical substance in it. When a drug enters the body, it will
be soon recognaised by the body and processes it in a special way, according to its characteristics.
The information that provided by a pharmacokinetics study is very necessary to improve the

administration and use of medicines [294, 295].

Every drug takes the oral rout has a set of conditions that must be fulfilled to be effective,

one of these conditions is the need to across the gut wall. The absorption of substance across this
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wall is a complex process, that is why gastrointestinal drug absorption (Gl absorption) is one of

the most important conditions that the drug needs to achieve [296].

Drugs directed to the brain to treat certain neurodegenerative diseases such as Alzheimer's
disease and Parkinson’s disease or to treat Inflammatory diseases (Infection, Multiple sclerosis
and Brain tumors), these drugs need to be able to across the blood—brain barrier (BBB) and this
condition is as much important as the first one in our candidates to treat the oxidation reactions
that occur in the brain [297].

P-glycoprotein (Pgp) is an important protein of the cell membrane that pumps many foreign
substances out of cells. The importance of this protein is to transport drugs across the cell
membrane, its ability to transport drugs accounts for regulating the distribution and bioavailability
of drugs [298].

Cytochromes P450 (CYPs) are a super family of enzymes that oxidize steroids, fatty acids,
and xenobiotics [299, 300]. The importance of these enzymes in pharmacokinetics is that they are
the main enzymes involved in drug metabolism, accounting for about 75% of the total metabolism.
effects on CYP isozyme activity are a major source of adverse drug interaction, since changes in

CYP enzymes activity may affect the metabolism of various drugs [301].

It can be seen from Table I1\VV-7 that most of the derivatives are strongly drug candidates due
to their ability to across the gut wall which allows them to take the oral route except F16. They
also have the ability to pass the Blood-Brain Barrier except F16 and F19. Moreover, the results
show that only F10-F12, F19, F21-F23 are not predicted to be Pgp substrate while all the rest are
predicted to be Pgp substrate which can allow them across the cell membrane. Also, the ADME
prediction indicated that the most derivatives are not CYP inhibitors, thus makes them good drug
candidates, although some derivatives have been considered as inhibitors of CYP1A2 and
CYP3AA4.

Table IV-7 ADME prediction of N-ferrocenylmethylaniline derivatives.

Gl BBB Pgp CYP1A2 CYP2C19 CYP2C9 CYP2D6 CYP3A4
Compound

absorption permeant | substrate | inhibitor inhibitor inhibitor inhibitor inhibitor

F1
F2
F3
F4
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— Gl BBB Pgp | CYP1A2 CYP2C19 CYP2C9 CYP2D6 CYP3A4

absorption permeant | substrate | inhibitor inhibitor inhibitor inhibitor inhibitor

?‘ High Yes Yes
F6 ‘ High Yes Yes Yes No No No No
F7 ‘ High Yes Yes Yes No No No No
F8 ‘ High Yes Yes Yes No No No No
F9 ‘ High Yes Yes Yes No No No No
F10 ‘ High Yes No Yes No No No Yes
F11 ‘ High Yes No Yes No No No No
F12 ‘ High Yes No Yes No No No No
F13 High Yes Yes Yes No No No No
F14 ‘ High Yes Yes Yes No No No No
F15 High Yes Yes Yes No No No No
F16 Low No Yes No No No No No
F17 ‘ High Yes Yes No No No No No
F18 High Yes Yes No No No No No
F19 High No No No No No No Yes
F20 ‘ High Yes Yes No No No No No
F21 High Yes No Yes No No No Yes
F22 ‘ High Yes No Yes No No No Yes
F23 ‘ High Yes No Yes No No No Yes
F24 ‘ High Yes Yes No No No No No
F25 ‘ High Yes Yes No No No No No
F26 ‘ High Yes Yes No No No No No
F27 ‘ High Yes Yes No No No No No
F28 High Yes Yes No Yes No No No

IV.9.2. Drug-likeness properties

Oral administration is the most common of the possible routes of administration for a
pharmacological molecule authorized by the US Food and Drug Administration (FDA). Rather of
receiving an injection intravenously, a patient prefers to open the lid of a bottle and consume the
tablets/capsules. Orally administered pharmaceuticals are swallowed, then travel through the
human body on a long journey before they reach the interaction site and exert their

pharmacological effect [302].
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Table 1V-8 shows the predicted results of all N-ferrocenylmethylaniline derivatives and their
violations of the roles of Lipinski’s (Pfizer) [303], Ghose’s (Amgen) [304], Veber’s (GSK) [305],
Egan’s (Pharmacia) [306] and Muegge’s (Bayer) [307]. The results shows that most of the
derivatives have the necessary characteristics and have no violations of the roles that allow them
to be drug candidates. On the other hand, some of the compounds have shown 1 violation
(MLOGP>4.15) with Lipinski rule of five. Furthermore, other derivatives such as F2-F8 shows
other violations in Muegge rule (XLOGP3>5, Heteroatoms<2). Bioavailability score was
predicted to be 0.55 for all derivatives, which means that all the derivatives have a good oral
administration [308].

Table 1V-8 Drug-likeness and bioavailability of N-ferrocenylmethylaniline derivatives.

Lipinski Ghose Veber Egan Muegge Bioavailability
Compound N . . .
#violations #violations | #violations #violations @ #violations Score
ﬁ
B

F4‘

B
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o
o
=

0.55
0.55
0.55
0.55
0.55
0.55
0.55
0.55
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0.55
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Lipinski Ghose Veber Egan Muegge Bioavailability
Compound N N . o N
#violations #violations | #violations #violations @ #violations Score

B

| 5

F23
F24
F25
F26 ‘
F27
F28

|
B

IVV.10. In silico toxicity studies

The in silico toxicity study aims to help in optimizing the compounds regarding its toxicity
proprieties, the study could offer an important improvement to the awareness of full perspective
of virtual screening for the identification of target compounds with negligible or no toxicity which
may open a path for the selection of novel nontoxic N-ferrocenylmethylaniline derivatives with

high antioxidant activity.

The in silico toxicity study of the derivatives was performed using ProTox-1l1 webserver
[309]. It aims to predict the hepatotoxicity (dili), carcinogenicity (carcino), immunotoxicity
(immuno), mutagenicity (mutagen), and cytotoxicity (cyto), also it predicts the median lethal dose
(LD50) and the toxicity class (TC). Paracetamol also have been studied as a standard (Table 1V-9).

Table 1V-9 In silico toxicity profiles of the most five potent compounds

Molecule ‘ Dili ‘carcino‘immuno mutagen  cyto  LD50 (mg/Kg) | TC

Paracetamol —‘ 338 4
Inactive | Inactive | Inactive | Inactive 300 3

Inactive | Active | Inactive | Inactive 400 4

Inactive | Active | Inactive | Inactive 400 4

Inactive | Inactive | Inactive | Inactive 920 4

‘ Inactive | Inactive 500 4

Inactive [IACHVER I[nactive | Inactive 700 4

‘ Inactive | Inactive 700 4

‘ Inactive | Inactive 300 3
——‘7 Inactive | Inactive 300 3
Inactive 300 3
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Molecule Dili ‘carcino immuno mutagen cyto LD50 (mg/Kg) | TC

F11 Inactive | Active 300 3
=) Inactive | Active 400 4
F13 Inactive Active Inactive 400 4
Inactive Active Inactive 400 4

Inactive | Active Inactive 400 4

2400 5

3000 5

Active | Inactive Inactive 210 3

Inactive | Active | Inactive Inactive 237 3
Inactive | Active Inactive 237 3
Inactive | Inactive 256 3

‘ Inactive | Inactive 237 3

‘ Inactive | Inactive 256 3

Inactive 1000 4

ProTox-I1 webserver successfully predicted the hepatoxicity of Paracetamol which is known
[310]. F1, F4, F20, F24, F25 and F26 were predected non toxic derivatives with LD50 equal to
300, 920, 237, 256, 237 and 256 respectevly and their TC were 3, 4, 3, 3, 3 and 3 respectivly. The
toxicity class of F14 and F27 was detected to be equal to 4 and were predicted as non-toxic in
hepatotoxicity, immunotoxicity, mutagenicity, and cytotoxicity, F27 possess the highest LD50,
compounds F21 and F23 were predicted as toxic in mutagenicity, finally compound F12 was

predicted to be immunetoxic. All derivatives did not show any hepatotoxicity or cytotoxicity.
IVV.11. Conclusion

The mixed basis sets of LanL2DZ(Fe)/6-31G(d) gave accurate results. That can be observed
from values of R2 of the comparison between the bond lengths and angles where R? was equal to
0.9992 and 0.9755 respectively. Also, the mixed basis sets show a high ability to predict the
spectral properties. Moreover, the energetic properties such as HOMO, LUMO, and HOMO-
LUMO gap have been calculated to predict the reactivity of the derivatives. Using Gaussian 09,

the MESP maps have been also calculated to predict the reactive sites of the derivatives. basically,
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the electrophilic sites concentrated on the nitrogen of the amine group of all derivatives where the

nucleophilic sites predicted to be concentrated on the phenyl group.

ADME and Pharmacokinetics properties of N-ferrocenylmethylaniline derivatives have
been predicted using SwissADME webserver tool, the predicted results show that most derivatives

have the needed properties of bioavailability which nominates them to be strong drug candidates.

The in-silico toxicity study predicted the toxicity of the derivatives to put in mind their

toxicity in order to select the best condidates as antioxidants.
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V.1. Introduction

Antioxidants appear today as the keys to longevity and our allies in the fight against modern
diseases. These are protective elements that act as free radical scavengers [311]. These are
produced daily by the body; they are very reactive compounds comprising a single electron, they
are necessary for vital mechanisms but, they become harmful when they are in excess and induce
certain damage at the level of the structure of the organs by causing an oxidative stress which

contributes to the creation of different diseases such as cardiovascular disease, cancer, etc.

Defense systems make it possible to prevent free radical formation or to limit the resulting
oxidation lesions. These systems can be endogenous or exogenous, of nutritional origin [312].
These systems depend on several molecules which called antioxidants. That makes the

investigation of new antioxidants such an interesting research field.

Glutathione plays an essential antioxidant intracellular role [313] and is involved in
elimination of reactive oxygen species and act as a scavenger for various oxygen radicals. The
enzyme glutathione reductase (GR), also called glutathione-disulfide reductase, reduces the
oxidized form of glutathione disulfide (GSSG) to the reduced glutathione form (GSH). Elevated
levels of the ratio GSH / GSSG, intracellular signal transduction, elimination of free radicals and
reactive oxygen species, and the preservation of intracellular redox status [314]. Thus, inhibition
of glutathione reductase results to a decrease in GSH and an increase in GSSG and consequently
high rate of GSH / GSSG, So, studding the glutathione reductase inhibition by potentially
antioxidant compounds could serve as a good means for choosing antioxidants candidates. A good
antioxidant candidate should inhibit glutathione reductase enzyme less. Therefor, molecular
docking study will be performed to afford an insight about the inhibition and binding partialities

of the most potent compounds with glutathione reductase.
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V.2. Materials and Methods

The derivatives were dissolved in dimethylformamide (DMF), the concentrations of the

derivatives are tabulated in Table V-1

Table V-1 the concentration of the derivatives in DMF

Code ‘ C [mM] Code C [mM] Code

30.242 60981 [
9.2 61.278 - F22 79.321
65.531 48.072 F23 52.881
73.928 43.012 . F24 | 55.832
92.132 117.018 . F25 | 47.457
107.487 83.526 F26 60.019
92.132 108.04 - F27 53.127
232.388 90.033 - F28 117.738
54.044 86.428
63.956 16.506

V.2.1. Experimental devices

The electrochemical study was carried out at VTRS laboratory using a Voltalab 40 (PGZ

301) with the three-electrode assembly controlled by a microcomputer (Voltamaster 04 Software).
V.2.1.1. Classic three-electrode assembly

In all the experiments, the assembly with three electrodes was used: a reference electrode,

an auxiliary electrode and a working electrode (the substrate).
V.2.1.1.1. Electrochemical cell

The cell used is in PYREX glass, with a capacity of 15 ml, a volume sufficient for the
concentration of electroactive species to remain constant during handling. The latter has a double
wall and a cover with 5 holes to pass the three electrodes, the gas tube and the last hole to inject

the derivatives into the solution.
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V.2.1.1.2. Electrodes

= The working electrode: a glassy carbon electrode of an area equal to 0.013 cm?

= The auxiliary electrode (counter electrode): a platinum wire was used as a counter

electrode.
= The reference electrode: all the potential measurements are taken in relation to the saturated

calomel electrode (SCE) with potassium chloride KCI, constituted by the calomel system
(mercurous chloride / mercury + potassium chloride) represented by:

Hg,Cl, | +2e~ & 2Hg 1 +2C1™ Equation V-1
Its potential in relation to the normal hydrogen electrode is equal to +0.2444 V at 25 °C.
V.2.1.1.3. Electrolyte

In general, solutions are used which contain electroactive species, a completely dissociated
support electrolyte salt allowing the solution to be saturated. Under these conditions the trace of a
voltammogram is from a few milliseconds to a few minutes. In order to remove dissolved oxygen

when needed, the generally used procedure is to bubble an inert gas for a few minutes [315].

In all electrochemical processes, there are several types of phenomena associated with a
transfer of electric charge at the interfaces formed by the contacting of electrodes (electronic
conduction) and an electrolyte (ionic conduction). During this charge transfer, chemical

transformation (redox) is occurring (Figure V-1).

Working Electrode Working Electrode
(cathode) (Anode)

Reduction Oxidation
(Generating Radicals)

Figure V-1 charge transferring process between the electrode and the electrolyte
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V.2.1.2. Experimental conditions
= The potential E: -1600 up to 0 mV.
= Scanning speed is constant: 100 mV/s.
= The solvent: Dimethylformamide (DMF).

= Supporting electrolyte: Tetrabutylammonium tetrafluoroborate (C1sH3sBF4N).
V.3. Results and discussion
V.3.1. Electrochemical study of the behavior of the electrolyte

Before starting the electrochemical study of our system, the solution has been examined in
the absence of O in order to determine its electroactivity domain. For the plotting of the cyclic
voltammetry curves, a potential sweep has been performed between 0 and -1600 mV, to analyze
the electrochemical behavior of our electrolyte. The shape of the cyclic voltammogram is given in
Figure V-2.

600 ~
400 +

200 ~

-200 +

Current Density (uWA/cm?)
o
" " 1 " "

-400 -

60 +——————T T T T T T
-18 -16 -14 -12 -10 -08 -06 -04 -02 00 02

Potential (V)

Figure V-2 cyclic voltammogram of the electrolyte

This voltammogram prove that there are no other reactions that can occur during the
experiment in the electrolyte which could mislead the results. Therefore, the only reactions that

can occur in the electrolyte are the redox reactions of the superoxide anion.
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V.3.2. Electrochemical study of the behavior of the complex (F-O2")

After getting a voltamogramm of the solution in the presence of only the support electrolyte,
O2 was then bubbled into the solution and a second voltammogram of O, was obtained under the
same conditions. Then, this experiment was reapeted after successive addition of a solution of each
ferrocene derivative, the volume of each addition is equal to 1ml.

400 400
02
——0.0908 mM
——0.1799 mM
{g 200 g.g 200 + ——0.3529 mM
g g ——0.4369 mM
= = ——0.5193 mM
= 04 3 0 - —— 0.6002 mM
= = —— 08340 mM
2 2
D -200 + @ -200
[a] o
= P
[= =4
< e
El -400 5 -400
(&) (&)
-600 -600
T T T T T T T T T J T T T T T T T T T d
-18 -1.6 -14 -1.2 -10 -08 -06 -04 -02 00 02 -1.8 -16 -14 -12 -10 -08 -06 -04 -02 00 0.2
Potential (V) Potential (V)
F4
600
400 —0,
i ——1.450 mM
400 l ——2153mM
——2.843mM
o 2004 = ——3.520mM
5§ g 200+ ——4.185mM
= = ——4.836 MM
ERE ES ——5.476 mM
g 04 ——6.104mM
%’ E‘ ——6.721mM
@ -200 @
[a] O -200
= €
L e
£ -400 E
3 -400
3 3
-600 - 600 4
T T T T T T T T T 1 T T T T T T T T T 1
-8 -16 -14 -12 -10 -08 -06 -04 -02 00 02 -1.8 -16 -14 -12 -10 -08 -06 -04 -02 00 02
Potential (V) Potential (V)
F5 o F6
——o0.912mM 15+ o,
400 — 1.807 mM
——2.683mM 104 2.108 mM
——3544mMm : ——3.131 mM
200 4 ——4.387 mM —— 4.134 mM
g ——5.215mM %‘ 0.5+ —— 6.084 mM
= e mm S ——7.032mM
< - < 0.0+
EREE —— 7.607 mM £ ——7.962 MM
= ——8.376 mM = —
= ml > o054 9.772 mM
2 z
& -200 o 3
[a) Q -1.04
k= k<3
1<) L 45
£ -400 £ -1.5
3 3
2.0
-600
2.5

T T T T T T T T T 1
T T T T T T T T T d
18 -1.6 -14 -12 -1.0 -08 -0.6 -04 -02 00 0.2 -18 -16 -14 -12 -10 -08 -06 -04 -0.2 0.0 0.2

Potential (V) Potential (V)

117



V. Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic voltammetry and molecular docking studies

F7
02
4004 ——0.912mM
——1.807 mM
2004 ——2.683mM
& ——3.544mM
g ——4.387mM
ERCE ——5.215mM
2 — 6.027 mM
a ——7.607 mM
& 2007 ——8.376 mM
z
1
5 -400 H
(s}
-600
T T T T T T T T !
-1.8 -16 -14 -12 -10 -08 -06 -04 -02 00 0.2
Potential (V)
F9
—o,
400 ——0.535 mM
l ——1.060 mM
—— 1574 mM
T > 2079 mM
S ——2.574mM
3 od ——3.059 mM
= ——3.536 MM
k] —— 4.003 mM
g -200+ ——— 4.462 mM
P ——4.913mM
[
£ -400
(8]
-600 -
T T T T T T T T T ,
-1.8 -1.6 -1.4 -1.2 -1.0 -0.8 -0.6 -0.4 -0.2 0.0 0.2
Potential (V)
F11
400 — 9
—— 0.604 mM
200 ——1.196 mM
T b ——1.776 mM
S —2.345 mM
< o4 ———2.904 mM
E ——3.452mM
2 ——3.989 mM
& -200+ —— 4517 mM
= ——5.035mM
[} [
S 400 5.544 mM
=1
s}
-600
T T T T T T T T T !
-1.8 -16 -14 -12 -10 -08 -06 -04 -02 00 0.2
Potential (V)
F13
400 — 5
——0.476 mM
——0.943mM
T 2004 —— 1.400 mM
S ——1.849 mM
< o ——2.289 mM
= ——2.721mM
iz ——3.145mM
& 200 ——3.561 mM
= ——3.969 mM
@ ——4.370mM
£ -400
=3
8}
-600

T T T T T T T T T d
-18 -16 -14 -12 -10 -08 -06 -04 -02 00 02
Potential (V)

02
104 ———2.301 mM
—— 4557 mM
05 ——6.769 MM
. = —— 8.938 mM
T 004 _|——11.066 mM
5 ——17.214mM
2 054 ———19.188 mM
= ——21.126 mM
% -1.0 -
a
E -1.54
5
O -2.04
-2.54
-18 -16 -14 -12 -10 -08 -06 -04 -02 0.0 0.2
Potential (V)
F10
400 o,
——0.633mM
200 ——1.254mM
N ———1.863mM
& ———2.460 MM
S o ——3.046 MM
e ——3.620 MM
= ——4.184 mM
2 200 ——4.737 mM
3 ———5.281mM
= ——5.814mM
§ -400 4 —— 8518 mM
O
-600
-1.8 -1.6 -1.4 -1.2 -1.0 -0.8 -0.6 -0.4 -0.2 0.0 0.2
Potential (V)
F12
02
4007 ——0.607 mM
——1.202 mM
o~ 200 1 ———1.785mM
3 ——2.357mM
2 ——2.918 mM
= 04 ——3.469 mM
z —— 4.009 mM
2 —— 4.539 mM
-200 H
8 —5.060 MM
e ——5571mM
g
£ -400
[8)
-600 +
-18 -16 -14 -12 -10 -08 -06 -04 -0.2 0.0 0.2
Potential (V)
Fl14
600
02
400 - ——0.426 mM
——0.843mM
= ——1.253mM
200
5 ——1.654 mM
< ——2.048 mM
> 01 ——2.435 mM
k2] ——2.814mM
& 2004 ——3.186 mM
= ——3.551 mM
o ——3.910 mM
= -400 -
o
-600
-1.8 -16 -14 -1.2 -10 -08 -06 -04 -0.2 0.0 0.2

Potential (V)

118



V. Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic voltammetry and molecular docking studies

Potential (V)

F15
400 + e O2
——1.159 mM
2004 ——2.294mM
T ——4.501 mM
b ——5.572mM
< oA ——6.624mM
= —— 7.655 mM
B ——8.668 mM
g -200+ ———9.662 MM
= ——10.638 mM
]
[
5 -400
(8]
-600 o
-18 -16 -14 -12 -10 -08 -06 -04 -02 0.0 0.2
Potential (V)
F17
154 02
104 ——1.070 mM
——3.147mM
T o054 —— 4.155 mM
S ——5.145mM
£ 004 ——6.115mM
= ———8.921mM
% -0.5-
=
3
S 104
f=
o
5 154
(s}
204
2.5 T T T T T T T T T )
-18 -16 -14 -12 -10 -08 -06 -04 -0.2 0.0 0.2
Potential (V)
F19
1.04 Oz
——0.885 mM
0.5 — 1.694 mM
- 5 —— 2,517 mM
g 004 ——3.324mM
= ——4.115mM
E 057 ——4.892mM
e ——5.654 mM
% ' ——6.402 mM
Q 154 ——7.136 mM
5 —— 7.857 mM
5 204
(8]
-2.54
-3.0 T T T T T T T T T )
-18 -16 -14 -12 -10 -08 -06 -04 -02 00 02
Potential (V)
F21
400 0,
——1.037 mM
——— 1.540 mM
—~ 200 ——2.034 mM
g ——2.518 mM
= ——2.993mM
2 01 ——3.917mM
2 —— 4.366 mM
& -200 —— 4.807mM
[a]
€
o
S -400
@]
-600
-18 -16 -14 -12 -10 -08 -06 -04 -02 0.0 0.2

Current Density (mA/cm?)

Current Density (mA/cm?)

Current Density (nA/cm?)

Current Density (uA/cm?)

F16
1.5+
02
1.0 —0.827 mM
——1.638 mM
0.5 ——3.213mM
——3.977mM
0.0 ——5.464 mM
——6.187 MM
054 ——6.897 MM
——7.593 mM
-1.04
-1.54
-2.04
-25 T T T T T T T T T 1
-18 -16 -14 -12 -10 -08 -06 -04 -02 0.0 0.2
Potential (V)
F18
1.5 —0,
—— 0.891 mM
1.0 ——1.765mM
——2.622mM
0.54
——3.463 mM
004 ——4.287 mM
—— 6.669 mM
054 —— 7.434mM
——8.185mM
-1.0
1.5
-2.04
25 T T T T T T T T T !
-18 -16 -14 -12 -10 -08 -06 -04 -0.2 0.0 0.2
Potential (V)
F20
400
OZ
——0.324mM
2001 ——0.786 mM
——0.934 mM
——1.080 mM
04 - ——1.223mM
——1.363mM
——4.229mM
-200 4
-400 -
-600
T T T T T T T T T !
-18 -16 -14 -12 -10 -08 -06 -04 -0.2 0.0 0.2
Potential (V)
F22
400 —0,
—— 0.785 mM
200 4 ——— 1.555 mM
—2.310 mM
— 3.051 mM
01 ——3.777mM
——5.876 mM
-200 —7.211 mM
-400 A
-600
-800 T T d

T T T T T T T
-18 -1.6 -14 -12 -1.0 -08 -06 -04 -02 00 02
Potential (V)

119



V. Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic voltammetry and molecular docking studies

400 400 4
__ 200 2004
s 5
o4 S
E 3 o
z 2
@ -200 @
3 5 -200
a a
£ -400 =
S £ -400
3 3
-600
-600
-800 T T T : r r r . . , T T T T T T T T T |
-1.8 -1.6 -14 -1.2 -10 -08 -06 -04 -02 00 0.2 -18 -16 -14 -12 -10 -08 -06 -04 -02 00 02
Potential (V) Potential (V)
F25 F26
400 - —0, 400 — 06,
— 0.470 mM — 0.594 mM
&~ 200 —1.382mM 200+ — 1%171; mm
£ ——1.825mM T —Ll748m
2 ——2.260 mM S % ——2.308mM
2 07 - ——3.515mM ERNGE - 75-233 mm
= ——3.918 mM ) T 3s9im
2 ——4.314mM 2 T 3.926mM
8 2001 ] & 200 —— 4.446 mM
= = —— 4.956 mM
@ @ ——5.456 MM
£ -400 £ -400 -
o (&)
-600 - -600
T T T T T T T T T 1 T T T T T T T T T 1
18 -16 -14 -1.2 -1.0 -08 -06 -04 -02 00 0.2 -1.8 -1.6 -14 -12 -1.0 -08 -06 -04 -02 00 0.2
Potential (V) Potential (V)
F27 F28
400 —0, 400 —0,
——1.547mM ——1.166 mM
2004 ——2.043mM 200 4 ——2.309 mM
< ——2.530 mM < ——3.429mM
5 ——3.007 mM 5 = ——4.528mM
< o4 ——3.476 MM < 01 ——5.607 mM
= ——3.935mM = ——6.607 mM
‘@ 200 ——— 4387 mM @ 2004 ——8.721mM
[=4 c
8 —4.830 mM 8 —9.722 mM
z = ——10.703 mM
g -400- 5 -400
3 3
-600 + 600 4
-800 T T T T T T T T T ! -800 - : : T r r T T T )
-1.8 -1.6 -1.4 -1.2 -1.0 -0.8 -0.6 -0.4 -0.2 0.0 0.2 1.8 -1.6 1.4 -1.2 -1.0 -0.8 -0.6 -0.4 -0.2 0.0 0.2

Potential (V)

Potential (V)

The reduction peak is obviously stable in every addition of the derivatives which means that
initial amount of O is the same in every cycle, the fixed amount of Oz in the solution gives us the
same concentration of the superoxide radical in the reduction process of O,. Therefore, it is
possible to compare the oxidation peak of each addition to each other. Most of the voltammograms
shows a good response upon addition of ferrocene derivatives, the decreasing of the oxidation peak
is clearly observed for compounds F12, F15, F19, F21, F23, F27 and F28.

From these voltammograms the binding constant (K), the free binding energy (AG), the

diffusion coefficient (D) and the half-maximal inhibitory concentration (IC50) were calculated.
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V.3.3. Binding constant (K)

The bonding affinity between two or more molecules at equilibrium is measured by a binding
constant, which is a special case of general equilibrium constants. According to authors of
references [5, 316, 317] K is calculated using the following equation:

1 <1)—1 (i)+l (K) Equation V-2
og 7] = log p— og quation V-
where K is the apparent binding constant, i, and i are the peak current of the free radical
(O27) and the complex (F-O27), respectively. Under the assumption of reversible, diffusion-
controlled electron transfer and the complex F-O2™ is a 1:1 association complex, then the plot of
log(1/[F]) versus log(i/(io-i)) becomes linear with the intercept of log(K) (Equation V-2).

The plots of log(1/[F]) versus log(i/(io-i)) used to calculate the binding constants of each

derivative with O are represented in Figure V-3, and the values of K are tabulated in Table V-2.

F1 F2
33 36
35
31 _
S S 34
=29 3 33
Q0 oo
8 832
27 y=0.7593x + 1.5579 y =0.6571x + 2.1582
R? = 0.901 31 R?=0.9136
25 3
12 14 16 1.8 2 22 24 14 16 1.8 2 22
logli/i0-i)] logli/i0-i)]
F3 F4
35 3
2.8 °
— 3 - °
L L 2.6
EPE g24
y=1.7777x +0.581 25 y =0.7347x + 1.165
R? = 0.9488 R? = 0.9439
2 2
0.7 0.9 11 13 15 17 12 14 16 18 2 22
log[i/i0-i)] log[i/i0-i)]
F5 F6
23 2.8
2.25 26 .
- —~ °
o 22 Q24 PS
) )
% 2.15 % 2.2
T2 et Ea7e T, e v = 0.6225x + 1.3406
R? = 0.9987 R?=0.9025
2.05 1.8
0.8 0.9 1 11 12 13 12 14 16 18 2 22 24
log[i/i0-i)] log[i/i0-i)]




V. Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic voltammetry and molecular docking studies

log(1/C)

log(1/C)

F7
3.5
3
[ )
2.5
2 y = 0.8985x + 1.5954
2 _
15 R*=0.9624
0.5 0.7 0.9 11 13 1.5 1.7
log[i/i0-i)]
F9
35
3
2.5
2 ° y = 1.1209x + 1.2926
R? = 0.9554
15
0.5 0.7 0.9 1.1 13 15 1.7 19
log[i/i0-i)]
F11
35
3

2.5
y = 1.3269x + 1.3523
R2=0.9374
2
0.5 0.7 0.9 1.1 1.3 1.5
log[i/i0-i)]
F13
3.4
32
5 3
=28
b
9 26
24 y = 0.9458x + 1.5268
' R?=0.9566
22
0.8 1 1.2 1.4 16 1.8 2
log[i/i0-i)]
F15
35
~ 3 ®
(&}
=25
o
o
2 y=0.6111x + 1.5293
R2 = 0.9096
1.5
0.5 1 15 2 2.5

log[i/i0-i)]

log(1/C)

log(1/C)

log(1/C)

F8
2.5
23 L
2.1 ®
1.9
1 y =0.8712x + 0.9721
: R?=0.9243
15
0.5 0.7 0.9 1.1 13 15 1.7
log[i/i0-i)]
F10
3.5
3
2.5
2 y =1.0243x + 1.6241
R?=0.9874
1.5
0 0.5 1 15 2
log[i/i0-i)]
F12
3.5
[ ]
3
2.5 s
: y =0.9034x + 1.8121
R? = 0.9346
2
0.2 04 06 08 1 1.2 1.4 16
log[i/i0-i)]
F14
3.7
S 3.2
i
K
227 v =0.7688x + 1.9118
R? = 0.9886
22
0.5 1 15 2
log[i/i0-i)]
F16
3.5
3 .
o o
=25
[T
°
2 y=0.9192x +0.9173
R? = 0.9357
15
1.2 1.4 1.6 1.8 2 2.2 24
log[i/i0-i)]

122



V. Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic voltammetry and molecular docking studies

F17
26
[ )
_ 24
o
=22
K
- 2 y =0.8108x +1.1794
R2 = 0.9488
1.8
1 1.1 1.2 1.3 14 1.5 16 1.7
log[i/i0-i)]
F19
33
[ )
) 2.8
L
-
W
2 23 y =0.9976x + 1.6398
R2 = 0.9242
1.8
0.3 0.5 0.7 0.9 1.1 13 1.5
log[i/i0-i)]
F21
3.2
3
o 238
=)
W 2.6
Y y = 0.6415x + 2.0081
: R2=0.97
22
0.5 0.7 0.9 1.1 1.3 15 1.7
log[i/i0-i)]
F23
3.4
32 .
5 3
=28
o0
9 26 _.
y = 0.914x + 1.9693
24 19 R2 = 0.9055
22
0.2 0.4 0.6 0.8 1 1.2 14
log[i/i0-i)]
F25
3.4
3.2
5 3
=28
&
2 2.6 y = 1.0416x + 1.1622
2.4 R2=0.9147
22
0.6 1.1 1.6 2.1 26
log[i/i0-i)]

F18
33
’J 2.8 ()
S~
)
K
<23 y =0.7575x + 1.4992
R2=0.9616
1.8
0.7 0.9 1.1 1.3 15 1.7 1.9 21
log[i/i0-i)]
F20
43
3.8
Q33
-
go 2.8
23 y = 1.6425x + 1.1203
R2=0.94
1.8
0.7 0.9 1.1 1.3 1.5 17
log[i/i0-i)]
F22
35
3
o
=25
&
-2 y = 1.6344x + 0.834
R2 = 0.956
15
0.7 0.9 1.1 13 15
log[i/i0-i)]
F24
3 °
28
o
= 2.6
w
o°
24 y=0.6526x +1.8
R2 = 0.959
22
0.6 0.8 1 1.2 1.4 1.6 1.8
log[i/i0-i)]
F26
35
®
S 3
i
%
9 25
y = 0.7871x + 1.6543
R?=0.9429
2
0.6 1.1 1.6 21 26
log[i/i0-i)]

123



V. Antioxidant activity of N-ferrocenylmethylaniline derivatives by cyclic voltammetry and molecular docking studies

F27

2.8

Q26

2.2

0.4 0.6

log[i/i0-i)]

0.8 1

g2
§°2.4

y =0.5669x +2.0134
R%=0.9654

1.2 14

log(1/C)

F28

y=0.7715x + 1.5221

0.7

1.2

R%=0.9882

1.7 22

log[i/i0-i)]

Figure V-3 plots of log(1//N-ferrocenylmethylaniline Derivative]) versus log(i/(io-1)) of each derivative

All the results have good R? values between 0.9010 and 0.9987. It can be seen from Table
V-2 that F2, F21and F27 had the highest values of K which equal to 143.95 M, 101.89 M and
103.14 M respectively, where the smallest values belong to the binding of F3, F8, F16 and F22

which were between 3 and 9 M.

Table V-2 binding constant of N-ferrocenylmethylaniline derivatives with the superoxide radical.

14.6208

21.9091

39.3898

9.3785

24.5592

42.0157

22.5071

R2

Code ‘ K [M?Y]

64.8739

33.6393

81.6259

0.9886

33.8337

8.2663

Tn
(op]

15.1131

M
\'

31.5633

Tn
(e}

43.6316

16.8658

V.3.4. Free binding energy (AG)

2
2
2

F21 ‘

F22

101.8880

6.8228 0.9560
93.1798 0.9055
63.0959 0.9590
14.5291 0.9147
45.1163 0.9429
103.1360 | 0.9654
33.2720 0.9882

The values of free binding energy AG were calculated from binding constant K, using the

following Equation V-3:

AG = —RTIn(K)

Equation V-3

Where AG represents the binding free energy in KJ.mol™?, R is the gas constant 8.31 J.mol"
K1 and T is the absolute temperature 298 K.
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The calculated values of AG are summerised in Table V-3. It can be seen from the obtained
results that the interactions between the radical and ferrocene derivatives are physical interaction.
The F-O2" bond occurs through multiple noncovalent bonds: electrostatic, hydrogen,
hydrophobic, and VVan der Waals. Long-range forces such as electrostatic and hydrogen bonds are
important in the rate of formation of F-O>™ complexes at the points of contact. The strongest
interactions between the radical and the derivatives that observed are those with F2 (12.306
KJ/mol), F21 (11.450 KJ/mol), F23 (11.229 KJ/mol) and F26 (9.433 KJ/mol). On the other hand
F3, F16 and F22 had the weakest interactions with the superoxide radical and their energy equal
to 3.313, 5.231 and 4.755 respectively, these interactions are most likely to be Van der Waals
interactions type.

Table V-3 Free binding energy of N-ferrocenylmethylaniline derivatives with the superoxide radical.

Code -AG (KJ/mol) Code -AG (KJ/mol) Code -AG (KJ/mol)
F1 F11 F21
2 . F12 - F22 |
- F3 . F13 | . F23 |
F4 F14 F24
- F5 . F15 | . F25 |

- F6 . F16 . F26
F7 F17 F27
F8 F18 F28
F9 F19
F20

V.3.5. Diffusion coefficient (D)

The scanning speed was varied between 5 values (100, 200, 300, 400 and 500 mV/s) for the
blank solution (O2~) and the F-O." complex in order to measure the current density of the

oxidation using Randles-Sevcik equation [318] (Equation V-4)

3 11 .
ipa = 2.69. 105.n2.A.C.D2.v2 Equation V-4

Where ipa is the anodic peak current in pA.cm™, n is the number of electrons transferred
through the oxidation reaction, A is the surface area of the electrode in cm?, C is the bulk
concentration of the electroactive species within the electrolyte solution in mol.cm™3, D is the

diffusion coefficient in cm2.s* and v is the scan rate in Vs,
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The values of anodic currents increase upon increasing the scan rate used to monitor the
diffusion phenomena.. The diffusion coefficient D is obtained from the slop of the linear plot of

the anodic current density versus thesequare root of the scan rate using Equation V-4

The measurement allows to know the diffusion coefficient D of the free radical and the F
bounded radical. Thus, it becomes possible to determine the deference between the diffusion speed
of the free and the F bonded radical which further confirm the interaction between the radical and

the derivative.

All the obtained results of diffusion coefficient are tabulated in Table V-4, from this table
it is obvious that the diffusion speeds of the complexes are slower than diffusion of the free radical
O2". The percent decrease of the diffusion has been also calculated. F12, F19 and F28 gave the
highest values of percent decrease 66.50 %, 95.19 % and 74.21 % respectively. It can be noted
that the decrease in diffusion coefficient values of the complexe F-O." does not depend only on
the molecular weight of the derivative attached to it, however the strength of the interactions
between the radical and the derivative can be also considered.

Table V-4 Diffusion coefficient of the free and bonded radical

D x10° D x10° Decrease Cod D x10° D x10° Decrease
ode
Oz [cm?/s] O2-D [cm?s] of D [%] O2[cm?/s] 02-D [cm?/s] of D [%]
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V.3.6. Half-maximal inhibitory concentration (1C50)

The half-maximal inhibitory concentration 1C50 is a measure of the effectiveness of a given
compound to inhibit a specific biological or biochemical function. Often the compound in question
IS a possible drug. This quantitative measure indicates how much of a drug or other substance
(inhibitor) is needed to half-inhibit a given biological process. in the study case IC50 refers to the
needed concentration to half-scavenge the superoxide anion. IC50 can be calculated according to

the following equation:

lpg. — L
% = P2 __P2x100 Equation V-5

02 radicalscavengingactivity ~ lpa
0

Where i,,,, is the anodic current density of the blank with the derivative and i, is the anodic

current density of the radical in each addition.

The plot of the % values versus the concentration gives a linear

02 radicalscavengingactivity
equation y = ax + b, where x is concentration of the derivative and y is the radical scavenging

activity. Thus, 1C50 can be calculated as follow:

5
1650 = a Equation V-6

The plots of the % versus the concentration for all the derivatives

02 radicalscavengingactivity

are represented in the following Figure V-4.
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Figure V-4 plots of % versus the concentration of ferrocene derivative

02 radicalscavengingactivity

included their equation and linear regression.

All 1C50 values are summarized in Table V-5 side by side with the linear regression of each
derivative. It can be seen from the Table V-5 that all the derivatives have considerable values of
IC50. However, F2, F12, F14, F21 and F27 show the best values of 9.981, 12.414, 10.565, 10.201
and 9.738 mM for IC50 respectively, the highest value is attributed to F23 (7.719 mM, R2=0.96).
R2 confirms the accuracy of the results where it can be clearly seen that all the results are with a
high values of R2 (>0.9).

Table V-5 Half-maximal inhibitory concentration of N-ferrocenylmethylaniline derivatives.

Code
F21
F22
F23

IC50 mM R?

Code IC50 mM R2

Code
F1 F1

IC50 mM ‘
F2 1
|

R2

0.9757
0.96

31.941
7.719

F3 F13
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Code  1C50 mM R2  Code ‘ IC50 mM R2  Code IC50 mM R2
F4 . . F24
= . . F25
F6 . . F26
F7 . . F27
F8 F28
F9

Obtained values of IC50 indicated that most N-ferrocenylmethylaniline derivatives showed

promising scavenging activity againstO; radicals, the compounds F2, F10, F12, F14, F19, F21,
F23, F24 and F27 emerged to display the most significant potency, with the activity of compounds
F23 is almost comparable to that of the standard a-tocopherol (7.0581 mM) [319] used as positive
control because it is the most potent biological [320-322] and antioxidant form of the vitamin [323-
326] values were summarized in Figure V-5. Although it didn’t give the best IC50 value, F24 is
obviously the safer choice between the derivatives considering the toxicity risks of F23 and the

other derivtives while F24 is non toxic.
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Figure V-5 IC50 values of N-ferrocenylmethylaniline derivatives and a-tocopherol as positive control.
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V.4. Molecular docking Studies

Molecular docking study was carried out to afford an insight about the inhibition and binding
parameters of the most five potent compounds with the enzyme glutathione reductase. The enzyme
glutathione reductase (GR), also called glutathione-disulfide reductase, reduces glutathione
disulfide (GSSG) to glutathione (GSH) which is involved in elimination of reactive oxygen species
and act as a scavenger for various oxygen radicals, glutathione exists in reduced (GSH) and

oxidized (GSSG) forms, the reaction symbolized by the following equilibrium.
2GSH + NADP* — GSSG + NADPH + H*

Inhibition of glutathione reductase results in a decrease in reduced glutathione (GSH) and
an increase in glutathione disulfide (GSSG) using NADPH, particularly from the pentose
phosphate pathway in bacteria, plants and animals in order to regenerate glutathione, a molecule
essential for resistance against oxidative stress and for the preservation of intracellular pH. So,
studying glutathione reductase inhibition could serve as a good means for the selection
antioxidants candidates. A good antioxidant candidate should inhibit glutathione reductase enzyme
less.

Rigid receptor and flexible ligand molecular docking model were carried out to study the
inhibition of glutathione reductase by the most five potent compounds against superoxide anion
radical, and to understand, how strong the interactions between them. The crystal 3D-structure of
glutathione reductase target involved in this study was retrieved from online data bank, RCSB
PDB (https://www.rcsb.org/pdb, ID: 1XAN) as shown in Figure V-6 [327].

Figure V-6 UCSF chimera ribbons chemical structure view of human glutathione reductase in complex

with a xanthene inhibitor (ID: 1xan).
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V.4.1. Receptor preparation

The receptor was first imported into the AutoDockTools interface, missing atoms were
inserted in incomplete residues, alternate conformations were deleted, all water molecules and

ligands were removed, and polar hydrogen atoms and charges were added to the receptor structure.
V.4.2. Receptor-Ligand Docking

In silico molecular docking simulations studies were executed by using the software
AutoDock 4.2 software [328, 329]. Lamarckian genetic algorithms were utilized, the grid box size
was set at 60x60x60 (A) in the x, y and z directions and the coordinates was fixed at x = 69.46, y
=-17.32 and z = 55.62. All docking experiments consisted of 50 docking runs; the other parameters
were left to their default values. The best conformation was selected with the lower docking energy
for further docking analysis. The visualization of the interaction was generated with PLIP

webserver (protein Ligand Interaction Profiler) [330, 331].

Results from molecular docking suggest that hydrogen bonding, hydrophobic forces and n-
cation interactions are involved in the binding process. Figure V-7 illustrates the interactions of
compounds F12, F14, F21, F23, F24 and F27 with the nearby residues in the active site of

glutathione reductase

*O

F12-GR F14-GR
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F21-GR

F24-GR FAM27-GR
Figure V-7 Best docking poses for glutathione reductase interacting with F12, F14, F21, F23, F24 and

F27 generated with PLIP web server illustrating the H-bonds, hydrophobic and w-cation interactions.

Interacting residues and their corresponding bond types and length are summarised in Table
V-6, it can be seen from this table that beside hydrophobic interactions, compounds F14, F23 and
F24 formed with the GR three hydrogen bonds, however, compounds F12 and F21 reacted
respectively via two and one hydrogen bonds, in contrast, compounds F27 did not form any

hydrogen bonding.

Table V-6 Interactions type between the ligands F12, F14, F21, F23, F24 and F27 and glutathione

reductase
Molecule ‘ Bond type Amino acid Distance (A)
H-bonds TYR197, LEU327 3.54; 2.50
F12 Hydrophobic | THR 57(2), ILE 198(2), TYR197, | 3.72; 3.31; 3.52; 3.25:
interactions LYS66 3.04;3.83
F14 H-bonds LYS66, SER177, TYR197 2.75; 2.06; 1.99
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Molecule ‘ Bond type Amino acid Distance (A)
Hydrophobic LYS66, TYR197, ILE198, 3.41; 3.33; 3.59; 2.21;
interactions LEU338(2), THR369, PHE372 3.22; 3.46; 3.37
H-bonds THR339 1.89
F21 Hydrophobic TYR197(2), THR369, VAL370(2), 3.35; 3.04; 3.40
interactions PHE372 3.41; 3.50; 3.63; 3.50
H-bonds LYS66, THR339(2) 2.05; 2.32; 1.93
F23 Hydrophobic THR57, TYR197, ILE198, 3.91; 3.50; 3.71; 2.99;
interactions LEU338, THR369, PHE372 3.18; 3.50; 3.45
H-bonds TYR197, THR339 (2) 3.10, 2.65, 2.01
Hydrophobic THR57, TYR197, ILE198, 3.82, 3.71, 3.85,
F24 interactions LEU338, THR369, PHE372 3.25, 3.47, 3.30
n-stacking
_ _ TYR197 5.25
interactions
n-cation
_ ) LYS66 4.06
interactions
F27 _ TRR57, LYS66(2), PHE181, 3.74; 3.52; 3.49; 3.83;
Hydrophobic
_ _ TYR197(2), ILE198, LEU338, 3.27; 3.12; 3.41; 3.20;
interactions
PHE372 3.34

Obtained binding free energy and the calculated inhibitory concentration (Equation V-7)

from molecular docking study for the most five potent compounds are summarised in Table V-7.
AG = RTIn(IC50) ‘ Equation V-7

Table V-7 Binding free energies and inhibitory concentration obtained from molecular docking study

Adduct

F12-GR F14-GR F21-GR F23-GR ‘ F24-GR  F27-GR
AG (Kcal/mol) -7.34 -7.61 -8.26
IC50 (uM) 4.16 2.61 0.88

The lowest binding free energy was found to be equal to -7.34 kcal/mol for compound F23,
this value indicates weak binding affinity towards the enzyme glutathione reductase compared to
other compounds. Compound F23 also possess the highest inhibitory concentration that is
necessary to reduce the rate of glutathione reductase enzyme reaction by 50%. Thus, the compound
F23 is a weaker inhibitor of glutathione reductase. Frthermore, F21 and F24 posses high 1C50
value and low AG (-7.52 and -7.61 Kcal/mol) respectively
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V.5. Conclusion

The results of studying the antioxidant activity for 28 N-ferrocenylmethylaniline derivatives
show that all the derivatives have a considerable radical scavenging activity. The confirmation of
the interactions between the derivatives and the radical was carried out by calculating free binding
energy to determine the strength of these interaction and their type. The result goes to confirm that
all the interactions between the derivatives and the radical were physical interaction. Free binding
energy of all the derivatives varied from 3.313 to 12.306 KJ/mol. To further confirm the
interaction between the radical and ferrocene derivative the diffusion coefficients were calculated,
the results showed that the diffusion coefficient of the free radical is always higher than the bonded
one, this finding further confirmed the interaction between theradical and the studied ferrocene
derivatives. Half-maximal inhibitory concentration IC50 of every derivative has been also

calculated

Molecular docking study revealed that compound F23 is the most inactive compounds
against glutathione reductase enzyme having the highest inhibitory concentration of 4.16 puM and
the lowest docking scores of 7.34 kcal/mol. F21 and F24 also predicted to be inactive compounds

against glutathione reductase enzyme.

The obtained in silico and in vitro results correspond with one another and give room for the
design of novel antioxidant N-ferrocenylmethylaniline derivatives with less activity against

glutathione reductase and inactive toxicity or at least bearly active considering its dose.
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VI. QSAR modeling

VI1.1. Introduction

Toward the discovery of novel biologically potent ferrocene derivatives, we herein present
a series of new antioxidant compounds of N-ferrocenylmethylanilines bearing various substituted
functions. Also, we build a QSAR model for description and prediction of radical scavenging
activity of N-ferrocenylmethylanilines, using the multiple linear regression (MLR) method. The
predicted QSAR model will guide the synthesis of potential new N-ferrocenylmethylaniline

derivatives as radical scavengers.
V1.2. Training set and biological data

Data set for the QSAR study is composed of 28 sets of N-ferrocenylmethylaniline
compounds for which their in vitro antioxidant activities against superoxide anion radical were
measured using cyclic voltammetry assays. All IC50 (mM) values have been converted into
positive logarithmic scale pIC50 by taking negative logarithm (-logIC50) and subsequently used

as the dependent variable for the QSAR model development.

The synthesis of a series of 28 N-ferrocenylmethylaniline derivatives and their in vitro
antioxidant activities (pIC50 values) used for the QSAR analysis were carried out in our laboratory
and listed in Figure VI-1.

=N <

Fe

<

F1, plICso = 1.5212 F2, pICso = 1.9061 F3, plCso= 1.4544 F4, pICso = 1.1594

Cl1
) CJ X (1 Q |
— — a =" @(C\m
Fe Cl Fe Fe Fe

& & < &

F5, p|C50 =1.4679 F6, p|C50 =1.1060 F7, p|C50 =1.7282 F8, p|C50 =1.0749

< I <

F9, pICso = 1.7038 F10, plCso = 1.8187 F11, plCso=1.7647 F12, pICso = 1.9761

CH,CH,
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F13, plCso = 1.7014  F14, pICso = 1.9914 F15, pICso = 1.5196 F16, pICso = 1.0839
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/@/ SO,NH,
COCH, Fe Fe COCH;
F17, pICso =1.1935  F18, pICs = 1.5327 F19, pICso = 1.8355 F20, pICso = 1.7092
C|0CH3 (|30CH3 COCH3 C|0C1-l3
F21, plCso = 2.0008 F22, plCso = 1.4957 F23, plCsp = 2.1124 F24, plCso= 1.8196

Y

N
Fe (|JOCH3

e @ o

(I

F25, plCso = 1.4897 F26, plCso = 1.6555 F27, plCso = 2.0115  F28, plCso = 1.5779
Figure VI-1 Chemical structures and observed pIC50 of N-ferrocenylmethylaniline derivatives against

05~ used as data set
V1.3. Molecular descriptors

Physico-chemical descriptors: such as surface area grid (SAG), molar volume (MV), heat of
formation (Hf), molar polarizability (Pol) and molecular weight (MW) were identified by pre-
optimizing the 28 N-ferrocenylmethylanilines by means of the Molecular Mechanics Force Field
(MM+) included in HyperChem version 8.0.8 package followed by refining the resulting

minimized structures using the PM3 semi-empirical Hamiltonian.

Quantum chemical descriptors: such as dipole moment (p), energy of frontier orbital’s
(HOMO and LUMO), atomic net charges and total energy were obtained using Gaussian 09
program package [332] at the density functional theory level with the unrestricted Becker’s three
parameter hybrid exchange functional [201] combined with Lee-Yang-Parr nonlocal correlation
function [333-335], a combination of basis set LanL2DZ (for iron) and 6-311G+(d) (for the rest

of atoms) was used for all structure optimisation process of N-ferrocenylmethylaniline derivatives.
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The rest of descriptors such as octanol/water partition coefficient (logP), topological polar
surface area (TPSA) and water solubility (logS) were calculated using the free web server
SwissADME [336].

V1.4. Molecular descriptors selection

In order to select the suitable predominant descriptors for establishing the QASR equation,
all generated descriptors obtained using Gaussian 09W, HyperChem and SwissADME were
subjected to correlation analysis with the experimentally determined radical scavenging activities,
taking every one of the descriptors as an independent variable, and pIC50 as a dependent variable
using multiple linear regression (MLR) method implanted in Molegro Data Modeler software
version 3.0, at the end of regression analysis only 6 descriptors were selected. The molecular
descriptors finally maintained are presented in Table VI-1. Moreover, the leave-one-out method
was used to validate the QSAR equation, and the obtained square of the cross-validation coefficient

Q? was used as a criterion of both robust stability and predictive ability of the model.

Table VI-1 Values of molecular descriptors

Molecule pIC50 HOMO LUMO TotalE p = MW MV | pol
SO 15212 |-0.01859 | , oo | -836.24 | 1.648 | 29117 | 3.03 | -4.76 | 482.29 | -145.48 |30.25 |, 4o
B 19061 |-0.01841| o | -87556 | 1.884 305.20 | 3.30 | -5.14 |500.34| 846.05 |32.09 |,
M 14544 |-0.01845 | -0.1989 | -836.24 | 1.786 305.20 | 3.30 | -5.14 | 480.8 | 798.42 |30.25 |, 40 4o
/BN 11504 |-0.01816 | , 0. | 91487 | 1.944 |319.22 | 3.56 | 558 |527.39| 893.38 [33.92| 1 o
G 14679 |-0.02032 |  ,oc10 | 1905 g3 | 2137 325,61 | 3.50 | 541 |499.65| 839.81 [32.18| o o
G 11060 |-0.02182 |, ,ocaa | 1905 g3 | 3-393 |325.61 | 3.50 | -5.41 |501.56| 845.95 |32.18 | ;.
AN 17282 |-0.02276 | ) 500 | 1905 g3 | 3865 325.61 | 3.50 | 541 |503.92| 84557 [32.18| o 4
SR 10749 |-0.02186| ) o, | -848.80 | 3.472 |370.06 | 3.57 | -5.48 |517.84| 8634 |32.88|,,; o
SO 17038 |-0.02826 | ) 0o | -848.80 | 3.948 | 370.06 | 3.57 | -5.48 |512.23| 8658 |32.88|,,; o
SON 15187 |-0.09388 | -0.2145 | | | 5603 |336.17 | 256 |-6.12 |502.84 | 850.77 |3197 | o oo
SERN 17647 | -0.09672 | o 511 | 1040 75| 6814 [336.17| 245 | -6.55 | 519.01 | 867.55 (3197 | o o
ZEI 19761 |-0.08552 | 1010 | 10407 | 8625 |336.17| 245 | -5.55 | 513.52 | 86178 |3197 | oo o
ZER 17014 |-0.05134 | 1, | -928.49 | 4577 |316.18| 2.89 | -5.54 506,53 | 85319 | 32.1 | ;2 o
ZTR 19914 |-0.05469 | 1, | -928.49 | 6113 |316.18| 2.78 | -4.97 51013 | 857.95 | 32.1 | ;2 1
ZERN 15196 | -0.04156 | .- | -928.49 | 7.726 |316.18| 2.78 | -4.97 | 511.1 | 858.74 | 32.1 | .. 1o
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F16

F17

F18

F19

F20

F21

F22

F23

F24

F25

F26

F27

F28

Molecule

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

F11

F12

F13

F14

F15

F16

F17

1.0839

-0.03607

0.20957

1173.30

4.433

359.17

4.00

-5.68

520.15

873.88

31.81

307.32

1.1935 | -0.05617 0.21'042 -988.88 | 4.589 |333.21| 3.00 |-5.00 |526.73 | 896.71 |34.01 185.36
1.5327 | -0.04942 0.26993 -988.90 | 5.653 |333.21| 2.96 | -4.79 | 533.01 | 905.96 |34.01 196.59
1.8355 | -0.03319 0.21'368 144;)_17 6.785 |370.25| 1.94 |-4.71|553.39 | 930.31 | 32.74 21é.89
1.7092 | -0.03233 0.26314 -988.90 | 3.954 |333.21| 2.85 | -4.28 | 521.94 | 896.46 |34.01 18&;.37
2.0008 | -0.10873 0.26706 119'3_40 6.488 |378.20| 2.15 | -5.07 | 544.38 | 943.67 |35.72 194.74
1.4957 | -0.11378 |  500oc | 1793 41 | 4192 [378.20| 215 | -5.07 |554.00 | 954.57 [35.72| oo,
2.1124|-0.11364 | 51 1cg | 119347 | 2183 |378.20| 215 | -5.07 (55354 | 954.67 |35.72| o
1.8196 | -0.07599 | 5 -0c | 1007 15| 6:500 (358.21| 2.63 | -4.49 | 544.5 | 945.62 (35.86 | 1.1 ,e
1.4897 | -0.07578 | ) 50001 | 10g7 15| 4082 [358.21| 2.63 | -4.49 | 555.00 | 953.27 |35.86 | 1, -9
1.6555 | -0.07678 |  510cy | 1097 15| 1716 [358.21| 2.63 | -4.49 | 556.92 | 952.87 (35.86 | |- o
2.0115 | -0.0379 | 5 50024 | 118063 | 3:660 |395.27| 3.90 | -6.01 |600.02 | 1051.65 [41.83 | 1. oq
1.5779 | -0.02033 0.26602 104;1_22 3.638 |348.22| 2.64 |-4.82 |546.97| 938.9 |35.36 163'.74
TPSA

12.03 | -1.019 | -0.396 | -0.086 |0.0644 | -0.531 0_1'09 0_é37 -0.343 | 0.005 o.é43 1.208
12.03 | -1.045 | -0.369 | -0.236 | 1.039 | -0.911|0.158{0.084 | -1.292 | 0.006 | 00| 0.914
12.03 | -1.023 | -0.364 | -0.178 | 0.999 | -0.855|0.232| g: | -0.293 | -0.196 |, 20| 0.549
1203 | -1.03 | -0.378 | -0.16 |0.957 |-0.805|1.303|, o, | -0.78 | -0.531 | o- | 0.858
12.03 | -1.035 | -0.295 | -0.17 | 1.072 | -0.893 | o, {0.445|-0523 | -0.008 |, , | 0.457
12.03 | -1.022 | -0.366 | -0.185 | 0.982 | -0.903 |0.087 | ;| -0.227 | -0.363 |0.091 | 0.264
12.03 | -1.031 | -0.362 | -0.19 | 1.031 | 0.9 |0.067 o.é31 -0.614 | 0.186 0.5'14 0.746
12.03 | -1.022 | -0.375 | -0.19 | 0.959 | -0.8480.183| ) o [ -0.165 | -0.602 | 1.227 | -0.602
12.03 | -1.027 | -0.365 | -0.187 | 1.009 | -0.897 | 0.038 0_7'84 -0.771| 0.79 0.7'99 0.593
57.85 | -1.005 | -0.39 | -0.122 | 0.96 |-0.674 0_1'98 0_3'12 0.44 | -0.182 0.5'02 0.151
57.85 | -0.998 | -0.417 | -0.177 |-0.229 | -0.058 | 0.788 | 0.123 | -0.403 | -0.004 |, oo (-0.525
57.85 | -1.009 | -0.372 | -0.156 | 1.002 | -0.86 |0.677|, 5o | 0.024 | -0.166 | 50| 0.682
35.82 | -1.019 | -0.311 | -0.123 | 1.066 | -0.843 | oeo| 042 | -0.620| 0.077 |, 0| 0.476
35.82 | -1.025 | -0.362 | -0.182 | 0.967 | -0.922 |0.166 |, oo | -0.182 | -0.306 |0.238| 0.769
35.82 | -1.017 | -0.359 | -0.177 | 1.031 | -0.899 |0.245| o, | -0.34 | 0.361 |, .| 0.928
12.03 | -1.033 | -0.395 | -0.144 | 0.925 | -0.867 |0.446 |, ., |-0.285 | -0.221 |, /. | 0.846
29.1 | -1.003 | -0.338 | -0.14 | 1.022 |-0.873 0_447 0.392|-0.526 | -0.013 0.479 0.337
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29.1 | -1.018 | -0.368 | -169 | 1.034 |-0.882|0.279 1_3206 -0.858 | 0.527 0!;38 0.942
80.57 | -1.017 | -0.363 | -0.185 | 1.054 | -0.898 |0.349 1_687 -0.255 | -0.5 0.é63 1.053
20.31 | -1.16 | 0.183 | -0.141 | 1.252 |-1.054 1_3:72 0.082| -0.365 | 0.002 o.éoe 0.734
66.13 | -1.193 | 0.296 | -0.204 | 1.215 | -0.96 1_668 0.082 | -0.319 | -0.164 0.1'66 0.255
66.13 | -1.178 | 0.157 | -0.143 | 1.271 | -1.137 0_5'03 0_668 -0.555 | -0.031 | -0.3 | 0.421
66.13 | -1.189 | 0.19 | -0.104 | 1.342 | -1.245 0_442 0_1'35 -0.046 | -0.154 |0.076| -0.31

44.1 -1.19 0.263 | -0.174 | 1.454 | -1.247 0.264 | -0.36 | -0.304 |0.093| 0.322

0.814

441 | -1.152 | 0.175 | -0.249 | 1.216 | -1.01 0 8-23 0.359 | -0.073 | -0.188 |0.063|-0.184
441 | -1.169 0.24 | -0.242 | 1.311 | -1.076 1134 0.39 | -0.318 | 0.502 0558 0.213
2031 | -1.279 | 0.199 | -0.214 | 1.879 | -1.966 0611 -0.08 | -0.498 | -0.052 0.429 0.635

32.34 | -1.139 | 0.278 | 0.175 | 0.937 | -1.393 0.102 | -0.355 | -0.117 | -0.77 | 0.646

0.303

V1.5. Model building

To build the QSAR model and to predict pIC50 for radical scavenging activity of N-
ferrocenylmethylaniline derivatives, we used a total of 20 compounds, belonging to the same class,
they only differ in terms of the position of the functionalization in the aniline ring (Figure 1). All
the compounds were synthesized coupling the quaternary salt (ferrocenylmethy) trimethyl-
ammonium iodide with various substituted anilines [337-340].

While constructing the model, great care was taken into consideration to avoid the inclusion
of highly collinear molecules using MLR regression. After a statistical analysis using MLR
regression method implanted in Molegro Data Modeler software with the antioxidant activities
(pIC50) as the dependent variable and the descriptors as independent variables, the best
statistically QSAR model equation was obtained and the statistical parameters were given in the

following model, Equation V-6:

pIC50 = —0.535097 x logP — 7.16821 x qFel — 1.67059 x gN1 — 4.83885 Equation VI-1

N =20; R?=0.934; S =0.333; F=36.525; p <0.005; Q =7.202; RMSD =0.1160

In this QSAR equation, N is the number of compounds used to build the QASR model, R?
is the squared correlation coefficient, p is the significance of the model, F is the Fisher ratio, Q is
the factor of quality for which Q = R/ESS (where R is the correlation coefficient and ESS is the

standard error of the estimation), and RMSD is the root mean squared deviation. The positive value
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of Q for QSAR’s model suggests its high predictive power. The accuracy in the analysis is
indicated by the low standard error of estimate value of 0.12968.

This QSAR equation suggests that the octanol/water partition coefficient (logP) and the net
charges (gFel and gN1) are the main independent parameters contributing to the antioxidant

activities of the N-ferrocenylmethylaniline derivatives.

As it can be seen from Equation VI-1, the obtained QSAR equation reach the optimal ratio
of compounds to descriptors which should be according to the Topliss and Costello rule equal to
at least 5:1 and thus the equation should be credible [341]. The equation also shows that all
parameters have negative coefficients which means that any increase in these values result in a

decrease in the antioxidant activity.
V1.6. Validation of the model

The leave-one-out cross-validation method was used to determine the predictive power of
the model. Results summarized in Table 3 for the obtained QSAR model indicate that it is
statistically significant. The high values of Q? = 0.873 (Q? > 0.5), R? = 0.934 (R?> 0.6), R%qj =
0.849 (R%g; > 0.5), and the low value of R? - Q*= 0.061 (R? - Q%< 0.3), are considered ultimate
proof that the QSAR model has a high predictive power [342, 343]. The obtained predicted residual
sum squares (PRESS) value of 0.269 is smaller than the sum of the squares of response (SSY)
value of 2.112 which further points out that the model predicts better than chance and can be
considered statically significant. Furthermore, the PRESS/SSY ratio is equal to 0.127 which is
smaller than 0.4 is also proof of the predictive ability [344]. The low Spress value of 0.130
additionally reflects the good predictive potential of the QSAR model.

The predictive error of the coefficient correlation PE is another parameter used to evaluate
the predictive power of the obtained model. For the developed model, the condition R > 6PE is

satisfied and hence has good predictive power.

Table VI-2 Cross-validation parameters

SPRESS PRESS/SSY

0.849 | 0.873 | 0.873 | 0.017 | 0.102 | 2.112 0.269 0.130 0.127
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The comparison of the observed plC500bs values with the predicted values plC50pred is
presented in Table VI-3. The residual values by the QASR model are also presented in this table.

The calculated low residual values confirmed the high predictive power of the model.

Table VI-3 Comparison of observed (pIC50), predicted (pIC50) and residuals of the QASR model

Molecule pIC500bs pIC50pred Residuals
F1 1.5212 1.5058 0.01543
F2 1.4544 1.3365 0.11789
F4 1.1594 1.2710 -0.11155
F5 1.4679 1.2257 -0.11966
F6 1.106 1.2032 -0.12834
F7 1.7282 1.6469 0.17181
F8 1.0749 1.7007 0.06402
F9 1.7038 1.7044 0.27175

1.7647 1.5634 -0.0438
1.9761 1.0854 -0.00151
1.7014 1.3102 -0.11674
1.5196 1.4893 0.04342
1.5327 2.0196 -0.18406
1.8355 1.6455 0.06366
1.7092 2.0679 -0.06708
2.1124 2.2163 -0.10389
1.4897 1.8447 -0.02506
1.6555 1.7326 -0.07705
2.0115 1.9100 0.10153
1.5779 1.4487 0.12923

A plot of predicted pIC50 versus observed pIC50 values are shown in Figure 4A. The
obtained squared fitting correlation coefficient of 0.934 between the predicted and observed values
confirmed the efficiency of the obtained QSAR model and further confirms that the QASR
equation has satisfactory predictability for new samples and could be used to guide the design of

new antioxidant N-ferrocenylmethylanilines.

A plot of the residuals (observed pIC50 - predicted plC50) versus observed plC50, is also
presented in Figure 4B. A random distribution of the residuals on both sides of zero was observed
indicating a good fit for a linear model and that no systematic error exists [345]. The applicability
domain is set up inside a defined domain where all the data points were within the boundary -0.20,
+0.30.
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Figure VI-2 (A) Correlation plot of predicted pIC50 versus observed pIC50 value, (B) a distribution plot
of the residuals versus observed plC50

V1.9. Conclusion

The high predictive ability of the QASR model was established. The model involved logP,
gFe and gN1 to predict the antioxidant activity. With the high values of Q2 = 0.892, R? = 0.934
and R%gj = 0.842 cross-validation approved that the model has a high ability to predect the 1C50

of new N-ferrocenylmethylaniline derivatives.
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GENERAL CONCLUSION

Optimization procedures using Gaussian 09W software have been done to optimize the 28
derivatives in order to determine their properties. The optimization method was DFT/B3LYP and
the basis set wasn’t the same for all atoms. In this study the mixed basis sets of LanL2DZ(Fe)/6-
31G(d) was used. The accurancy of the method is confirmed by values of R? obtained from the
linear correlation between the calculated and the experimental values of the bond lengths and
angles which were equal to 0.9992 and 0.9755 respectively. Moreover, the mixed basis sets
showed a high ability to predict the spectral and energetic properties. HOMO-LUMO gap values
which have been calculated to predict the reactivity of the derivatives The MESP maps have also
been used to predict the derivatives’ reactive locations. The electrophilic sites of all derivatives
were centered on the amine group, while the nucleophilic sites were projected to be concentrated

on the phenyl group.

The ADME and pharmacokinetics properties of N-ferrocenylmethylaniline derivatives were
predicted using the SwissADME webserver tool. The predicted results revealed that the majority
of the derivatives have the required bioavailability properties. Furthermore, the in silico toxicity
analysis performed, median lethal dose (LD50) and toxicity class (TC) have been predicted and

they gave some promising candidates such as F24.

All compounds of the studied series of 28 N-ferrocenylmethylanilines showed remarkable
in vitro radical scavenging activity. The obtained values of the free binding energy (-3.313 and
-12.306 KJ/mol) confirmed physical interactions between the derivatives and the free radical
(O27). The half-maximal inhibitory concentration (IC50) of all the 28 derivatives was measured
using cyclic voltametry thecnics. The compounds F2, F10, F12, F14, F19, F21, F23, F24, and F27
showed the best results, these results were compared with that of the standard vitamin E (7.0581
mM), the IC50 value of F23 (7.719 mM) is competitive to that of the standard while the others

idicating that they are strong drug candidates.

We could conclude from the docking study that although the molecule F23 is the most
inactive compound against glutathione reductase enzyme, with the greatest inhibitory
concentration of 4.16 puM and the lowest docking scores of 7.34 kcal/mol, but it cannot be a good
antioxidant candidate because it is predicted as carcinogenic and mutagenic. On the other hand,
based on what it is cited above, the compound F24 can be chosen as the best and safer antioxidant

candidate because it is inactive against glutathione reductase enzyme, its remarkable scavenging
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activity against superoxide inion, its promising ADME and drug-likness properties and because it

is predicted to be a non-toxic derivative.

Finally, the QASR model was built with high values of Q% = 0.892, R%gj = 0.842, and R? =
0.934 which allows it to predict IC50 Of new N-ferrocenylmethylaniline derivatves and save time

and efforts for researchers.
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